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Summary

Audience

Preface

This Preface provides supporting information for the Oracle Financial Services Advanced
Analytical Applications Infrastructure Pack Installation and Configuration Guide and includes
the following topics:

> Summary

> Audience

> Related Documents
> Conventions

»  Abbreviations

You can find the latest copy of this document in OHC Documentation Library which includes
all the recent additions/revisions (if any) done till date.

Before you begin the installation, ensure that you have an access to the Oracle Support Portal
with the required login credentials to quickly notify us of any issues at any stage. You can
obtain the login credentials by contacting Oracle Support.

Oracle Financial Services Advanced Analytical Applications Infrastructure Pack Installation
and Configuration Guide is intended for administrators, and implementation consultants who
are responsible for installing and maintaining the application pack components.

Prerequisites for the Audience

Following are the expected preparations from the administrator before starting the actual
installation:

The document assumes that you have experience in installing Enterprise components and basic
knowledge about the following are recommended:

> Oracle Financial Services Advanced Analytical Applications Infrastructure pack
components

2 OFSAA Architecture
2 UNIX Commands
> Database Concepts

> Web Server/ Web Application Server
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About OFSAA and OFSAA Application Packs

This chapter includes the following topics:
> About Oracle Financial Services Analytical Applications (OFSAA)
> About Oracle Financial Services Analytical Applications (OFSAA) Application Packs

> About Oracle Financial Services Advanced Analytical Applications Infrastructure (OFS
AAATI) Application Pack

> About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)

About Oracle Financial Services Analytical Applications

(OFSAA)

In today's turbulent markets, financial institutions require a better understanding of their
risk-return, while strengthening competitive advantage and enhancing long-term customer
value. Oracle Financial Services Analytical Applications (OFSAA) enable financial institutions
to measure and meet risk adjusted performance objectives, cultivate a risk management culture
through transparency, lower the costs of compliance and regulation, and improve insight into
customer behavior.

OFSAA uses industry-leading analytical methods, shared data model and applications
architecture to enable integrated risk management, performance management, customer insight,
and compliance management. OFSAA actively incorporates risk into decision making, enables
to achieve a consistent view of performance, promote a transparent risk management culture,
and provide pervasive intelligence.

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of
financial services analytical applications for both banking and insurance domain.

About Oracle Financial Services Analytical Applications
(OFSAA) Application Packs

The following figure depicts the various application packs that are available across the OFSAA
Banking and Insurance domains:

About OFSAA and OFSAA Application Packs 1-1
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Figure 1-1 OFSAA Application Packs
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About Oracle Financial Services Advanced Analytical
Applications Infrastructure (OFS AAAI) Application Pack

Oracle Financial Services Advanced Analytical Applications Infrastructure (OFS AAAI)
Application Pack provides integrated stress testing and modeling capabilities that you can
readily apply across multiple risk areas enabling institutions to devise appropriate
enterprise-wide and holistic risk and economic capital strategies.

OFS AAALI enables you to comply with regulatory requirements on stress testing, enables
advanced customer and portfolio analytics, utilize multiple industry standard techniques, test
and model with complete data integrity.

OFS AAAI Application Pack includes the following applications:

> Financial Services Analytical Applications Infrastructure: This application powers the
Oracle Financial Services Analytical Applications family of products to perform the

1-2 OFS AAAI Application Pack Installation and Configuration Guide
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processing, categorizing, selection and manipulation of data and information needed to
analyze, understand and report on specific performance, risk, compliance and customer
insight issues by providing a strong foundation for the entire family of Oracle Financial
Services Analytical Applications across the domains of Risk, Performance, Compliance
and Customer Insight.

> Financial Services Enterprise Modeling: This application helps banking institutions to
identify the business opportunities and to measure the risk prevailing in the competitive
market to safeguard the regulatory and economic capital of banks.

> Financial Services Inline Processing Engine: This application provides real-time
monitoring, detection and interdiction of single and complex fraud events across multiple
channels and lines of business.

About Oracle Financial Services Analytical Applications
Infrastructure (OFS AAl)

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle
Financial Services Analytical Applications family of products to perform the processing,
categorizing, selection and manipulation of data and information needed to analyze, understand
and report on specific performance, risk, compliance and customer insight issues by providing a
strong foundation for the entire family of Oracle Financial Services Analytical Applications
across the domains of Risk, Performance, Compliance and Customer Insight.

Components of OFSAAI

The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the
Oracle Financial Services Analytical Applications Data Model and form the array of
components within the Infrastructure.

The OFSAA Infrastructure components/ frameworks are installed in two layers; primarily the
metadata server and Infrastructure services run on one layer, and the UI and presentation logic
runs on the other. The UI and presentation layer is deployed on any of the supported J2EE
Servers.

The following figure depicts the various frameworks and capabilities that make up the OFSAA
Infrastructure:
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Figure 1-2 Components of OFSAAI
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OFSAA Infrastructure High Availability

The current release of the OFSAA Infrastructure supports only "Single Instance" installation for

the Infrastructure components. However, the High Availability (HA) for the Database Server
and/ or the Web Application Server clustering and deployment are supported in this release.

This release supports Active-Passive model of implementation for OFSAAI components. For
more information, refer Configuration for High Availability- Best Practices Guide.
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Understanding OFS AAAI Pack Installation

This chapter includes the following topics:
> Installation Overview

> Deployment Topology

> Hardware and Software Requirements
> Verifying System Environment

> Understanding the Installation Mode

Installation Overview

This section gives an overview of the OFS AAAI Pack Installation. Figure 2—1 shows the order
of procedures you will need to follow:
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Figure 2-1 Installation Overview
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Table 2—1 provides additional information and links to specific documentation for each task in
the flowchart.

Table 2-1 OFSAA Application Pack Installation Tasks and Descriptions

Tasks Details and Documentation

Verify Systems Environment ~ To verify that your system meets the minimum necessary requirements
for installing and hosting the OFSAA Application Pack, see Verifying
System Environment.

Obtain the software To access and download the OFSAA Application Pack, see Obtaining
the software.

Configure and Execute the For instructions on creating the database schemas, see Configuring and

Schema Creator Utility Executing the Schema Creator Utility.

Install OFS AAAI Pack For instructions on Installing OFS AAAI Application Pack, see

Installing the OFS AAAI Application Pack.
Configure OFS AAAI Pack See Post Installation Configuration.
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Deployment Topology
The following figure depicts the logical architecture implemented for OFS AAAI Application
Pack.

Figure 2-2 Deployment Topology
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Hardware and Software Requirements

This section describes the various Operating Systems, Database, Web Server, and Web
Application Server versions, and other variant details on which this release of the OFS AAAI
Application Pack has been qualified.

Note:

OFS AAAI Application Pack installation can be performed on both Virtual and
Physical servers.

The following tables show the minimum hardware and software requirements for installing
OFS AAALI Application Pack:
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Configurations supported for Java 7

Table 2-2 Configurations Supported for Java 7

Operating System

Oracle Linux / Red Hat 2
Enterprise Linux (x86-64)

Oracle Linux Server release 5.3 up to 5.10 - 64 bit
Oracle Linux Server release 6.0 and above - 64 bit

Note: Same versions of RHEL is supported

Oracle Solaris (SPARC)/

~

Oracle Solaris v5.10 Update 11 and above - 64 bit

?

Solaris x86 2 Oracle Solaris v5.11 update 1 and above - 64 bit
IBM AIX (POWERPC) > AIX 6.1 (TL 09 and above) - 64 bit

Shell . KORN Shell (KSH)

Note:

If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small,
configure the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change the
file size limit for a particular user, add or edit the fsize attribute for the user in the
/etc/security/limits file on the AIX system. Change the file size limit to unlimited (fsize = -1) or to
a size equal to the size of the file being transferred. This may require an restart of the AIX server to
pick up the new configuration. For more information refer IBM Support.

If the operating system is RHEL, install the package Isb_release using one of the following
commands by logging in as root user:

» yum install redhat-1lsb-core

> yum install redhat-1sb

Java Runtime Environment

Oracle Linux / Red Hat 2
Enterprise Linux

Oracle Solaris

Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit

IBM AIX ?

IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit

Oracle Database Server and Client

?

?

2

Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC
with/ without partitioning option

Oracle Database Server Enterprise Edition 12¢ Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC
with/ without partitioning option

Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

Oracle Client 12¢ Release 1 (12.1.0.1.0+) - 64 bit

Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

Oracle R Distribution (Optional). For supported versions, see the Tech Matrix.

Oracle R Enterprise (Server) (Optional). For supported versions, see the Tech Matrix.

2

?

2

Note:

Ensure that the following patches are applied:

Oracle Server 12¢, v12.1.0.1 — 17082699
Oracle Server 12¢, v12.1.0.2 - 20698050

Also for latest information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)
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Hardware and Software Requirements

Table 2-2 (Cont.) Configurations Supported for Java 7

OLAP
Oracle Hyperion Essbase 2V 11.1.2.1+ (Server and Client) with Oracle 11g Database
» V 11.1.2.3+ (Server and Client) with Oracle 12¢ Database
Oracle OLAP » V 11.2.0.3+ with Oracle 11g Database
>V 12.1.0.1+ with Oracle 12c Database
Note:

Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of
OFSAAL For Oracle OLAP, ensure that you have configured the Oracle Database server with OLAP
option.

Web Server/ Web Application Server

Oracle Linux / Red Hat Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM HTTP
Enterprise Linux/ IBM AIX Server
Oracle Solaris > Oracle WebLogic Server 12.1.2+ (64 bit)
> IBM WebSphere Application Server 8.5+ with bundled IBM
Java Runtime (64 bit)

> Apache Tomcat 8.0.x (64 bit)

Note: OFS Inline Processing Engine does not support Tomcat Web
Application Server.

Note:

2 OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle
JRockit is not supported.

> Ifthe Oracle WebLogic Server is in the 12.2.x series and you plan to configure the Security
Assertion Markup Language (SAML) to enable Single Sign-On (SSO), then ensure that the
WebLogic Server version is upgraded to 12.2.1.4 or higher.

Desktop Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1
Browser 2 MS Internet Explorer 9, 10(Compatibility Mode) and 11
(Compatibility Mode)

Oracle Java plug-in 1.7.0+* (64- bit)

Configure Pop-up blocker settings. For more information, see Internet
Explorer Settings

Office Tools » MS Office 2007/2010/2013
2 Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280*1024
Other Software
Directory Services OFSAAL is qualified on both OPEN LDAP 2.2.29+ and Oracle

Internet Directory v 11.1.1.3.0. However, it can be integrated with
other directory services software like MS Active Directory.

Note:

»  Configuration of Directory services software for OFSAAI installation is optional. For more
information on configuration, see Infrastructure LDAP Configuration.

> Open LDAP needs to be installed on MS Windows Server machine only.
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Configurations supported for Java 8

Table 2-3 Configurations Supported for Java 8

Operating System

Oracle Linux / Red Hat p
Enterprise Linux (x86-64)

Oracle Linux Server release 5.3 up to 5.10 - 64 bit
Oracle Linux Server release 6.0 and above - 64 bit

Note: Same versions of RHEL is supported

Oracle Solaris (SPARC)/

Oracle Solaris v5.10 Update 11 and above - 64 bit

~

?

Solaris x86 » Oracle Solaris v5.11 update 1 and above - 64 bit
IBM AIX (POWERPC) 2 AIX 6.1 (TL 09 and above) - 64 bit

Shell . KORN Shell (KSH)

Note:

If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small,
configure the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change the
file size limit for a particular user, add or edit the fsize attribute for the user in the
/etc/security/limits file on the AIX system. Change the file size limit to unlimited (fsize = -1) or to
a size equal to the size of the file being transferred. This may require an restart of the AIX server to
pick up the new configuration. For more information refer IBM Support.

If the operating system is RHEL, install the package Isb_release using one of the following
commands by logging in as root user:

» yum install redhat-1sb-core

> yum install redhat-1sb

Java Runtime Environment

Oracle Linux / Red Hat 2
Enterprise Linux

Oracle Solaris

Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit

IBM AIX ?

IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit

Oracle Database Server and Client

?

?

2

Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC
with/ without partitioning option

Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC
with/ without partitioning option

Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

Oracle Client 12¢ Release 1 (12.1.0.1.0+) - 64 bit

Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

Oracle R Distribution (Optional). For supported versions, see the Tech Matrix.

Oracle R Enterprise (Server) (Optional). For supported versions, see the Tech Matrix.

?

?

?

Note:
Ensure that the following patches are applied:

Oracle Server 12¢, v12.1.0.1 — 17082699
Oracle Server 12¢, v12.1.0.2 - 20698050

Also for latest information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)
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Hardware and Software Requirements

Table 2-3 (Cont.) Configurations Supported for Java 8

OLAP
Oracle Hyperion Essbase 2V 11.1.2.1+ (Server and Client) with Oracle 11g Database
» V 11.1.2.3+ (Server and Client) with Oracle 12¢ Database
Oracle OLAP » V 11.2.0.3+ with Oracle 11g Database
>V 12.1.0.1+ with Oracle 12c Database
Note:

»  Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of
OFSAAL For Oracle OLAP, ensure that you have configured the Oracle Database server with
OLAP option.

Web Server/ Web Application Server

Oracle Linux / Red Hat Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM HTTP
Enterprise Linux / IBM AIX Server
Oracle Solaris > Oracle WebLogic Server 12.1.3+ (64 bit)

> Apache Tomcat 8.0.x (64 bit)

Note:

IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

OFS Inline Processing Engine does not support Tomcat Web
Application Server.

Note:

2 OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle
JRockit is not supported.

> For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install
patch 18729264 from http://support.oracle.com/.

> Ifthe Oracle WebLogic Server is in the 12.2.x series and you plan to configure the Security
Assertion Markup Language (SAML) to enable Single Sign-On (SSO), then ensure that the
WebLogic Server version is upgraded to 12.2.1.4 or higher.

Desktop Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1
Browser > MS Internet Explorer 9, 10(Compatibility Mode) and 11
(Compatibility Mode)

Oracle Java plug-in 1.7.0+* (64- bit)

Configure Pop-up blocker settings. For more information, see Internet
Explorer Settings

Office Tools » MS Office 2007/2010/2013
2 Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280%1024
Other Software
Directory Services OFSAALl is qualified on both OPEN LDAP 2.2.29+ and Oracle

Internet Directory v 11.1.1.3.0. However, it can be integrated with
other directory services software like MS Active Directory.

Note:

> Configuration of Directory services software for OFSAAI installation is optional. For more
information on configuration, see Infrastructure LDAP Configuration.

2 Open LDAP needs to be installed on MS Windows Server machine only.
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Verifying System Environment

Note:

To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8§, refer
Appendix P.

OFS AAAI Application Pack recommends the following software combinations for

deployment:

Table 2-4 Recommended Software Combinations

Web Application
Operating System | Database Server Web Server
Oracle Linux 5.3 up | Oracle Database Oracle WebLogic Server Oracle HTTP Server/
to 5.10/ 6.0 and /Apache Tomcat Server Apache HTTP Server
above
Oracle Solaris 5.10/ | Oracle Database Oracle WebLogic Server Oracle HTTP Server/
5.11 /Apache Tomcat Server Apache HTTP Server
IBM AIX 6.1 Oracle Database IBM WebSphere IBM HTTP Server/
Application Server Apache HTTP Server
/Apache Tomcat Server

Verifying System Environment

To verify your system environment meets the minimum requirements for the installation, a
Pre-Install Check utility is available within the Install Kit archive file. This utility can also be
obtained separately by contacting Oracle Support.

Though the system environment verification is an integral and automated part of the installation
of this software product, Oracle strongly recommends running this utility prior to beginning the
installation as part of your organization's "Installation Readiness Verification Process".

Note: For more details on download and usage of this utility, see Oracle
Financial Services Analytical Applications Infrastructure Environment Check
Utility Guide given in the Related Documents section.

Understanding the Installation Mode
The following modes of installation are available for the OFS AAAI Applications Pack.
> GUI Mode
> SILENT Mode

GUI Mode

This mode launches the product installation in a Graphical User Interface (GUI) Mode. Users
need to enter the required information on various panels within the Ul in a user interaction
format at various stages.

Note: For more information on configuration required for GUI Mode
installation, refer Configuration for GUI Mode Installation.
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SILENT Mode

This mode mandates updating the installation configuration files with required details and
performs installation in a "Silent" non user interactive format.
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Preparing for Installation

This chapter provides necessary information to review before installing the Oracle Financial
Services Advanced Analytical Applications Infrastructure (OFS AAAI) Pack v8.0.0.0.0. This
chapter includes the following topics:

> Installer and Installation Prerequisites
> Obtaining the software

> Common Installation Tasks

Installer and Installation Prerequisites

Table 3—1 mentions the list of prerequisites required before beginning the installation for OFS
AAAI application. The Installer/ Environment Check Utility notifies you if any requirements
are not met.
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Installer and Installation Prerequisites

Table 3—-1 Prerequisite Information

Category Sub-Category Expected Value
Environment Java Settings > PATH in .profile to be set to include the Java
Settings Runtime Environment absolute path. The path

should include java version (java 7 or java 8) based
on the configuration.

Note:

? Ensure the absolute path to JRE/bin is set at the
beginning of PATH variable.

> For example,
PATH=/usr/java/jrel.7/bin:SORACLE _
HOME/bin:$SPATH

P Ensure no SYMBOLIC links to JAVA installation is
being set in the PATH variable.

Oracle Database » TNS_ADMIN to be set in .profile pointing to
Settings appropriate tnsnames.ora file

> ORACLE_HOME to be set in .profile pointing to
appropriate Oracle Client installation

> PATH in .profile to be set to include appropriate
$ORACLE_HOME/bin path

»  Ensure to add an entry (with SID/ SERVICE
NAME) in the tnsnames.ora file on the OFSAA

server.
Oracle Essbase ? ARBORPATH, ESSBASEPATH, HYPERION _
Settings HOME to be set in the .profile pointing to an
appropriate Oracle Essbase Client installation.
Note:

These settings are required only if you want to use Oracle
Hyperion Essbase OLAP features.
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Table 3—-1 (Cont.) Prerequisite Information

Category

Sub-Category

Expected Value

OS/ File System
Settings

File Descriptor
Settings

? Greater than 15000
Note:

The value specified here is the minimum value to be set
for the Installation process to go forward. For other
modules, this value may depend on the available
resources and the number of processes executed in
parallel.

Total Number of
Process Settings

2 Greater than 4096
Note:

The value specified here is the minimum value to be set
for the Installation process to go forward. For other
modules, this value may depend on the available
resources and the number of processes executed in
parallel.

Port Settings

> Default port numbers to be enabled on the system
are 6500, 6501, 6505, 6507, 6509, 6510, 6666,
9999, and 10101.

.profile > User to have 755 permission on the .profile file.
permissions
Installation > Adirectory where the installation files will be
Directory installed.
2 Set 755 permission on this directory.
This directory needs to be set as FIC_HOME.
Temporary Directory |Default temporary directory where installation files are
stored for a short period of time to support faster
installation.
> For installation on UNIX OS, your UNIX
administrator must give you the required read-write
permissions for the /tmp directory and disable the
NOEXEC option
> Configure adequate space on the /tmp directory. It is
recommended that you allocate more than 10 GB of
space.
Note: [f NOEXEC is enabled, the extraction of files by
the installer into the /tmp directory is prevented and the
binaries will not execute in the directory, which will fail
the installation.
Staging Area/ > Adirectory to hold the application metadata artifacts
Metadata Repository and additionally act as staging area for flat files.
»  The directory should exist on the same system as the
OFSAA Installation. This directory can be
configured on different mount or under a different
user profile.
Set 777 permission on this directory.
Download Directory |» A directory where the product installer files will be
downloaded/ copied.
Set 755 permission on this directory.
OS Locale > Linux:en US.utf8

»  AIX:EN_US.UTF-8
> Solaris: en_US.UTF-8

To check the locale installed, execute the following
command:

locale -a | grep -i ,en_USE’l[Fparing for Installation  3-17




Installer and Installation Prerequisites

Table 3—-1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value

Database Settings Database Instance » NLS CHARACTERSET to be AL32UTF8

Scttings , NLS_LENGTH_SEMANTICS to be BYTE
> OPEN CURSORS limit to be greater than 1000
Web Application WebSphere/ 2 Web Application Server should be installed and
Server WebLogic/ Tomcat profile /domain created.
> You will be prompted to enter the WebSphere
Profile path or WebLogic Domain path or Tomcat
Deployment path during OFSAALI installation.
Note:
> Refer Appendix A for WebSphere Profile Creation
and WebLogic Domain Creation.
»  For deployment on Oracle WebLogic Server 12.1.3+
(64 bit) with Java 8, download and install patch
18729264 from http://support.oracle.com/.
Web Server Apache HTTP This is an optional requirement. HTTP Server Installation
Server/ Oracle to be present. You will be required to enter the Web
HTTP Server/ Server IP/Hostname and Port details during installation.

IBM HTTP Server Note: Refer Appendix A for Web Server installation.

Others Oracle R/ Oracle R |- This is an optional requirement.

Enterprise 2 Refer section Installation of Oracle R distribution

and Oracle R Enterprise (ORE) for more details.

OFSAA > For installation on Java 8, login to
https://support.oracle.com/ and search for 21160684
under the Patches & Updates tab. This is applicable
only when you have installed OFSAAI pack version
8.0.0.0.0 and not required for version 8.0.0.1.0.

> For installation of this release on an existing
OFSAA instance where the underlying OFSAA
Infrastructure (OFS AAI) version is upgraded to
version 8.0.1.0.0, login to
https://support.oracle.com/ and search for 21133780
under the Patches and Updates tab.

> For installation of this release on an existing
OFSAA instance where the underlying OFSAA
Infrastructure (OFS AAI) version is upgraded to
version 8.0.2.0.0, login to
https://support.oracle.com/ and search for 21657319
under the Patches and Updates tab.

OFSAAI One-off Download the consolidated one-off patch 25777667 from
https://support.oracle.com/.

Note: Ensure that the tablespace (s) used for the database user (s) is set to
AUTOEXTEND ON.
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Common Installation Tasks

Obtaining the software

This release of OFS AAAI Application Pack v8.0.0.0.0 can be downloaded from the Oracle
Software Delivery Cloud (https://edelivery.oracle.com). You need to have a valid
Oracle account in order to download the software.

Common Installation Tasks

The following are the common pre-installation activities that you need to carry out before
installing the OFS AAALI application pack.

This section includes the following topics:

2

2

2

Configuration for GUI Mode Installation

Identifying the Installation Directory, Download and Metadata Repository Directories
Download and copy the OFS AAAI Applications Pack Installer

Copying and Extracting the Software

Setting Up the Web Application Server

Installation of Oracle R distribution and Oracle R Enterprise (ORE)

Configuration for GUI Mode Installation

To install OFS AAAI Application Pack in GUI mode, you need to ensure the following
software and configurations are available:

2

Install and configure any PC X Server software such as Open Text Exceed (formerly
Hummingbird Exceed) on the user desktop system from which the installation is triggered.

Configure the DISPLAY variable.

Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed,
to point to the user desktop system where the PC X Server software has been installed.

Syntax:
export DISPLAY=hostname:n.nl

where hostname is the IP Address/ Host Name of the user desktop system
and n is the sequence number (usually 0).

For example, 10.11.12.13:0.0 or myhostname:0.0

Identifying the Installation Directory, Download and Metadata
Repository Directories

To install any of the OFSAA Application Packs, the following folders/ directories are required
to be created.

?

OFSAA Download Directory (Optional): Create a download directory and copy the
OFSAA Application Pack Installer File (Archive). This is the directory where the
downloaded installer/ patches can be copied.

OFSAA Installation Directory (Mandatory): Create an installation directory. This is the
directory where the installer installs or copies the product files. FIC_ HOME variable to be
set in the .profile pointing to this OFSAA Installation Directory.

OFSAA Staging/Metadata Directory (Mandatory): Create a Staging/ Metadata
Repository Directory. This is the directory where you should copy data loading files, save
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data extracts and so on. Additionally, this folder also maintains the OFSAA metadata
artifacts. This is commonly referred as "FTPSHARE".

Note:
> Ensure the user permission is set to 755 on the installation directory.
> Ensure the user permission is set to 777 on the Staging Directory.

> Ensure the OFSAA staging directory is not set to the same path as the
OFSAA installation directory and is not a sub-folder inside the OFSAA
installation directory.

Download and copy the OFS AAAI Applications Pack Installer
To download and copy the OFS AAAI Applications Pack Installer, follow these steps:

> To download the OFS AAAI Applications Pack, you need to login to the Oracle Software
Delivery Cloud (https://edelivery.oracle.com). You need to have a valid Oracle account in
order to download the software.

> Copy the downloaded installer archive to the Download Directory (in Binary Mode) on the
setup identified for OFS AAALI installation.

Copying and Extracting the Software

Once you obtain the installer, copy the installer (in BINARY mode) to the system on which the
OFSAA Infrastructure components will be installed.

Note: : You must be logged in to the UNIX operating system as a non-root
user.

1. Download the unzip utility (OS specific) unzip <os>.Z and copy it in Binary mode to
the directory that is included in your PATH variable. If you already have the unzip utility to
extract the contents of the downloaded archive, skip to the next step.

2. Uncompress the unzip installer file using the command:

uncompress unzip <os>.7Z

Note: In case you notice an error message "uncompress: not found [No
such file or directory]" when the package is not installed, contact your UNIX
administrator.

3. Give EXECUTE permission to the file using the command:
chmod 751 unzip <0S>
For example, chmod 751 unzip sparc

4. Extract the contents of the Oracle Financial Services Advanced Analytical Applications
Infrastructure Application Pack 8.0.0.0.0 in Download Directory installer archive file using
the following command:

unzip OFS_AAAI PACK.zip
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5. Give the following permission to the installer folder. Navigate to the Download Directory
and execute the command:

chmod -R 755 OFS_AAAI PACK

Setting Up the Web Application Server

For setting up the environment based on your selected Web Application Server, refer to
Appendix A for more information.

Installation of Oracle R distribution and Oracle R Enterprise (ORE)

This is an optional step and required only if you intend to use Oracle R scripting in the Oracle
Financial Services Enterprise Modeling Application. Follow this step:

Install Oracle R Distribution and Oracle R Enterprise (Server Components) on the Oracle
Database server. See Oracle® R Enterprise Installation and Administration Guide for Windows,
Linux, Solaris and AIX at Oracle R Enterprise Documentation Library. For supported versions
of ORD and ORE, see the Tech Matrix.

Note: If you use ORE 1.4.1 with Oracle Financial Services Enterprise
Modeling, you must set the session time zone in 'R_HOME/etc/Rprofile.site’
file on the database server, where R HOME is the home directory of the R
instance on which ORE server packages are installed. Alternatively, you can
set session time zone in scripts registered within OFS EM by using the
'Sys.env(TZ=<time zone>)’ R function.
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Installing the OFS AAAI Pack

Follow the instructions in this chapter to install the OFS AAAI pack depending on the mode of
installation.

This chapter includes the following sections:

> Schema Creator Utility

> Configuring and Executing the Schema Creator Utility
> Installing the OFS AAAI Application Pack

Schema Creator Utility

Creating database users/schemas is one of the primary steps in the complete OFS AAAI
installation. This release of OFSAA provides a utility to quickly get started with the OFSAA
8.0 installation by allowing easier and faster creation of database User (s)/ Schema (s), assign
the necessary GRANT (s), and so on. Additionally, it also creates the required entities in these
schemas.

This section includes the following topics:
> About Schema Creator Utility
> Execution Modes in Schema Creator Utility

> Execution Options in Schema Creator Utility

About Schema Creator Utility

The schema creator utility should be configured and executed mandatorily every time prior to
installation of any OFSAA Application Pack.

The following are the types of schemas that can be configured in the OFSAA:

> CONFIG - Denotes the unique OFSAA setup configuration schema. It contains entities
and other objects required for OFSAA setup information.

Note: There can be only one CONFIG schema per OFSAA instance.

= ATOMIC - Denotes the schema that contains the data model entities. One ATOMIC
schema is attached to one Information Domain.

Note:: There can be multiple ATOMIC schemas per OFSAA Instance.
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2

?

SANDBOX - Denotes the schema that contains the data for all Sandbox executions. One
SANDBOX schema is attached to one Sandbox Information Domain

Note:: There can be multiple SANDBOX schemas per OFSAA Instance.

ADDON - Denotes any additional schema used by the OFSAA Applications.

Note:: This Schema type is not applicable for OFS AAAI Application
Pack.

Execution Modes in Schema Creator Utility

Schema creator utility supports the following two modes of execution:

2

Online Mode: In this mode, the utility connects to the database and executes the DDLs for
User, Objects, and Grants. If you have the SYSDBA privileges you can execute the
Schema Creator Utility in Online mode and thereby create the Users, Objects, and Grants
during the execution process.

Note: To execute the utility in Online mode, you need to connect as
"<User> AS SYSDBA"

Offline Mode: In this mode, the utility generates a SQL script with all the required DDLs
for User, Objects and Grants. This script needs to be executed by the DBA on the
appropriate database identified for OFSAA usage. If you do not have the SYSDBA
privileges, you can execute the Schema Creator Utility in Offline mode and generate the
script file that contains the Schemas, Objects, and Grants information. Subsequently, a
SYSDBA user should execute the script file manually.

Note: :

1. To execute the utility in Offline mode, you need to connect as any user with the
following grants (alternatively, you can also connect as a user with SYSDBA
privileges):

? SELECT ON DBA_ROLES

> SELECT ON DBA_USERS

> SELECT ON DBA DIRECTORIES
> SELECT ON DBA TABLESPACES
»  CREATE SESSION

2. Ifthere are any errors during the script execution, reconfigure the <PACK>_
SCHEMA_IN.XML file and execute the utility. This regenerates the scripts with
corrected information.

For more information, refer Configuring <<APP Pack>> SCHEMA IN.XML
file.

3. Do not modify the <PACK>_SCHEMA OUT.XML file generated after the execution
of this utility.
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Execution Options in Schema Creator Utility

Depending on the option selected to run the OFSAA Application Pack Installer, you need to
select the schema creator utility execution option. To run the OFSAA Application Pack installer
in SILENT mode, it is mandatory to execute the schema creator utility with -s option.

Note: If the schema creator utility is executed without the option -s, it is
mandatory to run the OFSAA Application Pack Installer in GUI mode.

Configuring and Executing the Schema Creator Utility
This section includes the following topics:
> Prerequisites
> Configuring the Schema Creator Utility

> Executing the Schema Creator Utility

Prerequisites

The following prerequisites must be satisfied before configuring the Schema Creator Utility:
> You must have the Oracle User ID/Password with SYSDBA privileges.

> You must have the JDBC Connection URL for RAC/Non RAC database.

> You must have the HOSTNAME/IP of the server on which OFSAA is getting installed.

»  For Java 8, navigate to OFS_AAAI PACK/bin/ and modify the value for property JAVA
VERSION to 1.8 in the VerInfo. txt file and save the changes.

Notes:

> If this release of the OFS AAAI Application Pack version 8.0.0.0.0 is
being installed on an OFSAA setup where the underlying OFSAA
Infrastructure (OFS AAI) version is upgraded to version 8.0.1.x.x,
download and install the patch for schema creator utility (Bug 21133780
) by following the instructions in the Readme.txt packaged in it prior to
executing the utility.

> Ifthis release of the OFS AAAI Application Pack version 8.0.0.0.0 is
being installed on an OFSAA setup where the underlying OFSAA
Infrastructure (OFS AAI) version is upgraded to version 8.0.2x.x,
download and install the patch for schema creator utility (Bug 21657319)
by following the instructions in the Readme.txt packaged in it prior to
executing the utility.

> The following configuration is required only if you intend to use Oracle Linux/Red Hat
Enterprise Linux v7.x.

For Oracle Linux/RHEL 7.x, navigate to OFS_AAAI PACK/bin/ and modify the value for
property Linux VERSION to include 7 in the VerInfo.txt file and save the changes.

For example, Linux VERSION=5,6,7

Installing the OFS AAAI Pack 4-25



Configuring and Executing the Schema Creator Utility

Note: If you get the following error during schema creation on OEL7:

UPPER(TABLE NAME) = 'DBA_USERS' and UPPER(PRIVILEGE) =
'SELECT'

[SCHEMAUTILITY] [ INFO] - Connection URL successfully validated...

[SCHEMAUTILITY] [DEBUG] - Executing ...SELECT VALUE FROM
v8option WHERE parameter = 'Partitioning’

[SCHEMAUTILITY] [ERROR] - Error while validating host name
10.184.157.139

[SCHEMAUTILITY] [ERROR] -
Jjava.net.UnknownHostException: online: Name or service not known
modify the following line in the osc.sh file:

machinelP="/sbin/ifconfig | grep "inet addr"|head -1|tr -s "\t'"'|cut -d ' ' -f3|cut
-d"-f2°

to the following line:

machinelP='"/bin/hostname —1'

» For IBM AIX 7.1, navigate to OFS_AAAI PACK/bin/ and modify the value for property
AIX VERSION to include 7.1 in the VerInfo.txt file and save the changes.

For example, AIX VERSION=6.1,7.1

Configuring the Schema Creator Utility

This section explains the steps to configure the Schema Creator Utility.

To configure the Schema Creator Utility, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following path: OFS AAAI PACK/schema creator/conf folder.
3. Editthe OFS AAAI SCHEMA IN.xml file in a text editor.
4

Configure the elements as described in the sectionConfiguring <<APP Pack>>
SCHEMA IN.XML file.

5. Savethe OFS AAAT SCHEMA IN.xnml file.

Note: On successful execution of the utility, the entered passwords in the
OFS_ARAI SCHEMA IN.xml file are nullified.

Executing the Schema Creator Utility

You can execute the schema creator utility either in Online Mode or Offline Mode. This section
includes the following topics:

> Executing the Schema Creator Utility in Online Mode
> Executing the Schema Creator Utility in Offline Mode
> Executing the Schema Creator Utility with -s option

> Executing the Schema Creator Utility while Installing Subsequent Applications Pack
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Note: If you intend to use Oracle OLAP feature, execute the following
grant on all ATOMIC schema (s) grant olap user to &database
username.

Executing the Schema Creator Utility in Online Mode

In Online Mode, the Schema Creator Utility will create all the Schemas, Schema Objects,
Tablespaces, Grants, and Roles in the database during the execution process.

To execute the Schema Creator Utility in Online Mode, follow these steps:

1. Login to the system as non-root user.

2. Navigate to the following folder path: OFS AAAI PACK/schema creator/bin/
3. Execute the osc. sh file using the following command:

./osc.sh
The following message is displayed:

You have chosen ONLINE mode. Triggering the utility in ONLINE mode will execute the
DDLs directly on the Database. Do you wish to proceed? (Y/y or N/n).

4. Enter Y/y to proceed with the script generation.
or

Enter N/n to quit script creation.
5. Enter the DB Username with SYSDBA Privileges. For example: SYS as SYSDBA.

6. Enter the User Password.

Figure 4-1 Schema Creation - Online Mode

7. The console runs the initial validation checks and then displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic
Schema>ATOMIC schema. Do you want to proceed? (Y/N).

8. Enter Y/y to proceed with the schema creation.
or

Enter N/n to quit schema creation.
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The following message is displayed.

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want
to proceed? (Y/N).

Figure 4-2 Schema Creation - Online Mode

9. Enter Y/y to start the schema creation.

Or

Enter N/n if you want to quit executing the schema creation.
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Figure 4-3 Schema Creator Utility - Online

Note:

> On successful execution of schema creator utility, the console displays
the following status message:
Schema Creator executed successfully. Please proceed with the installation.

> Refer log file in OFS_ AAAI PACK/schema creator/logs folder for
execution status. In case of any errors, contact Oracle Support.

Executing the Schema Creator Utility in Offline Mode

In Offline Mode, the Schema Creator Utility creates an output in SQL file format. This script
has to be executed manually by logging as database user with SYSDBA privileges. The SQL
file contains the creation of Schemas, Schema Objects, Tablespaces, Grants, and Roles.

Prerequisites:

To execute the utility in Offline mode, you need to connect as any user with the following
grants (alternatively, you can also connect as a user with SYSDBA privileges):

? SELECT ON DBA ROLES
? SELECT ON DBA USERS
? SELECT ON DBA DIRECTORIES
? SELECT ON DBA TABLESPACES

? CREATE SESSION
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Note: Explicit Grants to the user are required. Grants assigned through
Roles are not supported.

To execute the schema creator utility in the offline mode, follow these steps:
1. Log in to the system as non-root user.
2. Navigate to the OFS_AAAI PACK/schema creator/bin folder.
3. Execute the osc.sh file using the following command:
./osc.sh -o
4. The following message is displayed:

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate
the script. Do you wish to proceed? (Y/y or N/n).

5. Enter Y /y to generate the script.
or
Enter N/n to quit the schema creation.
6. Enter the DB Username with SELECT privileges.

7. Enter the User Password.

Figure 4-4 Schema Creation - Offline Mode

8. The console runs the initial validation checks and displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic
Schema>ATOMIC schema. Do you want to proceed? (Y/N).

9. Enter Y/y to start the script generation.
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Or
Enter N/n if you want to quit the script generation.
The following message is displayed.

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want
to proceed? (Y/N)

Figure 4-5 Schema Creation - Offline Mode

10. Enter Y/y to start the script generation.
Or

Enter N/n if you want to quit the script generation.
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Figure 4-6 Schema Creator Utility - Offline

On successful execution of schema creator utility, the console displays the following status
message:

Schema Creator executed successfully. Please execute scratch/ofsaaapp/OFS AAAI
PACK/schema_creator/sysdba_output_scripts.sql before proceeding with the installation.

11. Navigate to the directory:
OFS ARAI PACK/schema creator

12. Log in to SQLPLUS with a user having SYSDBA Privileges.
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Figure 4-7 Schema Creator - Offline Mode

13. Execute the sysdba output scripts.sql file using the following command:

SQL>@sysdba output scripts.sql

Alternatively, you can copy the sysdba output scripts.sqgl file and SQLScripts
folder to a remote server and execute sysdba_output scripts.sql file.

Note: Refer log sysdba output scripts.log file for execution status.
In case of any errors, contact Oracle Support. If there are no errors in the
execution, this log file is empty.

Executing the Schema Creator Utility with -s option

If you intend to run the OFS AAAI Application Pack Installer in SILENT mode, it is
mandatory to execute the schema creator utility with -s option.

To execute the utility with -s option, follow these steps:

1.

Edit the file OFS_AARI PACK/schema creator/conf/OFS AAAI SCHEMA IN.xml in
text editor.

Set the value for attribute "INFODOM" of <SCHEMA> tag(s) to specify a specific
Information Domain name. By default, the value is empty and the utility will derive the
Information Domain name. If the attribute value is set, the utility/ installer will configure
the Information Domain against this <SCHEMA>.

Execute the utility with -s option.

For Example . /osc.sh -s.

Note:

»  Ifthe utility is executed without the -s option, it is mandatory to launch the
OFSAA Applications Pack Installer in GUI mode.

> To execute the utility in OFFLINE mode with SILENT option, enter the
following command
./osc.sh -0 -8
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Figure 4-8 Schema Creator Utility with -s option
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Figure 4-9 Schema Creator Utility with -s option
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Figure 4-10 Schema Creator Utility with -s option

Executing the Schema Creator Utility while Installing Subsequent
Applications Pack

While executing the schema creator utility for subsequent Applications Pack, you can choose to
install the pack either on the same Information Domain/Atomic Schema or on a new

Information Domain/Atomic Schema. You can execute the Schema Creator Utility either in
Online or Offline Mode.

Note: OFS AAAI Application Pack can be installed on any Information
Domain/ Atomic schema where any OFS Application Packs are installed
other than OFS Behavior Detection Application Pack or OFS Compliance
Regulatory Reporting Application Pack.

To execute the schema creator utility while installing OFS AAAI Application Pack over an
existing Application Pack, follow these steps:

1. Repeat the steps 1 to 9 from the Executing the Schema Creator Utility section.

Note: Ensure to use the same config schema user name as the previous
Application Pack.

2. The utility identifies the Application Packs that are already installed on the current OFSAA
setup and displays the following on console:

> Atomic schema of the Existing Application Pack
> Information Domain Name of the Existing Pack, and the

> List of Installed Application Packs
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Figure 4-11 Schema Creator Utility while installing Subsequent Application Pack

3. Select the Atomic User, on which you want to install the Application Pack.
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Figure 4-12 Schema Creator Utility while installing Subsequent Application Pack

On successful execution of schema creator utility, the console displays the following status
message:

Success. Please proceed with the installation.

Note:

» Refer log file in OFS_AAAI PACK/schema_creator/logs folder for execution
status.

» Refer log sysdba_output_scripts.log file for execution status, if executed in
offline mode. This log would be empty if there are no errors in the execution.

? In case of any errors, contact Oracle Support.
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Installing the OFS AAAI Application Pack

Follow the instructions in this section to install the OFS AAAI Application Pack depending on
the mode of installation.

This section includes the following topics:

?

?

?

SILENT Mode Installation
GUI Mode Installation

Verifying the Log File

SILENT Mode Installation

In the SILENT Mode Installation you must configure the product xml files and follow the
instructions in command prompt.

To install OFS AAAI in SILENT mode, follow these steps:

1.
2.

8.

Log in to the system as non-root user.

Identify a directory for installation and set the same in the user .profile file as follows:
FIC HOME=< OFSAA Installation Directory >

export FIC HOME

Execute the user .profile.

Navigate to OFS_AAAI PACK folder.

Edit the OFS_AAAI PACK/conf/OFS AAAI PACK.xml to enable the product licenses.

Note: Refer Configuring <<APP Pack>> PACK.xml file for details on
configuring this XML file.

Edit the OFS_AAAI PACK/schema creator/conf/OFS AAAI SCHEMA IN.xml file to set
the appropriate attribute values.

Note: Refer Configuring <<APP Pack>> SCHEMA IN.XML file for
details on configuring this XML file.

Edit the OFS_AAAT PACK/OFS AAI/conf/OFSAAI InstallConfig.xml file to set the
appropriate infrastructure installation attribute values.

Note:
> This step can be ignored if an installation of OFSAA 8.0 already exists.

> Refer Configuring OFSAAI InstallConfig.xml file for details on
configuring this XML file.

Execute the schema creator utility.
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Note:

> This step is mandatory and should be executed before every OFSAA
Application Pack installation.

> Ensure to execute with -s option in Online/ Offline Mode.

> For more information, refer Executing the Schema Creator Utility.

9. Enter the following command in the console to execute the application pack installer with
SILENT option.

./setup.sh SILENT

Figure 4-13 Silent Mode Installation

10. Enter the Infrastructure FTP/SFTP password value, when prompted at the command
prompt.
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Figure 4-14 Silent Mode Installation

Table 4-1 Console Prompts - Silent Mode installation

Console Prompts

User Inputs

Please enter Infrastructure
FTP/SFTP password

Enter the password to access Product Staging/Metadata repository
directory in the application server.

Note: In case the prompt reads as follows, enter the username/
password for accessing the product Staging/ Metadata Repository
FTPSHARE

? Kerberos username [user]

»  Kerberos password for user:

11. Enter Always, when prompted to add host key fingerprint.

The OFSAAI License Agreement is displayed.
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Figure 4-16 Silent Mode Installation

12. Enter Y/y to accept the License Agreement.

13. Enter the passwords for default Infrastructure administrator and authorizer users.

Table 4-2 Console Prompts - Silent Mode installation

Console Prompts User Inputs

Please enter password for Enter the password for the System Administrator.
default Infrastructure
administrator user SYSADMN

Please re-enter password for Enter the same password again to confirm its validity.
default Infrastructure
administrator user SYSADMN

Please enter password for Enter the password for the System Authorizer.
default Infrastructure
authorizer user SYSAUTH
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Table 4-2 Console Prompts - Silent Mode installation

Console Prompts User Inputs

Please enter password for Enter the same password again to confirm its validity.
default Infrastructure
authorizer user SYSAUTH

Note: SYSADMN and SYSAUTH are the two defaults OFSAAI
administrative users created.

Figure 4-17 Silent Mode Installation
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Figure 4-18 Silent Mode Installation

Note: The installation process continues on the console. Do not close the
console until the installation process is complete.

14. The following message is displayed in the console:
Installation completed...

15. On completion of installation, refer the installation log files.
For more information, refer Verifying the Log File.

16. Install the consolidated one-off patch 25777667. Refer to the Readme available with the
patch for further instructions on installing the patch.
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17. Perform steps mentioned in the Post Installation Configuration section.

Note: Download and install patch for Bug 21160684 if installing this
release of the OFS AAAI Application Pack version 8.0.0.0.0 on Java 8. For
more information, refer Configurations for Java 8. This patch is not required
if an OFSAA instance already exists and is configured for Java 8.

GUI Mode Installation

Note: Ensure you have followed the steps as mentioned in the
Configuration for GUI Mode Installation section prior to proceeding with the
next steps.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the
following:

FIC HOME=<OFSAA Installation Directory>
export FIC HOME
3. Execute the user .profile.

4. Navigate to the path: OFS_AAAI PACK.

5. Editthe OFS ARAI PACK/schema creator/conf/OFS AAAI SCHEMA IN.xml file to set
the appropriate attribute values.

Note: Refer Configuring <<APP Pack>> SCHEMA IN.XML file for
details on configuring this XML file.

6. Execute the schema creator utility.

Note: This step is mandatory and should be executed before every OFSAA
Application Pack installation.

Refer Executing the Schema Creator Utility for more details.

7. Execute the following command in the console.

./setup.sh GUI

Note: Refer the console for any errors during Pre-install checks.
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Figure 4-19 Initialization Window

Welcome to the OFSAA 8.0 Application Pack
Installation

ORACLE’
FINANCIAL SERVICES

Copyright @ 1383, 2015, Oracle andior Ex affiliates. Al righls reserved,

| I E——

8. The general License Agreement is displayed.

Figure 4-20 License Agreement

License Agreement
Welcome to the OFSAA Application Pack Installation
This program will guide you through the installation of OFSAA Application Pack.
Copyright © 1293, 2014, Oracle and / or its affiliates, Al rights reserved.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual
property laws, Except as expresshy permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadecast, modify, license,
transmit, distribute, exhibit, perform, publish or display any part, in any form, or by any means. Reverse e or dec of this
software, unless required by law for interoperability, i prohibited,

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find amy errors, please repon them to us in writing.

If this software or related documentation is delivered to the U.5. Government or anyone licensing it on behalf of the U5, Government, the Tollowing notice is
applicable

U.5. GOVERNMENT END USERS: Oracle programs, inclucing any operating system, imegrated software, any programs installed on the hardware, and/for
documentation, delivered to US. Covernment end users are "commercial computer software pursuant to the applicable Federal Acquisition Regulation and
agency-specific supplememal regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system,
integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the
jprograms. Mo other rights are granted to the LS. Government

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in amy inherently
dangerous applications, including applications that may create a risk of personal injury. If you wse this software or hardware in dangerous applications, then vou
shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim
any liabllity for amy damages caused by use of this software or hardware in dangerous applications.

This software or harcware and documentation may provide access to or information on content, products, and sendces from third parties. Oracle Corporation and
its affiliates are not responsible for and expressty disclaim all warranties of any kind with respect to third-party content, products, and sendces. Oracle Corporation
and its affiliates will not be responsible for any loss, costs, or damages incurred due to vour access 10 or use of third-party content, products, or services,

ORACLE
FIVANCIAL SERVIES

1 geeeptthe terms of the Licenss Agresment

() 1 do NOT accept the terms of the License Agresment

9. Select I accept the terms if the License Agreement option.

10. Click Next.
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The Financial Services Advanced Analytics Infrastructure Pack details are displayed.
Figure 4-21 Applications Pack Details

Financial Services Advanced Analytics Infrastruciure Pack

B Predral Sete Applicasen Pack B : OFS_Adal_PACK D’?ACLE-
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preioes e}

11. Select the product (s) to enable.

Note: Financial Services Analytical Applications Infrastructure is selected
by default.

12. Click Next.

The Application Pack License Agreement window is displayed.

Installing the OFS AAAI Pack 4-47



Installing the OFS AAAI Application Pack

Figure 4-22 Application Pack License Agreement window

Financid Services Advanced ﬁﬂ:ﬂj“llf! Infrastructure Pack License Agresment

Iersraiation and u<e of Financial Servioes Advanoed Anshtics InFrastrucoene Pack Insualles requine s acteprasce of the folbsning license agreement
DESAS APFUCATION PALK LICENSE ALFEEMENT
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addresses speci funciiznal comales wa 3 produns thae are grouped 10gnher. The Orscle Financial Sersces Anadaical Appiicanong infrasirucrere (0FS AMD Deing
the base nfraciruciure Tor deployment of ofher OFSAA products LApplcation Facks, is bundied with each Applicalion Pack. With every Applicalion Pac insall .
A OF5AS INArasiructhere Doodud would De tRecked for anid inalled # reguired
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13. Select I accept the terms of the License Agreement option.
14. Click Next.

The Pre Installation Summary is displayed.
Figure 4-23 Pre-Installation Summary

Pre Installation Surmmar

Fiease peview e Tollowing before continuisg

§ Freingel Setup
Application Pack 1D
OF5S_AAAL PACK

Application Fack Same
Financial Services Advanoed Anabytcs Infrascroccure Pack

Application Pack Virsion
B.0.0.0.0

Belony produscts are selected ta he enablet

Fi I Servicds AREIIEl ApElcRTons Bnfra s o
Fi | Services Enverprise Modelin
Finuncial Sericss Inling Procassing Engine

[ _preveus e |

15. Click Next.
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The Manage Information Domains window is displayed.

Figure 4-24 Manage Information Domains window

Manage Infarmatien Domalns
& [nfarrmation Domain MName ieatimn Mame Irforemation Damain Desoription Ty DE Schims
L
b Preln gl Setup Financial Services Enterpeise  frformaiion Doman for OFS, AA4
CFSARAINF ) ppceing QM2 0
] ritSrTion Domdn fof OFF_uad
racessing Engng e um2 0

16. The default Information Domain Name for this Application Pack is OFSAAAIINFO.

Double-click the Information Domain Name field to edit.

Note: In case of subsequent Application Pack installation on the same
Information Domain, the Information Domain Name is not editable.

Permissible length is 16 characters and only alphanumeric characters are
allowed. No special characters are allowed.

17. Click Next.

The User Installation Directory window is displayed.
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Figure 4-25 User Installation Directory

User Installation Directory

User Installation Directory
Sfecratchfofsaadb fJOFSAL

ORACLE
FINANCIAL SERVICES

InstallAmaswhers

[ coco | oo |

Note: The User Installation Directory path is auto-populated from the path
you have set in the user .profile file in Step 2.

18. Click Next.
The OFSAA Infrastructure Server Details window is displayed.

Figure 4-26 OFSAA Infrastructure Server Details

OFSAA Infrastructure Server Details

o License Enter requested information :

= Frelnsiall Setup
e Mate: If the JDBC_URL is of RAC type then DB Server IPfHostname

field name should be ha

OFSAAl Server IP / Hostname :
|_myhost. mydomain.com

Database Server IP / Hostname ;
| 0fss220823

ORACLE
FINANCIAL SERVICES

Installarmawhere

corce [ eo |

19. Enter the IP address or hostname of the Database Server.

Note: The OFSAAI Server IP/Hostname is auto-populated by default.

20. Click Next.

4-50 OFS AAAI Application Pack Installation and Configuration Guide



Installing the OFS AAAI Application Pack

The Web Application Server window is displayed.

Figure 4-27 Web Application Server

Web Application Server

i License

Choose the Web Application Server tyoe
= Prelnstall Setup

Installation..
Install Complete

) Tamcat
® lWebSphere
) irehlogic

ORACLE’
FINANCIAL SERVICES

21. Seclect the appropriate Web Application server type. The options are Tomcat, WebSphere,
and WebLogic.

22. Click Next. Based on the selection, corresponding windows are displayed.

23. For WebSphere: The WebSphere Setup Details window is displayed.

Figure 4-28 WebSphere Setup Details

WebSphere Setup Details

o License Enter WetSphere installation Path up 10 the Host name directony
=¥ Prelnsiall Setup For Ex:- fdata2 ftestf/WebSphere/appierver/profiles/ < Profile Na
me s finstalledApps, <celiMame >

ORACLE
FINANCIAL SERVICES
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a. Enter the installation path (up to the Node Cell Name directory) of WebSphere. The
format is WebSphere path <WebSphere profile
directory>/installedApps/<NodeCellName>.

24. For Tomcat: The Absolute Tomcat Path window is displayed.

Figure 4-29 Absolute Tomcat Path

Absolute Tomcat Path

o) License Enter absolute Tomcat Installation path where Oracle Financial
= Prelnstall Setup Services Anahdgical Applications Infrastructure is to be deployed.
Installation Example:- jhomefdatalftomcat-7.0.19 fwebapps

I i E4

Install Complete

Iscratch/ofzaadbitomcat/webapps

ORACLE
FINANCIAL SERVICES

a. Enter the Tomcat installation path (till/webapps) where OFSAALI is deployed.

25. For WebLogic: The Weblogic Home window is displayed.
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Figure 4-30 Weblogic Home

Weblogic Home

Enter Weblogic Home
For Ex: fhome fweblogic/beajweblogic 10.3.5.0

ORACLE’
FINANCIAL SERVICES

Installamawhere

a. Enter the WebLogic home directory path.

Figure 4-31 Weblogic Setup Details

Weblogic Setup Details

o) License Enter Weblogic Domain Home
S Prelnstall Setup For Ex: fhome,wehlogicfbeajuser_projectsfdomainsfmydomain

() Installation:.
() Install Complete

ORACLE’
FINANCIAL SERVICES

Install A, e

b. Enter the path of the Weblogic domain directory and click Next.
The OLAP Details window is displayed.
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Figure 4-32 OLAP Details

OLAP Details

o License Mate -

1 = Enabled 0=Disabled
If walue is 1 then ARBORPATH, HYPERICK_HOME & ESSBASEPATH
wariables should he set in .profile before installation.

53 Pralnstall Setup
Installation..

Install Complete

CONFIGURE OFSAAI OLAP FEATURE :
0

ORACLE
FINANCIAL SERVICES

26. Enter 1 if you want to configure OFSAA OLAP feature using Oracle Hyperion Essbase.
By default, it is set to 0.

27. Click Next. The Web Server Details window is displayed.

Figure 4-33 Web Server Details

Web Server Details

o License Mote : Context name will be used in vour Application URL

http: ff < WebServerlP = <Sendet ports f<contextname = flagin. jsp
Example:;- httpo 10 80.50.206: 9080/ rmyvapp/login. jsp

¥ Prelnstall Setup
() Installation..
() Install Complete

EMABLE HTTPS

WEE SERVER PORT
| 9061 |

[»]

WEE APF SERVER IP
| 11121314 |

Context name for deployment
| Profsa733 |

ORACLE

_—— WEB LOCAL PATH
FINANCIAL SERVICES

|;scraz:hmnspherempshare |

28. By default, ENABLE HTTPS is selected. If you want to install without HTTPS enabled,
click the checkbox to remove the selection and proceed with the installation. Enter the Web
Server (HTTP Server) Port, Context name for deployment, and Local path to any folder on
the Web Application Server (Tomcat/Websphere/Weblogic).

29. Click Next. The Database Details window is displayed.
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Figure 4-34 Database Details

Database Details

@ License 8 (oTE
= Frelnstall Setup Specify the Database user name which is the user created for
() instaliation configuration database schema. For example: configuser
Eauloesla Specify the Database driver path as <ORACLE_HOME > fjdbc/lib
() Install Complete where < ORACLE_HOME > should be replaced with ORACLE_HOME
walue.

The ABSOLUTE DRIVER. PATH refers to the |DBC driver files path.

[»]

ORACLE SID / SERVICE_NAME :
| oFsADE |

JDEC URL:
| jdbc:oracle:thin @ 11.12.13.14.1516: OFS0ADE |

CONFIG SCHEMA USER ID :
[Doc7zzconF |

Oracle Configuration Schema Password

ORACLE’
FINANCIAL SERVICES

ABSOLUTE DRIVER PATH :
| | Jscratchforacle fappforacle/product f 112 . 0fclient _1/jdbc flib |

Ins

Eestore Default || Choose... |3

30. Enter Oracle SID/Service Name.

Note:

> The JDBC URL, Configuration Schema User ID, Oracle Configuration Schema
Password, and Absolute Driver Path are auto-populated.

»  Absolute Driver Path can be the path where Oracle DB client is installed or
JDBC driver is installed. For example,
/scratch/oracle/app/oracle/product/11.2.0/client 1/jdbc/lib

31. Click Next. The Ports Configuration window is displayed.
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Figure 4-35 Ports Configuration

Ports Configuration

o License

= Prelnstall Setup

Enter required information ;
Mote: Ports must have unigue walue.

() Installatian..

[»]

() Install Complete Java Port

19999 |

Native Port
6666 |

Agent Port
16510 |

ICC Server Port
6507 |

ORACLE
FINANCIAL SERVICES

ICC Native Port
16509

Note: The Java Port, Native Port, Agent Port, ICC Server Port, and ICC
Native Ports are auto-populated. You can also modify the Ports settings.

32. Click Next. The Ports Configuration window is displayed.
Figure 4-36 Ports Configuration

Ports Configuration

f) License Enter requested information ;
S Prelnstall Setup Mote: Ports must have unigue value.

() Installation..
() Install Complate

OLAP Port
| 10101

Message Server Port
6501

Router Port
6500

AM Port
| 6505

ORACLE’
FINANCIAL SERVICES

Previous

Note: The OLAP Port, Message Server Port, Router Port, and AM Port
details are auto-populated. You can also configure the Ports settings.
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33. Click Next. The Default Infrastructure Administrator and Authorizer User Password
window is displayed.

Figure 4-37 Default Infrastructure Administrator and Authorizer User Password

Default Infrastructure Administrator and Authorizer User Password

o) License Enter requested information

= Preinstall Setup

() Installation.. Please enter password for default Infrastructure
administrator user SYSADMN :

() Install Complete
| LIt 1L 1Ll]]

Please re-enter password for default Infrastructure
administrator user SYSADMN @

Please enter password for default Infrastructure authorizer
user SYSAUTH :

ORACLE Please re-enter password for default Infrastructure
authorizer user SYSAUTH :

FINANCIAL SERVICES

It | ArE

34. Enter the passwords for default System Administrator and System Authorizer users.

35. Click Next. The SFTP Details window is displayed.

Figure 4-38 SFTP Details

SFTP Details

f License Mate -
= Prelnstall Setup For enakle SFTP : If walue iz 1 then SFTP will be enabled . If value is

y : 0 then FTP will be enahled
Inztallation

Install Complete

ENABLE SFTP
[1

FILE TRANSFER PORT :
|22

ORACLE’
FINANCIAL SERVICES

Cancel Prewvious
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Note:
> Enable SFTP and File Transfer Port details are auto-populated.

Ensure that the system, on which the OFSAA Infrastructure is being installed,
has either FTP/SFTP enabled.

» You can also modify the SFTP settings

36. Click Next. The OFSAAI Post Install Details window is displayed.

Figure 4-39 OFSAAI Post Install Details

OFSAAI Post Install Details

W License FTPSHARE PATH
) Preinstall Setup | fstratch/ofsaadb/Mpshare
[ Eestore Defaul |

FTP [ SFTP USER ID
| afsaadb

Please enter Infrastructure FTP/SFTP password:
| uauu.|

ORACLE’
FINANCIAL SERVICES

Installanywhers

37. Enter the FTPSHARE Path. This is same as the OFSAA Staging/ Metadata Repository
Directory.
38. Enter the FTP/SFTP User ID and Password for FTPSHARE Directory access.

Note: The transfer of data (files) between the OFSAA Server and the Web
Application Server happens over FTP/ SFTP. Ensure the necessary host
configurations are made for a successful handshake. For more details, refer

FTP/SFTP Configuration for File Transfer.

39. Click Next. The Pre Installation Summary window is displayed.
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Figure 4-40 Pre Installation Summary

Pre-installation Summary

@ License Please review the following before contihuing:

= Prelnstall Setup
Product Name:
OFSAAInfrastructure

Installation.
() install Complete

Version
3.0.00.0

Installation Folder
fecratchfofsaadh [ OFSAAI

Required Space
990 MegaBytes

ORACLE Available Space

e 57543 MegabBytes
FINANCIAL SERVICES

Selartad | nrcale

40. Click Install. The Installing OFSAA Infrastructure window is displayed.

Figure 4-41 Installing OFSAA Infrastructure

Installing OFSAAInfrastructure

W Licensa
o Preinstall Setup
=¥ Installation_.

O

Installation is in progress...
This process may take several minutes, Please Wait,

ORACLE
FINANCIAL SERVICES

Installing...

Installarnywhers

Note: Anytime during the installation you can click Cancel to stop the
installation. Once completed, the Installation Summary window is displayed.

41. Once completed, the Installation Summary window is displayed.
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Figure 4-42 Installation Summary

INSTALLATION SUMMARY

P License INSTALLATION SUMMARY.
® Preinstall Setup Ml [T
= g #FATAL ERRORS===== 0
Installation.. BERRORS —==—mmmmmee -0
¥ Install Complete #DEBUG STATEMENTS: 666
#INFORMATIONS-=---: 283
EWARNINGS =< mmmmman 0

Note:

Please see the installation log under
fscratchfofsaaapp/OFS_AALl PACK/OFS_AA flogs/OFSAMIE log and
fscratchfofsaaapp,/ASAIPACK fOFSAAINTrastructure_Install.log for
mare details.

Click on Mext to continue,

ORACLE
FINANCIAL SERVICES

The Summary window displays the number of Fatal Errors, Errors, Debug Statements,
Informations, and Warnings along with the location of log files.

42. Click Next. The Installation Complete window is displayed.

Figure 4-43 Installation Complete

Installation Complete

Congratulations! Oracle Financial Services Anahtical Applications
& Freinstall Setup Infrastructure has been successfully installed,

W@ Instaliation.. Click on "Done” ta exit the installer. Please do not close the
& Install Complete console. Post Install activites will be performed in consale..

ORACLE’
FINANCIAL SERVICES

InstallAnywhere

Previous Done

43. Click Done. The following message is displayed:

Please wait, pack_install is being configured for your system. This may take a moment.
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Figure 4-44 Checking OFSAAI Services

Please Wait
¥ Prelnstall Setup
Please w Exzcuting AAl Installation Script... 47 system. This may take a moment..
EESSSSSSSS S
ORACLE
FINANCIAL SERVICES

44. The Checking OFSAA Service window is displayed.

Note: This step verifies the OFSAA services startup. In case of errors
during services check, an appropriate error message is displayed.
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Figure 4-45 Checking OFSAA Services

Please Wait

=¥ Frainsiall Setup

Pleasew Checking OFSAA Service... i system. This may take a moment..

ASSSSS\NSS\SSNSN]

ORACLE
FIVANCIAL SERVICES

Installampwhere

45. After checking the OFSAA services, installation proceeds with the Application Pack
Installation.

The Installing Financial Services Advanced Analytics Infrastructure Pack window is
displayed.
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Figure 4-46 Installing Application Pack

Please Wait
¥ Preinstall Setup
@ Instaliatior
a Installing Financial Services Advanced Anahytics Infrastructure Pack_, S M3y take a moment..
R s S S S S S % S % %S S %%
ORACLE
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46. On completion of Application Pack installation, the Installation Summary window is
displayed.
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Figure 4-47 Installation Summary

INSTALLATION SUMMARY.

o) Freinstall Setup
@ Installation..
=¥ Install Complete

HINFORMATIONS - -~~~ D27
FWARNINCS <eamcaman ]
Note:

Flease see the installation log under fscratchfofsaadbfOFS_AAAPACK flogs/Pack_Install log
Click on Next to continue.

ORACLE

FINANCIAL SERVICES

Note: In case of any ERRORS/ FATAL ERRORS, contact Oracle Support.
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Figure 4-48 Installation Complete

Congratulations! Financial Senices Advanced Anahtics Infrastructure Pack has been successfully installed.
& Freinstall Setup
o Instaliation,

k¥ Ins1all Complete

Click on "Done” ta exit the installer. Please do not close the console. Past Install activites will be performed in console..

ORACLE
FIANCIAL SERVICES

47. Click Done.

Note: The installation process continues on the console. Do not close the
console until the installation process is complete.
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Figure 4-49 Installation Complete

I$ ecd Secratchd/ofsasdb/OFS_ARAT_PRCKDin

1% 1=

EOFSﬁI‘-lI..iar' install.jar pack_install.bin pack_installsilent.bin setup.sh
1¥ .rsetup.sh GUL

| FIC_HOME : /scratchsofsaadb/OFSARI
| DISPLAY = localhost:lO.0
{Ervironment check wtility started...

rava walidation Started ...
E Java found in @ Susrdjavadjrel B.0_45/Din
| JAvA Version Found @ 1.6.0_45

| JewWA Bit Version found : 64-bit

Java Walidation Completed. Status : SUCCESS
i|=== ===

lEmvironment Varisbles Walidation Started ...
ORACLE_HOME : /scratch/oracle/apploraclesproduct/11.2.0/client 1
THE_ADHIN : /scratch/ofsaadb/tnsentry

Erwironment YWarisbles Walidation I:onpleted Status @ SUCCESS

0S5 specific Wal ld.:tion Started ...

Unix shell found @ /bindksh. Status @ SUCCESS

Total file descriptors @ 3216, Stat,us * SUCCESS
Total number of process @ unlimited. Status : SUCCESS
05 wersion : 6. Status : SUCCESS

05 specific Validation Completed. Status : SUCCESS

DB specific Walidation Started ...

Oracle Client wversion @ 11.2.0.3.0, Status @ SUCCESS

CREATE SESSION hasz been granted to user. Status @ SUCCESS

CRERTE FROCEDURE hasz bBeesn granted to user, Status ;T SUCCESS

CREATE YIEW has been granted to wser. Status : SUCCESS

CREATE TRIGGER hasz been granted to user. Status ; SUCCESS

CREATE MATERIALIZED YWIEW has been granted to user, Status ; SUCCESS

CREATE TABLE has been granted to user, Status @ SUCCESS

CREATE SEQUEMCE has been granted to user, Status ; SUCCESS

SELECT privilege is granted for ¥_$nls_parameters wview, Current wvaluwe @ SELECT.
Status i SUCCESS

HLS_LENGTH_SEMANTICS : EYTE. Current walue : BEYTE. Status @ SUCCESS
NLS_CHARACTERSET & ALZ2UTFE. Current walue : ALIZUTFS. Status : SUCCESS

SELELCT privilege iz granted for ¥_$paramster wview. Current walue : SELECT. Stat
us @ SUCCESS

Open cursor walue is greater than 1000, Current waluwe : 1200, Status : SUCCESS
SELECT privilege iz granted for USER_TS_OUOTAS wiew, Current walwe ; SELECT, St
atus @ SUCCESS

Schema is granted with at least 500 HE table space. Current value & Unlimited.
Status  SUCCESS

Oracle Server version Current value @ 11.2.0.3.0. Status : SUCCESS

DB zpecific Yalidation Completed, St.!tus 4+ SLCCE!

.Envlr‘onuult- check utility Status : SUCCESS

Start:.ng installation...

IPrepacing to install...

{Extracting the installation resources from the installer archiwe...
.Conl‘:gur-mg the installer for this sustem’s enwvironment...

Launching installer. ..

CTEL characters removal started ...

CTRL characters removal ower ...

Hindows executable files removal started ...
Hindows executable files remowval owver ...
He are now in Ascratch/ofsaadb ...

OFSAR App Layer Serwvices start-up check started...
Starting startofsaai.sh service...

nohup: appending output to “nohup.out”

OFSAA Serwvice — OK

Starting icc service...

rnohup: appending output to “nohup.out”

ICC service - OK

Shutting down icc serwvice...

rnohup: appending output to “nohup.out”

Shutting down OFSAA service...

nohup: appending output to “nohup,out”

OFSAAL App Layer Services check Status: SUCCESSFUL .
OFSAAL DB Layer Serwices check started,..

checking Router serwvice...

Fouter Service -

checking AM service,..

AM Service - OK

Checking MessageServer service, ..

DEBUG: main started,

DEBUG: TraceFileName = /scratch/ofsaadbs/0FSAR]L/Ficdb/'log/msg_trace_file.log
DEEUG: OpenFiles done,

MessageServer Service — 0K

OFSAAL DB Layer File Serwvices check Status: SUCCESSFUL.
Installation completed., ..

basename: missing operand

Try “bazsename --help” for more information.

executing "ant"

Unable to locate tools. jar. Expected to find it in Ausr/javasjrel .B6.0_45/1ibs/tools. jar
Buildfile; Sscratch/ofsaadb/OFSAALAFicuweb /build,xml

Trying to override old definition of datatype resources

existtest:
[echol] Checking for file /scratch/ofsaadb/OFSAALAFicueb /ARA] .war existense

createwar:
[echol] Creating Ascratch/ofsaadb/OFSAALAF icweb ARAL .war freshly..
[war] Building war: Sscratchs/ofsaadb/0OFSAALSFicweb/ARAL . war

BUILD SUCCESSFUL
Total time: 34 seconds
= W

48. You have successfully installed the OFS AAAI Application Pack.
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49. Install the consolidated one-off patch 25777667. Refer to the Readme available with the
patch for further instructions on installing the patch.

50. Perform steps mentioned in the Post Installation Configuration section.

Note: Download and install patch for Bug 21160684 if installing this
release of the OFS AAAI Application Pack version 8.0.0.0.0 on Java 8.

Verifying the Log File
Refer the following logs files for more information:

» Refer the Pack Install.log located at OFS AAAI PACK/logs/ folder for OFS AAAI
Application Pack installation log file.

»  Refer the log file(s) located at OFS_AAAI PACK/OFS AAI/logs/ folder for Infrastructure
installation log.

»  Refer the OFSAAInfrastucture Install.log located at SFIC_HOME folder for
Infrastructure installation log.
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Post Installation Configuration

On successful installation of the Oracle Financial Services Advanced Analytical Applications
Infrastructure Application Pack, follow these post installation steps.

This chapter includes the following sections:

2

2

2

Configure Resource Reference

Start OFSAA Infrastructure Services

Add TNS entries in TNSNAMES.ORA file

Configuration for Oracle R distribution and Oracle R Enterprise (ORE)
Configuration for Oracle Financial Services Inline Processing Engine (OFS IPE)
Configurations for Java 8

Create and Deploy the Application Pack Web Archive

Access the OFSAA Application

Perform Post Deployment Configurations

Note: Ensure to clear the application cache prior to the deployment of
Applications Pack Web Archive. This is applicable to all Web Servers
(WebSphere, WebLogic, and Tomcat). For more information, refer Clearing
Application Cache section.

Configure Resource Reference

Configure the resource reference in the Web Application Server configured for OFSAA
Applications. Refer Appendix B for details on configuring the resource reference in
WebSphere, WebLogic, and Tomcat Application Servers.

Start OFSAA Infrastructure Services

Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA
Applications. Refer to the Appendix D for details on Start/ Stop OFSAA Services.

Add TNS entries in TNSNAMES.ORA file

Add TNS entries in the tnsnames.ora file, for every schema created for the Application Pack.

To find the tnsname for the entries, follow these steps:

1.

Login to the application using System Administrator privileges.
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o » 0N

Navigate to System Configuration & Identity Management tab.

Click Administration and Configuration >> System Configuration >> Database Details.
Expand Name to get the list of TNS entry names.

Alternatively, you can connect to the CONFIG schema and execute the following query:

select dbname from db master where dbname !='CONFIG'

Configuration for Oracle R distribution and Oracle R
Enterprise (ORE)

This is an optional step. Skip and proceed with the next steps if OFS Enterprise Modeling
Application with R scripting is not enabled during installation.

1.

Install OFSAAIRunner Package. For more information, refer Installing OFS AAAI Runner
Package. If you have already installed OFSA AIRunner package (as part of a previous
installation), uninstall it. (For more information, refer Uninstalling OFSA AIRunner
Package section), and reinstall the latest available OFSA AIRunner package.

Log in to the database with dba privileges and provide the following privilege to
Configuration Schema:

ROADMIN by executing the command:
GRANT RQADMIN TO <config schema>;

Log in to the database with dba privileges and provide the following privileges to Atomic
Schema:

CREATE UNLIMITED TABLESPACE privilege by executing the command: GRANT CREATE
UNLIMITED TABLESPACE TO <atomic_schema>;

CREATE MINING MODEL privilege (to execute the Data Mining models) by executing the
command:
GRANT CREATE MINING MODEL TO <atomi c_schema>;

Installing OFS AAAI Runner Package

OFSAAIRunner is an R package built by the OFS Enterprise Modeling Application. It is a
prerequisite for executing models developed using R scripts. This package helps in:

?

?

?

?

Initializing inputs
Mapping framework variables to R objects
Configuring possible outputs of the script

Storing results back to the Database

OFSAAIRunner package (OFSAAIRunner 1.0.0.tar.gz) is available under SFIC DB
HOME/1ib.

Prerequisite

Oracle R & ORE should be installed on the Oracle Database server before installing
OFSAAIRunner package.

Refer to the following instructions to install OFSAAIRunner package:

1.

Log in to the OFSAA Server. Navigate to the folder SFIC_DB HOME/lib.
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Copy the file OFSAAIRunner 1.0.0.tar.gz in Binary mode to the Oracle Database
Server.

Log in to the Oracle Database Server with the user using which Oracle Database Server
installation is done.

Navigate to the directory where the file OFSAATRunner 1.0.0.tar.gz is copied.
Install the package by executing the command:

ORE CMD INSTALL OFSAAIRunner 1.0.0.tar.gz

Successful installation is indicated in the installation log as:

* DONE (OFSAAIRunner)

Making packages.html ... done

Note: The OFSAAIRunner package is installed in
/usr/1ib64/R/1library.

Navigate to the directory SORACLE_HOME/R/library and check whether OFSA AIRunner
package is listed there by executing the command:

>library (OFSAAIRunner)
>OFSAAIRunner:: and press TAB twice.

This lists out all the functions.

Uninstalling OFSAAIRunner Package

Refer to the following instructions to uninstall the OFSAAIRunner package:

1.

Log in to the Oracle Database Server with the same username, using which Oracle
Database Server installation is done.

Enter ORE in command prompt and execute the command:
#ORE

>remove.packages("OFSAAIRunner")

To save workspace image, enter the command:

>q0)

Enter y when prompted to save the workspace image.

Save workspace image? [y/n/c]: y

Navigate to the directory SORACLE_HOME/R/library and verify the package is not listed
there by executing the command:

Is -1

Configuration for Oracle Financial Services Inline
Processing Engine (OFS IPE)

Follow the instructions in Oracle Financial Services Inline Processing Engine
(IPE) Configuration Guide 8.0.0.0.0 to configure the OFSAA instance for using OFS
Inline Processing Engine. This step is mandatory if you have enabled OFS Inline Processing
Engine during the installation.
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Configurations for Java 8

Configurations for Java 8
Refer to the following instructions to extract and apply the patch.
1.  Copy the downloaded patch file (21160684) to your OFSAA server in Binary mode.

For more information on downloading the patch files, refer Prerequisite Information
section >> Category - Others >> Sub-Category - OFSAA.

2. Follow the instructions given in the Readme to apply the patch.

3. Ifthe Oracle Database version is 12¢, copy ojdbc7.jar from $SORACLE HOME/jdbc/lib
to the following locations:

> SFIC HOME/utility/OFSAAGenerateRepository/lib/

> SFIC HOME/realtime processing/WebContent/WEB-INF/1lib/
»  $FIC_HOME/ficdb/lib/

»  SFIC HOME/ficapp/icc/lib/

»  SFIC HOME/ficapp/common/FICServer/lib/

»  SFIC HOME/FMStandalone/FormsManager/WEB-INF/lib/

> SFIC HOME/ficweb/webroot/WEB-INF/lib/

? SFIC HOME/ficdb/etl/classes/

Note: Ifojdbcé.jar is already present in any of the aforementioned
folders, you need to remove it.

4. [If the Oracle Database version is 11g, copy ojdbc6.jar from SORACLE HOME/jdbc/1lib
to the following locations:

»  S$FIC HOME/utility/OFSAAGenerateRepository/lib/

»  SFIC HOME/realtime processing/WebContent/WEB-INF/1lib/
»  SFIC_HOME/ficdb/lib/

2 SFIC HOME/ficapp/icc/lib/

> SFIC HOME/ficapp/common/FICServer/lib/

»  SFIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

»  $FIC_HOME/ficweb/webroot/WEB-INF/lib/

»  $FIC_HOME/ficdb/etl/classes/

Create and Deploy the Application Pack Web Archive

On successful installation of the OFSAA Application Pack, the web archive file is
automatically generated. However, you need to deploy the generated web archive file on the
Web Application Server.

For identifying the location of the generated web archive file and for generating and deploying
the web archive file at any time later, refer Appendix C.
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Note: Refer the Oracle Financial Services Forms Manager User Guide for
instructions on Creating and Deploying the Forms Manager Web Archive.

Access the OFSAA Application

Prior to accessing the OFSAA application ensure the Internet Explorer Settings are configured.

Refer to Appendix E for details on accessing the OFSAA Application on successful
deployment of the application web archive.

Perform Post Deployment Configurations

Prior to using the OFSAA Application perform the Post Deployment Configuration steps
detailed in Appendix F.
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Configuring Web Server

This section covers the following topics:
> Configuring Web Server
> Configuring Web Application Servers

Configuring Web Server
This step assumes an installation of a Web Server exists as per the prerequisites.

Refer the product specific installation guide to install and configure the Web Server. If an
installation already exists, skip and proceed to the next step.

Note:

> Make a note of the [P Address/ Hostname and Port of the web server.
This information is required during the installation process.

> Refer Oracle Financial Services Analytical Applications Infrastructure
Security Guide mentioned in the Related Documents section for additional
information on securely configuring your Web Server.

- Ensure to enable sticky session/ affinity session configuration on the web
server. Refer the respective product specific Configuration Guide for
more details. Additionally, you also need to enable the sticky session/
affinity session configuration at Load Balancer level if you have
configured a Load Balancer in front of the web server(s).

Configuring Web Application Servers

This step assumes an installation of a web application server exists as per the prerequisites. To
configure the Web Application Server for OFSAA Deployment refer the following sections.

This section includes the following topics:
> Configuring WebSphere Application Server for Application Deployment
> Configuring WebLogic for Application Deployment

> Configuring Apache Tomcat Server for Application Deployment
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Note:

> Make a note of the IP Address/ Hostname and Port of the web
application server. This information is required during the installation
process (required if Web Server is not configured).

> Refer OFSAA Secure Configuration Guide/ Security Guide mentioned in
the Related Documents section for additional information on securely
configuring your Web Server.

Configuring WebSphere Application Server for Application Deployment

You can deploy multiple OFSAA applications on different profiles of a stand-alone WebSphere
application server. To create multiple WebSphere "Profiles" in a stand-alone server, use the
command line option as explained in the following section. A profile is the set of files that
define the runtime environment. At least one profile must exist to run WebSphere Application
Server.

This section covers the following topics:

> Creation of New Profile in WebSphere
> Manage Applications in WebSphere

> Delete WebSphere Profiles

> WebSphere HTTPS Configuration

> WebSphere Memory Settings

Creation of New Profile in WebSphere

The Profile is created in WebSphere through command line using the manageprofiles.sh which
resides in <WebSphere Install directory>/AppServer/bin.

The command to create a profile without admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile
path> -templatePath <template path> -nodeName <node name> -cellName <cell
name> -hostName <host name>"

Example:

Susr/home>./manageprofiles.sh -create -profileName mockaix
-profilePath/websphere/webs64/Appserver/profiles/mockaix
-templatePath/websphere/webs64/Appserver/profileTemplates/default
-nodeName ipa020dorNode(04 - cellName ipa020dorNode04Cell -hostName
ipa020dor

The command to create a profile with admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile
path> -templatePath <template path> -nodeName <node name> -cellName <cell
name> -hostName <host name> -enableAdminSecurity true -adminUserName
<Admin User Name> -adminPassword < Admin User Password> -samplespassword
<sample User Password>"

Example:

Susr/home>./manageprofiles.sh -create -profileName mockaix
-profilePath/websphere/webs64/Appserver/profiles/mockaix
-templatePath/websphere/webs64/Appserver/profileTemplates/default
-nodeName ipa020dorNode(04 -cellName ipa020dorNode04Cell -hostName
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ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword
ofsaai -samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a New
Profile in WebSphere, you can also use "-validatePorts" to validate if the
specified ports are not reserved or in use. Additionally, you can specify new
ports with "-startingPort <base port>" which specifies the starting port
number to generate and assign all ports for the profile. For more information

on using these ports, refer WebSphere manageprofiles command.

Manage Applications in WebSphere

To manage the installed applications in WebSphere, follow these steps:
1. Open the administrator console using the following URL:
http://<ipaddress>:<Administrative Console Port>/ibm/console

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled)

Note: Administrative Console Port value is available in serverindex.xml
file within <WebSphere Profile Directory>/config/cells/<Node
Cell>/nodes/<Node Name> directory.

The Integrated Solutions Console Login window is displayed.

Figure 5-1 Integrated Solutions Console Login

Integrated Solutions Console

Log in to the console.
User ID:

|upgs73
Password:
ssssee

Log in
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2. Log on with the User ID provided with the admin rights.

3. From the LHS menu, expand the Applications > Application Type> WebSphere
Enterprise Applications.

The Enterprise Applications window is displayed.

Figure 5-2 Enterprise Applications

Enterprise Applicationt
Use this page to manage instalied applcatons. A single applcation can be deployed onto multiple servers
B Preforences

Seop | Install | Unenstal || Update |  RolloutUsdate |  Remove File | Expert | EiportDOL |  Eport File |
QOY

Select Namo & Appheation Status Q

You can adminester the following resources:

E‘. AlXGAST =

0 | Cefaukiookiation »

[ | itdeo +

I b0y -

Total 4

This Enterprise Applications window helps you to:
> Install new application
> Uninstall existing applications

> Start or Stop the installed applications

Delete WebSphere Profiles
To delete a WebSphere profile, follow these steps:

1. Select the checkbox adjacent to the required application and click Stop.
2. Stop the WebSphere profile to be deleted.
3. Navigate to WebSphere directory:
<WebSphere Installation Directory>/AppServer/bin/
4. Execute the command:
manageprofiles.sh -delete -profileName <profile name>
5. Delete profile folder.

Example: <WebSphere Installation Directory>/AppServer/profiles/<profile
name>

6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry
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WebSphere HTTPS Configuration
To configure an HTTPS Transport on WebSphere, follow these steps:

1. Create a profile using the Profile Creation Wizard in WebSphere.

Note: Note down the https port specified during this process and use the
same as servlet port or web server port during OFSAALI installation.

2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS _ENABLE" in
OFSAAI InstallConfig.xml for Silent mode OFSAAI installation.

WebSphere Memory Settings
To configure the WebSphere Memory Settings, follow these steps:

1. Navigate to Websphere applications server > Application servers > serverl
> Process definition > Java Virtual Machine.

2. Change the memory setting for Java Heap:
Initial heap size = 512

Maximum heap size =3072

Configuring WebLogic for Application Deployment

You can deploy multiple Infrastructure applications on different domains of a stand-alone
weblogic application server. To create multiple WebLogic "Domains" in a stand-alone server
you can use the Domain Creation wizard. A domain is the set of files that define the runtime
environment. At least one domain must exist to run WebLogic Application Server.

Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with
Java 8, download and install patch 18729264.

To create a Domain in WebLogic 12.x, see the Creating Domain in
WebLogic Server section in the Oracle Financial Services Advanced
Analytical Applications Infrastructure Installation Guide
8.0.7.0.0.

This section covers the following topics:

> Creating Domain in WebLogic Server
> Delete Domain in WebLogic

> WebLogic Memory Settings

Creating Domain in WebLogic Server

To create a new domain using Configuration Wizard in WebLogic, follow these steps:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the
command:

./config.sh

The Welcome window of the Configuration Wizard is displayed.
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Figure 5-3 Welcome

n Fusion Middleware Configuration Wizard HHE

Walcome

oRrRACLE’

® Create a new WeblLogic domain

Create a YyebLogic domaln in your projects directory.

O Extend an existing WebLogic domain

Use this option to add new components 1o an existing domain and modify configuration setings.

[ ea |[ oo | [ereveus | [ nen ]

2. Seclect Create a new WebLogic domain option and click Next.

The Select Domain Source window is displayed.

Figure 5-4 Select Domain Source

Select Domain Source

@ Generate a domain configured automatically to support the following products:

O Base this domain on an existing template

[Eronee |

B2 || uep | | Brevious | [ bt |
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3. Select the Generate a domain configured automatically to support the following

products option and click Next.

The Specify Domain Name and Location window is displayed.

Figure 5-5 Specify Domain Name and Location

) Fusion Middleware Configuration Wizard !in
Specify Domain Name and Location
ORACLE
Enter the name and location for the domain:
Domain name: | MockSol |
Darsain ocation: .Memognmemmmamef_projectsmmam | Browse |

4. Enter the Domain Name and Location. Click Browse to navigate and specify the location.

Click Next.

The Configure Administrator Username and Password window is displayed.

Figure 5-6 Configure Administrator Username and Password

l] Fusion Middleware Configuration Wizard Hlm
Configure Administrater User Name and Password
.
ORACLE
. Disgard Changes
"Lzer rame:
"User password
*Confirm user password [ |
Description: | This wser is the defaut administrator
et |[ tew | | erevious | [ et ]

5. Enter the User name and User password to be assigned to the Administrator. Ensure that

the password is of minimum 8 characters in length.

6. Re-enter the password for confirmation and add a brief Description. Click Next.
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The Configure Server Start Mode and JDK window is displayed.

Figure 5-7 Configure Server Start Mode and JDK

) Fusion Middleware Configuration Wizard !Iﬁ

Configure Server Start Mode and JDK
ORACLE’

Before putting your domain info production, make sure that the production enmvironment is secure. For more information, see the topic "Securing &
Production Environment’ in the YWeblLogc Server documentation,

T use Weblogic JRockit in production, Cracle recommends developing and festing your applications with WebLogic JRockit early in the project cycle,
For information about WebLogic JRockE, see the WebLogic JROCKR documentation.

VWabLogic Domain Startup Mode JOK, Selection
@ Development Mode (@) Awailable JOKs
Utlize koot properties for usermame and hnSDlﬁ.B.Il_ﬂﬂw.BD_lB

password and poll for applications to deploy.
Sun JOK recommended for better startup
perionmance during terative development,

O Production Mode
Require the entry of a usermame and password
andd do not poll 1o appications 1o deplay,
WiebLogic JRockit JOK recommended for better L
rurtime performance and management. Location

| ea bel Previous | [ next |

7. Select the following options:

In the WebLogic Domain Startup Mode section, select the required mode (Development
Mode or Production Mode).

In the JDK Selection section, select Other JDK. Click Browse and navigate to the JDK
location. Click Next.

The Select Optional Configuration window is displayed.
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Figure 5-8 Select Optional Configuration

E) Fusion Middieware Configuration Wizard

Select Optional Configuration

ORACLE’

Administration Server
Modity Setlings
[ Managed Servers, Clusters and Machines
Add or Delets
Modity Settings
] RDBMS Security Store
Modity Settings

Ext tex

8. Select Administration Server. A WebLogic Server domain must have an Administration
Server. You can also select Manages Servers, Clusters and Machines and RDBMS Security
Store if required. Click Next.

The Configure the Administration Server window is displayed.
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Figure 5-9 Configure the Administration Server

[ Fusion Middleware Configuration Wizard !IE

Configure the Administration Server
ORACLE

7 Disgard Changes

"Name: | AdminServer

"Listen sddvess: | Al Local Addresses | -

Listen port: | 7007]
SEL ksten port: |

SSLenabledt [

Bt || bew previcus | | pext

9. Enter Administration Server details such as the Name, Listen address, Listen Port, SSL
listen port, and SSL enabled (for secure login using https) check box. Click Next.

The Configuration Summary window is displayed.

Note: Make a note of the Listen Port or SSL Listen Port value (ex: 7007),
since the same has to be re-entered in the Servlet port field during
Infrastructure installation.
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Figure 5-10 Configure Server Start Mode and JDK

E) Fusion Middleware Configuration Wizard
Configuration Summary
ORACLE
Domain Summary Chck on an @em in the Domain Summary pane on the left to inspect itz atiributes inthe
Summary View: Detaits pane below. You can make liméed adusiments by clicking Previous to return o a
Deployment |'| prior panel, I everything is satistactory, click Next.
"1 MockSal (weblogichwebi 01 3bealiser_projec i
& Server | Dotads
[ ndminserver l*‘-“"me Ve
Name Basic WebLogic Server Domain
Description  Creste a basic WebLogic Server domain without instaling sample application
Author Oraclke Corporation
Location  Aweblogichvebl] 01 3beatwiserver 10 3icommaondemplatesidomainsids jar
[ ] ) [ []
Greste

10. Verify the configuration details of the WebLogic domain and click Create.

The Creating Domain window is displayed with the status indication of the domain
creation process.
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Figure 5-11 Configure Server Start Mode and JDK

Creating Domain

B Fusion Middleware Configuration Wizard

ORACLE

Progress:

| 100%

ORACLE"

Extracting Domain Contends .,

Creating Domain Security Information...
Saving the Domain Information...

Storing Domain Information...

String Substituting Domain Files...
Performing OS Specific Tasks...
Performing Post Domain Creation Tasks ..,
Doman Created Successiullyl

Domain Location: fveblogichwebl 01 3bealuser_projecisidomains MockSal
Admin Server URL: hitpc ipeg8rey: 7007

[erevious ] [_pons

11. Click Done when complete. The domain server is created enabling the deployment of

multiple Infrastructure applications on a single WebLogic.

Note:

?

Note down the HTTPS port specified during this process and use the
same as servlet port or web server port during OFSAAI Installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS
ENABLE" in OFSAAI InstallConfig.xml for silent mode OFSAAI
installation

12. Add a java option entry -DUseSunHttpHandler=true in WLS HOME/bin/
"setDomainEnv.sh" file (Required only if self signed certificate is used).

Delete Domain in WebLogic
To delete a domain in WebLogic, follow these steps:

1. Navigate to the following directory:

<WebLogic Installation directory>/user projects/domains/<domain

name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.

3. Delete the Weblogic domain.
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WebLogic Memory Settings
To configure the WebLogic Memory Settings, follow these steps:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in setDomainEnv.sh
file, which resides in the folder <DOMAIN HOME>/bin and in CommEnv.sh file which
resides in the folder common/bin.

2. Edit this file for customizing memory settings and garbage collector settings depending on
the available hardware configuration.

Example 1:
if [ "${JAVA VENDOR}" = "Sun" ] ; then
WLS MEM ARGS 64BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 64BIT
WLS MEM ARGS 32BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 32BIT
else
WLS MEM ARGS 64BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 64BIT
WLS MEM ARGS 32BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 32BIT
Example 2:
JAVA VM=

MEM ARGS="-Xms256m -Xmx1024m"

Configuring Apache Tomcat Server for Application Deployment
This section is applicable only when the Web Application Server type is Tomcat.

This section includes the following topics:

> Tomcat User Administration

> Configure Tomcat to use JAVA 64 bit Executables
> Configure Servlet Port

> SSL Port Configuration

> Apache Tomcat Memory Settings

> Uninstalling WAR Files in Tomcat

> Configuration for Axis API

Tomcat User Administration

The Tomcat administration and manager application does not provide a default login. You are
required to edit "SCATALINA HOME/conf/tomcat-users.xml" as follows:

This file contains an XML <user> for each individual user, which will display the username
and password used by admin to log on to Tomcat, and the role names to which the admin user
is associated with. For example, <user name="admin" password="admin"
roles="standard,manager" />
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1. Add the manager role to any one of the existing username/password combination as shown
in the preceding example.

2. Use the same username/password to which the manager role has been assigned to access
the Tomcat Application Manager.

3. If the Tomcat server is already running, it requires a re-start after the preceding
configuration is done.

Configure Tomcat to use JAVA 64 bit Executables

To configure Tomcat to use JAVA 64 bit, follow these steps:
1. Navigate to the "SCATALINA HOME/bin" folder.
2. Edit the setclasspath.sh as follows:
3. Replace the following block of text
# Set standard commands for invoking Java.
_RUNJAVA="$JRE_HOME"/bin/java
if [ "S$0s400" != "true" ]; then
_RUNJDB="$JAVA HOME"/bin/jdb
With:
# Set standard commands for invoking Java.
_RUNJAVA="$JAVA_BIN"/java
if [ "S$0s400" != "true" ]; then
_RUNJDB="$JAVA BIN"/jdb

4. If the Tomcat server is already running, it requires a re-start after the preceding
configuration is done.

Note: In case tomcat is installed under different Unix profile, set JAVA
BIN environment variable in .profile to include the Java Runtime
Environment absolute path.

For example:
export JAVA BIN /usr/java6 64/jre/bin

export JAVA BIN = /usr/java6 64/jre/bin//sparcv9 for Solaris
Sparc

Configure Servlet Port

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if
you need to use the default port.

If you need to use a different port number, you must first configure the port in the "server.xml"
in the "conf" directory of Tomcat Installation directory.

To configure the Servlet Port, follow these steps:
1. Navigate to SCATALINA HOME/conf. Open server.xml and locate the tag:

2. "Define a non-SSL HTTP/1.1 Connector on port 8080 "
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3.

4.

Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to
the new port number that was used during the Infrastructure installation process.

Save your changes in "server.xml".

Note: Make a note of the servlet port configured. This information is
required during the installation of OFSAA Application Pack.

SSL Port Configuration

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the
following connect tag under Define a SSL HTTP/1/1 Connector on port 8443 in <Tomcat
installation folder>/conf/server.xml file is uncommented for SSL Configuration. (By
default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"

maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note:

> Make a note of the servlet port configured. This information would be
required during the installation of OFSAA Application Pack.

> To enable https configuration on Infrastructure, assign value 1 to
"HTTPS_ENABLE" in OFSAAI InstallConfig.xml for SILENT mode
OFSAALI installation.

For more information related to SSL Configuration on Tomcat, refer to
http://tomcat.apache.org/.

Apache Tomcat Memory Settings

To configure the Apache Tomcat Memory Settings, follow these steps:

1.
2.

Locate the file catalina.sh which resides in the folder <CATALINA HOME>/bin

Edit this file for customizing the memory settings and garbage collector settings depending
on the available hardware configuration.

Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

For example:

if [ -z "$LOGGING MANAGER" ]; then

JAVA OPTS="$JAVA OPTS -Xms512m -Xmx1024m
-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"
else

JAVA OPTS="$JAVA OPTS -Xms512m -Xmx1024m $LOGGING MANAGER"

fi

Uninstalling WAR Files in Tomcat
To uninstall WAR files in tomcat, refer Uninstalling WAR Files in Tomcat.
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Configuration for Axis API
This step is optional and required only if the web application server used in Apache Tomcat. If
you use any other web application server, skip and proceed to next step.

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_
4 /webapps/axis/WEB-INF/1ib and place it in under <Tomcat Installation
Directory>/1lib and restart the Tomcat Server
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Configuring Resource Reference in Web
Application Servers

This section covers the following topics:
> Configuring Resource Reference in WebSphere Application Server
> Configuring Resource Reference in Weblogic Application Server

> Configuring Resource Reference in Tomcat Application Server

Configuring Resource Reference in WebSphere Application
Server

This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:

> Creating JDBC Provider

> Create Data Source

> J2C Authentication Details

> JDBC Connection Pooling

Creating JDBC Provider

1. Open the WebSphere admin console in the browser window:
http://<ipaddress>:<administrative console port>/ibm/console. (https if
SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. The
JDBC Providers window is displayed.
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Figure 5-12 JDBC Providers
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§-';lod|=G‘.fSlSC‘RE\.‘-!onQINonSS. Server=serverl V|

Sreferences

l l] D‘nllu.
(M NG 4

35:5-;!5 Hame ™ | Scopa ™ Deseription

. W L

! You can administer the following rescurces:

1l rky 3 Provider HodemGNS150REV- Derby embadded non-XA JDBEC
Zoneilcdell, Sarvar=sarvarl Provider

| FICMAETER NodewGXS150REV- Cracle JDBC Drivar
ZonelNodals, Servar=sarvarl

D r b, ivar Node=GNS1S0REV- Oracle JDEC Driver
Zona2lodall, Sarver=sarvarl

O RORFFW Hode=GXS150REV- RORFFW
Zona2Nocals, Sarver=sarvarl

O RORPHG Hode=GX5150REV- RORPHC
ZoneZNodal5 Serverssarverl

O UBGSOFT Node=GX5150REV- UPGSEFT
Zane2Nodels, Serverssaryarl

H YUPGEROR Hode=GXS150REV- UPGSROR
ZoneZliodels, Servarssarvarl

D o Al Hode=GX5150REV- UPGSSAND
Zane2Nodels, Servarssarvarl

| Total &

4. Select the Scope from the drop-down list. Scope specifies the level at which the resource
definition is visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create new
JDBC provider window is displayed.
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Figure 5-13 Create a new JDBC Provider

Creste a new JDBC Provider -

Create a new JOBEC Provider

Step 1: Creabte new
JDBC provider

=, Sat the basic configuration values of a JOBC provider, which sncapsulatas the
Step 2: Enter vendsr JDEC driver implementation claszes that are required to Beoass the da

database class path The wizard fills in the name and the description fields, but vou can type differant
information valuas,

Step 3: Summary Scope

cells 1 GHSLS0REY-
Zene2lodel5Cellinodes: GXS150REV-
Zonae2NodelS isarvarsisarvarl

* Database type
| Cracle ¥

*# Provider type

# implementation type
|Cl:|:1n-t|:tion. pocl data source |

* Nama
[oracle JOBC Criver

Cescrigtion
Oracle JOBC Driver [:l

(] _cancel |

6. Enter the following details:

Table B-1 Fields and their description

Field Description

Database Type Oracle

Provider Type Oracle JDBC Driver

Implementation Type Connection pool data source

Name The required display name for the resource
Description The optional description for the resource

7. Click Next.
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Figure 5-14 Enter database class path information

Create a new JDBC Provider -

Create & new JDBC Provider

Step 1: Create new Enter database class path information |

JDBT provider

Set the environment variables that represent the JOBC driver class files, which

Step 2: Enter WebSphere(R} Application Server uses to define your JDBE provider. This wizard page
Flalahase class path displays the fila names: you supply only the directory locations of the files. Use
information cemplate directory paths vhen you type the JDBC driver file locations. For axample:
Ci\SQLLIE\java on Windovs({R) or fhome/dbZinstl/sqllib/java an Linux(TM].

Step 3: Summary

If & value iz specified for you, you may click Next to accept the value,

Class path:

&
=]

Directory location for "cjdbes.jar” whith is saved as WebSphaere variable
5{ORACLE JDEC_DRIVER_RPATH}
|." eracle/crajdbc/app/orajdbe/ product/11.2.0/ cient_1/idbo/lib

| ﬁrevibus-‘l 'Next || Cancel I

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use
the trailing slash file separators.

The Oracle JDBC driver can be downloaded from the following Oracle Download site:
»  Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers
> Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server.

Note: Refer Appendix O for identifying the correct ojdbc<version>.jar
version to be copied.

9. Click Next. The Summary window is displayed.
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Figure 5-15 Summary

Create & new JDBC Provider -

Create 8 new JOEC Brovider

Step 11 Create new Summary |
JDEC providaer el

Summary of actions:

Step 2! Enter

database dass path I Options [ U..h‘] |
information I T

| tcopa | callsrGXS150REV-Zone2Node05Cellinodes GXS1SOREY-
Step 3: Summary | | Zone2NodelSisarverssarvarl

| 108C provider name | Oracle JDBC Driver

| Deseription Oracla JOEC Drivar

| Class path | S{ORACLE_}DBC DRIVER_PATH}/ ojdbcs. jar

| S{ORACLE_JOBC_DRIVER_PATH} | foracle/crajdbe/app/orajdbe/ product/11.2.0/client_1/jdbe/lib |

Implamantation class nama oracde.jdbc. pocl.OradeConnectionPooiDataSource

| Previous [ .Firtist‘_!ll_, Cano_el]

10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Create Data Source
The following steps are applicable for both config and atomic data source creation.

1. Open this URL in the browser window: http://<ipaddress>:<administrative
console port>/ibm/console. (https if SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > Data sources option.
The Data sources window is displayed.
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Figure B-1 Data Sources

Data sources

Use this page te edit the settings of & datascurce that is asscciated with your selected JOBC provider. The datascurce
cbject supplies your application with connections for accessing the database. Learn more about this task in 2 guided
gekiviky. A guided activity provides a list of task steps and more general information abeut the topic.

B Scope: Call=GXS150REV-ZoneINodeD5Cell. NodenGXS1S50REV-Zone2Node0S, Sarvarsserverl

Scope specifies the level at which the rezource definition iz visitle. For detailed
infermatien on what scope is and how it werks, h in

I_ Node=GXS150REV-Zone2hode0S, Server=serverl (M)

F Preferences

Dalate || Test connectisn l' Manage stats.. I ‘
e |
IScIm| Name 2 INDT name § Su:pl s | Provider & | Description & | Category & |
i Yau ean sdminister the fallaving resaurses: |
O | pafault DefaultDatascurce | Node=GXS1SOREV- Derby JDEC | Datascurce
Catagource ZoneZWodels Servar=serverl | Provider for the
WebSphere
| Default
| Application
E] EICMASTER Jdbo/FICMASTER Node=GXS150REY- FICMASTER | Mew JDEC
| ZoneZNodels Serverssarvarl | Datesource
D RORFFW jdbe/RORFFW NHode=GXS1S0REV- | RORFFW | Hew 1DBC
ZenalNodeld, Servar=sarverl Datasource
O RORPHN jdba/RORPNC Hode=GXS150REV- RORBHC | Hew JDBC
| ZoneZWodelS Servar=serverl | Datasource
O UPGSDFT jdbe/UPGESRFT Node=GXS150REV- | UBGSRFT | Haw JDBC
ZonelZhodeOS Sarver=servarl | | Datasource
0 UPGSROR jdbe/UPGSROR Node=GXS150REV- UPGSROR | Hew JDBC
ZonaZNodelS, Sarvar=sarvarl | | Datasourca
1 il | |

4. Select the Scope from the drop down list. Scope specifies the level at which the resource
definition is visible.

5. Click New. The Create a Data Source window is displayed.
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Figure B-2 Create Data Source

Crante s data source

Step 1: Enter basic
data source
information

Step 2: Select IDBC
providar

Stap 3: Enter
database specific
proparties for the
data source

Enter basic data source information

Sat the basic configuration values of a datasource for asscciation with your JDBEC
provider. A datasource supplies the physical connections between the application
5 and tha database.

Requiremant: Use the Datasources (WebSphara(R)} Application Server V4) conscle
oages if your sapplications are based on the Enterprise JavaBesnz{TM) (EIB] 1.0
specification or the Java(TM) Serviet 2.2 specification.

Seope

cells: GXS15OREV-
Zone2iodedSCallinodes:GXS1 30REY-
Zona2lodelSisarvars isarvarl

Step 4: Satup
sacurity aliases

Step 3@ Summary 4+ Data source name

|-¢-.tu-mT

# JNOI name
ligse/DRYMOCK

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive and ensure that JNDI name is same as
the "Information Domain" name.

7. Click Next. The Select JDBC provider window is displayed.

Figure B-3 Select JDBC provider

Creats & data sourca

Step 11 Enter basic
data source
infarmation

Spacify 8 JDEC provider to support the datasource. If you choose to create a naw
JOBC provider. it will be created at tha same scope as the datasource. If you are
zelecting an existing JOBC provider, only thoze providers at the current scope are
available from the list,

Step 2: Select IDBC
provider

Step 31 Enter
database specific
proparties for the
data source

O Craate naw JDBC provider

'@' Select an axisting JDBC provider

Step 4: Satup
security aliases

| Oracle JDBC Oriver (¥

Step 51 Summary

| Previous |  Next| Cancel |

8. Select the option Select an Existing JDBC Provider and select the required JDBC
provider from the drop-down list. Click Next.
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Figure B-4 Enter database specific properties

Create 3 data source

Step 1t Enter basic Select JDBC provider
data sourca m o e e
infoarmation

Spacify a JDBC providar to support the datasource. If you choosas to craate a naw
JOBC provider. it will be created at the same scope as the datasource. If you are

Step ;" Select JDBC selecting an existing JDBC provider, only those providers at the current scope are
provider

availatla from the list,

Step 31 Enter
database specific
properties for the
data source

{0 Craate new IDBC pravidar

@ Select an axisting JDEC provider
Step 4: Setup

Eaury ailases [Oracle JDEC Drivar ]

Step 51 Summary

":_Im | Next|  Cancel |

9. Specify the database connection URL.
For example: jdbc:oracle:thin: @<DB_SEREVER IP>:<DB_SERVER PORT>:<SID>

10. Select Data Store Helper Class Name from the drop-down list and ensure that the
checkbox Use this data source in container managed persistence (CMP) is selected.

Note: For RAC configuration, provide the RAC url specified during
installation.

Example: jdbc:oracle:thin:@ (DESCRIPTION= (ADDRESS
LIST=(ADDRESS=(PROTOCOL=TCP) (HOST=10.11.12.13) (port=1521)) (ADDRESS=(PRO
TOCOL=TCP) (HOST=10.11.12.14) (PORT=1521)) (LOAD

BALANCE=no) (FAILOVER=yes) ) (CONNECT DATA=(SERVICE NAME=pgadb)))

11. Click Next.

Figure B-5 Enter Database specific properties

Create a dats source =

Creste a data source

Step 1: Enter basic Enter ' d,ltl bm ‘ll'ﬂdfh I t ,fu :-ZHI: n-m sou
data source A : 5C Specl properties he data Irce
Infarmation

Seak these database-specific properties, which are reguired by the database vender

b
Stap 2: Selact JDBEC JOBEC driver to support the connections that are managed through the datasource.

provider

Step 3: Enter Name | Value
database specific

properties for the * URL
dats source

| [10.184.108.91 11521 arl11g]

% Dats store helper clags name
: Oraclellg data store halper (V|

Stap 4: Setup
sacurity aliases

Stap 5: Summary [¥] Use thiz data source in container managed persistance (CMP)

| Previous I .5 Next I | Cancel I
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12. Map the J2C authentication alias, if already created. If not, you can create a new J2C
authentication alias by accessing the link given (Global J2C authentication alias) or you
can continue with the data source creation by clicking Next and then Finish.

Figure B-6 Summary

Create a data source -

Craate a data source

Stap 1t Enter basic mw
data source

information =
Summary of actions:

Step 2: Select JDBC |°Pﬂ0l‘tl \f-.r-u.;
prowider

cells:GX5130REV-ZoneZNodedSCell:nodes GXS1SOREV-

Step 3: Enter Scope ZoneZNodelS:servars:sarverl
database specific I

properties for the Data source name | AtomT

data source JNDI name | jdbe/ORYMOCK

Stap 41 Satup Select an _axilting Oracle JIDBEC Driver

security aliases JDEC provider N

Step 5: Summary :_‘T:‘I:m.ﬂhhgﬂ class oracle.jdbe.pool.CracleConnectionPeolbataSource

URL jdbcioracla:thini@10.184,108.91:152110rcl11gr2

Data store helper class

S com.ibm.websphere.rsadapter.Oraclel OgDataStoreHelpar

Usze thiz datas zourze in
centainer managed true
persistence (CMP)

Component-managed

authentication alias (none)

Mapping-configuration

alias (mane)

Centainer-managed
authentication alias

I {nens)
1

:___l-’re\.rinus | I_Ilfinilsh |.::_Cance]m|.

You can also create and map J2C authentication alias after creating the data source.

13. You must create another Data source by following the preceding procedure with
jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of Infrastructure.

J2C Authentication Details

The following steps are applicable for creating both config and atomic J2C Authentication.
To create J2C Authentication details:

1. Select the newly created Data Source and click JAAS - J2C authentication data link
under Related Items.
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Figure B-7 JAAS- J2C authentication data

Data sources > Default Datasource > JAAS - 12C authentication data

Specifies a list of user identities and passwords for Java(TM) 2 connector security to use.

E] Prafix new allas names with the nede name of the call '.-'lﬂ" compatibility with earier releases)

Apply
B Praferances

[naw|| Dalata

in
L=l o
| Salact| Alias = |userip o | Deseription 2
| You can administer the following rescurces:
[ | gxsiseaey- | upgsconf FICMASTER,
| ne2iodelS/FICMAST |
[] |SXSi30REV-ZonedNoded S/ RORFFV | rorffu
D GHSIS0REV-ZongSNodeQ BIROR BT | rarane
D GMSiS0REV-ZongZNodel S/ USGEEFT i upgspft upgspft
El GXS1S0REY- | upgaprod upgsprod
ZensalNedals/UPGSEROD
O GNS1IOREV- | upgsror upgsror
Zone2NodelS/USGSROR |
D QXS 1S0REY- upgssand upgssand
nggh LB &N
E‘_‘| GHS150REYV-Zone3Hoded SIVASTEST | upgsconf upgsconf
Tokal &

2. Click New under the Preferences section.

Figure 5-16 JAAS- J2C authentication data- New

Data sources > Default Datasource > JAAS - 13C authentication data > New
Specifies a list of user identities and passweords for Java(TM) 2 connecter security to use.

General Properties

* alisx
[atm

* Usar ID
||:ngi73

* Passwerd
|I.".. L]

Dessrigtion
|;f¢n-|'=: IAstance

Iipnlyl Elfl Ronl[ Cancel I

3. Enter the Alias, User ID, Password, and Description. Ensure the following:

> User ID is the Oracle user ID created for the respective CONFIG and ATOMIC
Schema for the "Information Domain".
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»  Specify the CONFIG database user ID and password information for the
jdbc/FICMASTER data source, and specify the ATOMIC database user ID and
password information for the ATOMIC schema data source that you created earlier.

4. Click Apply and save the details.

JDBC Connection Pooling

To define the JDBC connection pooling ensure that you have created JDBC Provider and Data
source to access the data from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources option.
The Data sources window is displayed.

2. Click the newly created Data Source SDATA SOURCES and navigate to the path Data
sources>$DATA SOURCES>Connection pools.

Figure B-8 Connection pools

Data sources > GAFUSION DATA SOURCE > Connection pools

Use this page to set properties that impact the timing of connedion management tasks, which can affect
the parforrnance of your application. Considar tha default values carefully: your application requirements
right warrant changing these values,

Configuration

Lensral Properties

Additional Properties

Scope &
calls:ipaZEdarModeDlCallinadesiipaZtdarNadallisarvars i sarverl M
connation pool
* Connection timeout properbies
seconds Sonnection pool
Tuul=ld i

* Maximum connacions
|1Dl2l connactions

* Minirmurm connactions
[:uj connactions

woeaptiod
|120 seconds

* Unused timeout

|1800 seconds
+ Aged timeout
(=] saconds
Purga policy .
EntiraPool w |

Apply | [0K] | Raset| | Cancel |

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100
connections, and Minimum connections to 10 connections as shown in the preceding
figure. You can also define Reap Time, Unused Timeout, and Aged Timeout as required.
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Configuring Resource Reference in Weblogic Application
Server

This section is applicable only when the Web Application Server type is WebLogic.This section
includes the following topics:

> Create Data Source

> Create GridLink Data Source

> Configure Multi Data Sources

> Advanced Settings for Data Source

> JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:

> "For a Non RAC Database instance, Generic Data Source has to be created. See Create
Data Source.

> "For a RAC Database instance, Gridlink Data Source has to be created. See Create
GridLink Data Source.

> "When Load Balancing/Fail over is required, Multi Data Source has to be created. See
Configure Multi Data Sources.

Create Data Source

The following steps are applicable for both config and atomic data source creation.

1. Open the following URL in the browser window:
http://<ipaddress>:<administrative console port>/console. (httpsif SSL is
enabled). The Welcome window is displayed.

2. Login with the Administrator Username and Password.
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Figure B-9 Welcome

oRrRACLE
WebLogic Server® 11g

Administration Console

Welcome

Log i o ok with S Weblogic Server doman
Usernarie:

Password:

3. From the LHS menu (Domain Structure), click Services > Data Sources. The Summary of
JDBC Data Sources window is displayed.

Figure B-10 Summary of JDBC Data Sources

DIRACLE Weblogic Server® fusmeiration Canscls

i [ . [y a Welkcomme, manager | Corredects: Macktel
Ve ch andrastant B e T L ML ET
Gonfi arion adtng i snabied. Futare Sunenery of J08E Dots Semces
sl ot sy bt SR 38 voul
b or it hevs i thes
& JO0C dets source'is an ot bound b e DL tee that providen datsbunn connmctty thoogh s pool of J00C conmactong. gl stons can ook op s Sasta sourcs on the 01 tres and thee
Deprviion Struciuse Ecrrow 8 dat shats connechoe frie a dets sarce.
Modkgal =
B Trm page memaroe the 1060 data source ot that Burve been creabed in tha doman,
eprymenis.

E-tarvican o Dnntomize this bable

Sovgitoiof] Preven | et

Showarg Lo 1 of 1 Pravoas | bet:

4. Click New and select Generic Data Source option. The Create a New JDBC Data Source
window is displayed.
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You can also select GridLink Data Source or Multi Data Source while creating a Data
Source. For more information, see Create Data Sourceor Configure Multi Data Sources.

Figure 5-17 Create a New JDBC Data Source

Creale a New J08L Data Source
et Conced

JDEC Dats Source Properties

The follgveng proper ties will be used to idenbfy your new JOBC data source.

What wiold you ke bo name your new J08C data soirce?
5 " Mame: ATOMSTSOL

What IO{ name would you ke to assign to your new J0BC Data Source?

A5 INDT Namme:

4dbc/ATCMETSOL

What database type woukd you e to select?
Database Type: Oracle -

heet Canced

5. Enter JDBC data source Name, JNDI Name, and sclect the Database Type from the
drop-down list. Click Next.

Ensure the following:
> The JNDI Name field should be in the format "jdbc/informationdomain”

> Same steps needs to be followed to create a mandatory data source pointing to the
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name.

> JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.

> Required "Database Type" and "Database Driver" should be selected.

Figure B-11 JDBC Data Source Properties

Create a New J0BC Muolti Data Sowrce
Back  hext | Camce

Select Data Source Type

Flease selact typs (WA or MorA) of data source you would ke £ add to your neww JO5C MUt Data Source

) A Driver
(%) Nom-XA Driver

Sack b Gancal

6. Sclect the Database Driver from the drop-down list. You need to select the Database
Driver depending on database setup, that is, with or without RAC. Click Next.
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Figure B-12 Transaction Options

Create & New JDBC Data Source
Back || hext | Conced

Transaction Options
Tou have sslacted ron-3A J0BC driver to create dabshase ponmachon in your ney dats scunce,
Does ths data source suppdr i global ransactens? I yes, please choose the ransaction protocol for this data source.

[#] Supports Global Transactions
Selact thes opson o you want to enabls -4 J0BC connectons from She dats source bo parbonats in fobal transactions using the Lagang (ast Resounde (LLR) ranshition optmizabon,
Reacommended in place of Emulate Two-Phsse Commit.

) Logging Last Resource

Eelect this opbon f you want to enable nion-XA JOBC connections from fe data source o emulate parbcioation in gliobal ransactons usng JTA, Sefeck the cobion only if your apolcation can
DT ale MEurE el CONGRONS-

) Emulate Two-Phase Commit

Salact this cption f you want in enable non-Xa JOBC connections from the data sourcs to particosts n global transactiond using the one-phase commit ransacton proosssng, With this cotion, no
ofer resources Can partiopate in the giobal transaction.

) One-Phase Commit

Back | | Mext | | cancea

7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.

8. Click Next. The Connection Properties window is displayed.

Figure B-13 Connection Properties

Create a liew JDBC Data Source
Bock | Mext | i Cance
Connection Properties
Define Conmection Properdes.
Whats the name of the databsse you would B t cornect o7

Database Mame: faghu

What s the name or TP sddress of the datshads sarer?

Host Hame: 10 184, 74 80

What S e Dot on the CMB0RGE SETVer LS 1D Cornect 1o e databage?

Port: B2

What datahase sctount LSer nAmE 80 you wBAL i Lie to reate databace cornections?

Database User Names gaatom

What s the database account passvord 1o use to creabe datshase conmections?

Fassword: R —
Confirm Password: sennns
Back | | Mext | cancsi

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User

Name, and Password.
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10. Click Next. The Test Database Connection window is displayed.

Figure B-14 Test Database Connection

Create a New JOBC Data Source

Tes! Configuration | | Back | | lext | | Finish | | cancel

Test Database Connection

Test the datsbace svadablty and the connecton propertes you provded.

What i the Bl package name of JDBC drever dass used to creste datsbase cornechons in the cornection pool?

Driver Class Name: oracle jdbe OracleDimer
Wwhat & the URL of the database to-connect in? The format of the LRL vanes by JOBC driver.

URL: jdbe oracie thin @10 154.]
hat databass Account user name do you want Io uss b crepse datshass cormechons?

Database User Name: ssatom

Whist s the datahass acoount passwvand i use bo reate database connectiora?

Password: LT L L
Confirm Password: BEANNENNEERR RN RN

What are the properbes to pass to the JDEC drrver when craatng database connectons?

Properties:
uaRI=33aToR |

Thie sat of driver properses whoss values s cirived 8% runtee from the naemed §yshes property,

System Properties:

WWhat table mame of SOL statement woukd you ke 1o use to test database connectons?

Test Table Hame:

9L SILECT 1 FROM DUAL

Tesi Configuration | | Back | | Mes iﬁuh | Caneat
. ! | g

11. Verify the details and click Test Configuration and test the configuration settings.
A confirmation message is displayed stating "Connection test succeeded.”

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.
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Note:

> "User ID" is the Oracle user ID that is created for the respective
"Information Domain".

> "User ID" to be specified for data source with "FICMASTER" as "JNDI"
name should be the Oracle user ID created for the "configuration
schema".

13. Select the new Data Source and click the Targets tab.

Figure B-15 Select Targets

Create a New JDBC Data Source
Sack Finish | | Cance
Select Targets

Wil CAN SAICT o o mone targats Bo ceplay your nev JOBC clats sourcs, If you don't salect & targat, the dats scurce will be created but ot deploped. Yoo il reed 1 deploy the data sturee
& B laber bme.

Servers

[ AdminServer

Back Fmisn Cancel

14. Select the AdminServer option and click Finish.

Create GridLink Data Source

If you have selected the option, New > GridLink Data Source while creating the "Data
Source", you can directly specify the JDBC URL as indicated.
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Figure 5-18 Create a New JDBC GridLinkData Source

Create a New JOBC Gridiink Data Source
Back Hemct Cancei

Connection Properties

Dt Cornettion Properted,

Ervber Complets J08C URL for Gridunk database

Comphete 1080 URL:

vt databese acoount user name 00 ol want fo use t9 Treate dalabase ConneCTong !
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1. Enter Data Source Name, and JNDI Name.

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA
Driver checkbox is not selected. Click Next.

Figure 5-19 JDBC GridLinkData Source- Connection Properties
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2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The
created "Data Source" is displayed in the list of Data Sources.

Configure Multi Data Sources

A JDBC multi data source is an abstraction around a group of data sources that provides load
balancing and failover between data sources. As with data sources, multi data sources are also
bound to the JNDI tree. Applications can look up a multi data source on the JNDI tree and then
reserve a database connection from a data source. The multi data source determines from which
data source to provide the connection.

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle
Database to run across a set of clustered servers, then group of data sources can be created for
instances running on a set of clustered servers and a JDBC multi data source can be created so
that applications can look up a multi data source on the JNDI tree to reserve database
connection. If a clustered server fails, Oracle continues running on the remaining servers.

1. Open WebLogic Admin Console in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSL is
enabled). The Login window is displayed.

2. Login with the "User ID" that has admin rights.

3. Inthe LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources. The
Summary of JDBC Multi Data Sources window is displayed.

Figure 5-20 Summary of JDBC Multi Data Sources
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4. Click New. The New JDBC Multi Data Source window is displayed.

Note: Ensure that the Data Sources which needs to be added to new JDBC
Multi Data Source has been created.
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Figure 5-21 Configure the Multi Data Source
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5. Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the
drop-down list. Click Next.

Note:
> The JNDI Name has to be specified in the format jdbc/infodomname.

2 JNDI Name of the Data Sources that will be added to new JDBC Multi
data source should be different from the JNDI name specified during
Multi Data Source.

> Same steps needs to be followed to create a mandatory data source
pointing to the "configuration schema" of infrastructure with
jdbc/FICMASTER as JNDI name for Data Source.

> JNDI Name provided in multi data source should be the same name that
will be mentioned in the web . xml file of OFSAAI Application.

> You can select the Algorithm Type as Load-Balancing.

Figure 5-22 Select Targets

Create & New JDBC Multi Data Source

Eack | W Cancal
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6. Select the AdminServer check box and click Next.

Figure 5-23 Select Data Source Type

Create a New JDBC Multi Data Source
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7.  Select the type of data source which will be added to new JDBC Multi Data Source. Click
Next.

Figure 5-24 Add Data Sources
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8. Map the required Data Source from the Available Data Sources. Click Finish.
The New JDBC Multi Data Source is created with added data sources.

Advanced Settings for Data Source
1. Click the new Data Source from the Summary of JDBC Data Sources window. The
Settings for <Data Source Name> window is displayed.

2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the window, and check the Test Connection
of Reserve checkbox (Enables Weblogic Server to test a connection before giving it to a
client).

To verify if the data source is valid, select "Data Source name". For example,
FICMASTER.
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Figure 5-25 Settings for <Data Source Name>
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4. Select the server and click Test Data Source.
A message is displayed indicating that the test was successful.

5.  Once the "Data Source" is created successfully, the following messages are displayed:
> All changes have been activated. No restart is necessary.
> Settings updated successfully.

If not, follow the preceding steps to recreate the data source.

JDBC Connection Pooling

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data
source to access the data from the database.

1. Click the newly created Data Source $DATA_SOURCES$ and navigate to the path Home
>Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data
Source-<INFODDOM NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity
Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.

3. Click Save.

Configuring Resource Reference in Tomcat Application
Server
This section is applicable only when the Web Application Server type is Tomcat.
This section covers the following topics:
> Create Data Source
> JDBC Connection Pooling
> Class Loader Configuration for Apache Tomcat

Copy the Oracle JDBC driver file, ojdbc<version>.jar from <Oracle
Home>/jdbc/11ib and place it in <Tomcat Home>/1lib.
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Note: Refer Appendix O for identifying the correct ojdbc<version>.jar
version to be copied.

Create Data Source

To create "data source" for Infrastructure application, navigate to <Tomcat Home>/conf and
edit the following block of text by replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the prefix of
setupinfo depending on the value set for PREFIX SCHEMA NAME in
<<APP Pack>> SCHEMA IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX SCHEMA NAME is DEV and the
schema name was mentioned as of saaconf, then the actual schema created
in the database would be DEV_ofsaaconf.

<Context path ="/<context name>" docBase="<Tomcat Installation
Directory>/webapps/<context name>" debug="0" reloadable="true"
crossContext="true">

<Resource auth="Container"
name="7dbc/FICMASTER"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the configuration schema>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"/>
<Resource auth="Container"
name="jdbc/< INFORMATION DOMAIN NAME >"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the atomic schema>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"/>

</Context>
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Note:

> The <Resource> tag must be repeated for each Information Domain
created.

> After the preceding configuration, the "WAR" file has to be created and
deployed in Tomcat.

JDBC Connection Pooling

To define the JDBC connection pooling, do the following:

1. Copy SORACLE HOME/jdbc/lib/ojdbc<version>.jar to the path $STOMCAT
DIRECTORY/1ib/.

Note: Refer Appendix O for identifying the correct ojdbc<version> jar
version to be copied.

2. Edit the server.xml present under the path STOMCAT DIRECTORY/conf/ with the
following changes, which is required for connection pooling.

<Context path="/ SCONTEXTNAMES" docBase=" $APP_DEPLOYED_PATH$ " debug="0"
reloadable="true" crossContext="true">

<Resource auth="Container"
name="jdbc/ $INFODOM NAMES"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username=" $ATOMICSCHEMA_USERNAME$"
password="$ATOMICSCHEMA_PASSWORD$"
url="$JDBC_ CONNECTION URL"
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"
removeAbandoned="true" removeAbandonedTimeout="60"
logAbandoned="true"/>

</Context>

Note the following:
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Note:

»

SAPP DEPLOYED PATHS should be replaced by OFSAALI application
deployed path.

SINFODOM NAMES should be replaced by Infodom Name.

$ATOMICSCHEMA USERNAMES should be replaced by Atomic schema
database user name.

SATOMICSCHEMA PASSWORDS should be replaced by Atomic schema
database password.

$JDBC_CONNECTION URL should be replaced by JDBC connection string
jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example,
jdbc:oracle:thin 10.80.50.53:1521:soluint

The User-1Ds for configuration/ atomic schemas have the prefix of setupinfo
depending on the value set for PREFIX SCHEMA NAME in <<APP Pack>>
SCHEMA_IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX SCHEMA NAME is DEV and the
schema name was mentioned as ofsaaconf, then the actual schema created in
the database would be DEV_ofsaaconf.

Class Loader Configuration for Apache Tomcat
Edit the server.xml available in $STOMCAT HOME/conf/ folder.

1.
2.

Add tag <Loader delegate="true" /> within the <Context> tag, above the
<Resource> tag. This is applicable only when the web application server is Apache Tomcat

8.

Note: This configuration is required if Apache Tomcat version is 8.
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Creating and Deploying EAR/ WAR File

This section covers the following topics:
> Creating EAR/WAR File
> Deploying EAR/WAR File

Creating EAR/WAR File
To create EAR/WAR File, follow these steps:
1. Navigate to the SFIC_WEB_HOME directory on the OFSAA Installed server.
2. Execute ./ant.sh to trigger the creation of EAR/ WAR file.

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken"
message is displayed and you will be returned to the prompt.

Figure C-1 Creating EAR/ WAR File

4. The EAR/ WAR file - <contextname>.ear/ .war - is created.
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Note: The <contextname> is the name given during installation. This
process overwrites any existing version of EAR file that exists in the path.

In case of OFSAA configured on Tomcat installation,
<contextname>.war is created.

ANT warning for tools. jar can be ignored while executing . /ant . sh

Deploying EAR/WAR File
This section covers the following topics:
> Deploying EAR/WAR Files on WebSphere
> Deploying EAR/WAR files for WebLogic
> Deploying Tomcat WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment of
Applications Pack Web Archive. This is applicable to all Web Servers
(WebSphere, WebLogic, and Tomcat). For more information, refer Clearing
Application Cache section.

Deploying EAR/WAR Files on WebSphere
To deploy Infrastructure application in WebSphere:

1. Start WebSphere Profile by navigating to the path "/<Websphere Installation
Directory>/IBM/WebSphere/AppServer/profiles/<Profile Name>/bin/" and
execute the command:

./startServer.sh serverl

2. Open the following URL in the browser: http://<ipaddress>:<Administrative
Console Port>/ibm/console. (https if SSL is enabled). The login window is displayed.
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Figure C-2 Login Window
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3. Enter the user credentials which has administrator rights and click Log In.

4. From the LHS menu, select Applications and click New Application. The New
Application window is displayed.

Figure C-3 New Application

MNew Applicatian

New Application

This page provides links to create new applications of different types,
Install a New Application

F

Mew Enterprise Applicatien

% Mew Business Level Application

L —

-I N

5.
is displayed.

Click New Enterprise Application. The Preparing for the application installation window
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Figure C-4 Preparing for the application installation

Preparing for the application installation

Specify the EAR, WAR, JAR, or SAR medule to upload and install,

Path to the new application

) Local file system

@ Remote file system

Full path

M Cancel

6. Select Remote File System and click Browse. Select the EAR file generated for OFSAAI
to upload and install. Click Next.

Figure C-5 Installation Options

Preparing for the application installation

How do you want to install the application?
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) Detailed - Show all installation options and parameters,

& Choose to generate default bindings and mappings
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7. Select the Fast Path option and click Next. The Install New Application window is
displayed.
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Figure C-6 Install New Application
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8. Enter the required information and click Next. The Map Modules to Servers window is
displayed.
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Figure C-7 Map Modules to Servers

Install New Application

Specify options for installing enterprise applications and modules,

Step 1 Select
installation options

Map modules to servers

Specify targets such as application servers or clusters of application servers where you want to install the modules that are
contained in your application, Modules can be installed on the same application server or dispersed among several application
servers. Also, specify the Web servers as targets that serve as routers for requests to this application. The plug-in
configuratien file (plugin-cfg.xml) for each Web server is generated, based on the applications that are routed through,

Apply

= Step 2: Map modules
to servers

Step 2 Summary

Clusters and servers:
|WEhEphErE:ceI|=ufss231.1.?GlNudEU2CE||.-nude=qus23Ll?OlNudeG2.sewer=sewErl

Select| Module URI Server

OFSAAT WehSphera:cell=ofs523117 01Node02Cell,node=0fs523117 01 Node02, server=serverl
AAIB0.war,WEB- B
Wweh
5 INFfweb.xml
Application

Previous || Cancel |

9. Select the Web Application and click Next. The Map Resource References to Resources
window is displayed.

Figure C-8 Map Resource References to Resources
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10. Map each resource defined in the application to a resource JNDI name defined earlier.

11. Click Modify Resource Authentication Method and specify the authentication method

created earlier.
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You can specify "config" for FICMASTER resource or "atomic" for atomic resource as the
authentication method.

12. Select the OFSAAI Web Application check box and click Next. The Map Virtual hosts
for Web Modules window is displayed.

Figure C-9 Map Virtual host for Web Modules
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13. Select the Web Application check box and click Next. The Summary window is
displayed.
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Figure C-10 Summary
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14. Click Finish and deploy the Infrastructure Application on WebSphere.

On successful installation, a message is displayed.

15. Click Save and save the master file configuration. The details are displayed in the Master
File Configuration window.

Start the Application
To start the application, follow these steps:

1. Expand Applications > Application Type > WebSphere enterprise applications. The
Enterprise Applications window is displayed.
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Figure C-11 Enterprise Application
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2. Select the installed application and click Start.

Note:

> <profile name> is the profile name given while creating the WebSphere
profile.

> <cell name > is the cell name given during profile creation.

? <contextname> is the context name given during installation.

Explode EAR File
To explode EAR, follow these steps:

1. Create the "applications" folder under domain name. For example, "/Bea/user
projects/domains/ <Domain name>/applications".

2. Create <context name>.ear folder under "applications" folder.

3. Copy the <$FIC_WEB_HOME/<context name>.ear file to <WEBLOGIC INSTALL
DIR>/Bea/user projects/domains/<DOMAIN NAME>/applications/<context
name>.ear.

4. Explode the <context name>.ear file by executing the command:
jar -xvf <context name>.ear

5. Delete the <context>.ear and < context >.war files (recently created) <WEBLOGIC
INSTALL DIR>/Bea/user projects/domains/<DOMAIN
NAME>/applications/<context>.ear./<contexts>.war

6. Create a directory <context name>.war under <WEBLOGIC INSTALL DIR>/Bea/user
projects/domains/<DOMAIN NAME>/applications/<context name>.ear.

7. Copy <SFIC WEB HOME/<context name>.war file to <KNEBLOGIC INSTALL
DIR>/Bea/user projects/domains/<DOMAIN NAME>/applications/<context
name>.ear/<context name>.war.

8. Explode the <context name>.war file by executing the following command to get the
directory structure:
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jar -xvf <context name>.war

Deploying EAR/WAR files for WebLogic

Following are the steps for deploying Infrastructure application that would be created during
installation:

1. Navigate to the path <WebLogic Installation directory>/user
projects/domains/<domain name>/bin in the machine in which WebLogic is
installed.

2. Start WebLogic by executing the command:
JstartWebLogic.sh -d64 file

3. Open the URL in the browser window: http://<ipaddress>:<admin server
port>/console (https if SSL is enabled). The Sign in window of the WebLogic Server
Administration Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing
"./startofsaai.sh" as mentioned in Starting Infrastructure Services section.

4. Log on to the WebLogic Server by entering the user credentials having privileges to deploy
the EAR file.

5. From the Domain Structure LHS menu, click Deployments. The Summary of
Deployments window is displayed.

Figure C-12 Summary of Deployments
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6. Click Install. The Install Application Assistant window is displayed.

7. Select the Exploded EAR directory after browsing to the directory where it is saved and
click Next.
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Install Application

To install Application, follow these steps:

1. Open the Install Application Assistant.

Figure C-13 Install Application Assistant
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Current Location: 10,184, 134. 147 [ oradata | 5 [ Orace [ Middieware [ user_projects [ domans [ upg 7273 [ appications

O L upg7273.ear (open drectoey)

Nt | | | Cancel

2. Click Next.

Figure C-14 Install Application Assistant

Install Application Assistant

Back. | | Next! | | cancel

Choose targeting style
Targets are the servers, dusters, and virtual hasts on which this deployment will run. There are several ways you can target an appication.

@ 1nstall this deployment as an application
The spphcatan &nd its components will be targeted to the same lacations, Ths i the most common wsage.
) Install this deployment as a library
Apphcation libranes are deployments that are availabls for other deployments to share, Libraries shauld be available on 8l of the targets running ther referenong applications

Back | | Next | | Cances
i

3. From the Choose targeting style section, select the Install this deployment as an
application option and click Next.

The Optional Settings window is displayed.
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Figure C-15 Optional Settings

Install Application Assistant
Back | | Kext | | Finish ll.‘.anoe:

Optional Settings
fou can modfy these settings or accept the defadlts
General

What do you want to name this deployment?

Hame: upaT273

Security

Vihat sacunty moded g you want 1 use with ths apphoation?

(%) DD Only: Use only roles and policies that are defined in the deployment descriptors.

() Custom Roles: Use roles that are defined in the Administration Console; use policies that are defined in the deployment
descriptor.

() custom Roles and Policies: Use only roles and policies that are defined in the Administration Console.

() Advanced: Use a custom model that you have configured on the realm’s configuration page.

Source accessibility

ik shiudd the solrce fles be made sccessiie?
(&) Use the defaults defined by the deployment’s targets

Recommended seleiton.
) Copy this application ento every target for me

During dapinyment, the fles will be copad autamancally to the managed servers ta which the apphoaton i targated.
O 1will make the deployment accessible from the following location

Location: foradata2iwl 1035/ 0racle Middlewara/user_projects/domail

Frovide the location from where all targats will access this applicabon’s fles. This is often a shared directory. You must ensure the application files most n thes location and that each target can
reach the location,

Back | | Wesd | | Finish Cancel

4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles and
policies that are defined in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location option
under the Source accessibility section.

7. Click Next to continue.

The Deployment Summary window is displayed.
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Figure C-16 Deployment Summary

Install Application Assistant
Back X Finish | || Cancel

Review your cholces and click Finish
Chick Finish to complete the deployment, This may take a few moments to complete,
Additional configuration
In order to work successfuly, this agpiication may require additional configuration. Do you want to review this appbcation's configuration after completing this assistant?

@) Yes, take me to the deployment's configuration screen.

) MNo, I will review the configuration later.

~ Summary
Deployment: foradata2vd 1035/Oracke Mddieware fuser_projects/domans fupg 727 3/applications fupg 7273.ear
Hame: upgr2TII
Staging mode: Use the defaults defined by the chosen targets
Security Model: D0Only: Use only roles and polices that are defined in the deployment descriptors,
Target Summary
Components < Targets
upg7273.ear AdminServer

Back ¥ |Fm|u1 || Cancel

8. Select the Yes, take me to the deployment's configuration screen option and click
Finish.

The Settings for <Deployment Name> window is displayed.
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Figure C-17 Settings for <Deployment Name>

Settings for upg7273

Overview | DegioymentPian | Configuraton | Seourity | Targets || Control | Testng | Monitaring | Notes

Save

Usa this page to view the general configuration of an Enterprise apphcation, such 2s its name, the phiysical path to the applbcation files, the assocated deployment plan, and so on, The table at
the end of the page ksts the madules (such as Web applications and EJBs) that are contaned in the Entesprise apolication, Chik or the name of the module toview and update its configuration.

Hame: upg72T3 The name of this Enterprice Application.  More Info...
Path: J oradata2f vd 1035/ Orade/ Mddlewaref user_projects) domainsf upg 7273/ The path to the source of the deployable unit on the Administratian
appications| upg 7273, ear Server. More Info...
Deployment Plan: {no plan specified) The path to the deployment plan dotument on Administration Server.  More
Info...
Staging Mode: {not specified) The mode that speofies whether a deployment's fles are copled from a

sgurce on the Administrabon Server to the Managed Server's staging area
durmg application preparation,  More Info...

¥ S&CUNty Mode! that S LSed 10 SE0Ure & JEpdYED MGdIE. e Info...

Secu Modek fra ] The odel d wodul More Info,

5] Deployment Order: 100 A iteger value that indicates when ths unit is deployed, relatie to other
deplgyable ursts on 2 sarver, during startup.  More Info...

ag Deployment Principal A siring value that indicates what princpal should be used whan deploying

Mame: the file or archive during startup and shutdown. This principal will be used to

set the current subject when caling out inte applcation code for interfaces
such as Applicationlifecydelistensar. 1f no principal name & specified, then
the anonymous principal wil be used.  More Info...

Save
Modules and Components
Showing 10 1of 1 Previous | Mext
Hame «= Type
Enterprise
Elupgrars Aeghcation
EEs
(7| StatelassCachedaanbean R
= Modules
fa) g 7273 Wed
@)pa St
™ baancache jar ]
- Mode
= Web Services
Hone to display

Showing 110 1of 1 Previous | Next

9. Review the general configuration details of the deployment. You can also update the
configuration of the deployment in this window. In the Overview tab, you can view the
complete deployment configuration.

10. Click Save to update the changes, if any.
11. From the LHS menu, click Deployments.

The Summary of Deployments window is displayed.
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Figure C-18 Summary of Deployments

Summary of Deployments

Control | Maonitading

This page displays 8 kst of lava EE applications and stand-alons appication modules that have been mstaled to ths doman, Instaled apphications and modules can be started, stopped, updated
{redeployed), or defeted from the domain by first selecting the appiication name and using the controls on this page.

To install & new application or module for deplayment to targets n this domain, dick the Instal button:

W Customize this table
Deployments.

install | | Update | Deiste | | Stariw | | Stop ¥ Showing 1to 10f 1 Previous | Mext

Senacing all requests

A £ Servang only admrstration reguests Skare Heality

Type Deployment Order

# [Pupg?273 Active o O Enterprise Applcation 100

insiak | | Update | | Deiste | | Stat> | Stop

Showing 1to 1of 1 Previous | Next

12. Select the newly deployed Infrastructure application and click Start > Servicing all
requests. Ensure that the Infrastructure server is up and running.

Figure C-19 Summary of Deployments

Messages
o Start requests have been sent to the selacted Depioyments
Summiary of Deployments

Control  Manitoring

Thes page displays 2 kst of Java EE appications and stand-glone appication modules that have been nstaled to ths domain. Instalied appbcations and modules can be started, stopped, updated
{redeployed), or deleted from the domain by first selecting the application name and using the controls on this page,

To install & new application or module for deplayment to tangets in this domain, dick the Instal button.

¥ Customize this table
Deployments.
instad v ¥ . 1k s = |
| 1 Showing 110 10F 1 Previous | Mext
[ | Hame & State | Health | Type Deployment Order
1 | ® Rupg7zr3 Active o o Enterprisa Apphoaton 100

Showing 1to 1of 1 Previous | Mext

13. The State of the deployed application will be displayed as Active if started successfully.

Deploying Tomcat WAR Files on Tomcat

Before deploying the WAR files, ensure that the previously deployed applications of
Infrastructure are uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for
the procedure to uninstall the previously deployed Infrastructure war files.

On the machine that hosts Tomcat, follow these steps to deploy Infrastructure application:

1. Copy the <context-name>.war from $FIC_WEB HOME/<context-name.war> to
<Tomcat Installation Directory>/webapps/ directory.
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Figure C-20 Tomcat Home window

Home Documentation Configuration

Apache Tomcat/7.0.57

Examples

Wiki  Mailing Lists

Recommended Reading:
Security Considerations HOW-TO

Manager Application HOW-TO

Developer Quick Start

restricted. Users are defined in
SCATALINA HOME/conf/tomcat-users.xml

In Tomcat 7.0 access to the manager
application is split between different users

Release Notes
Changelog
Migration Guide
Security Notices

Other Downloads Other Documentation

Tomcal Connectors

Tomcat Natre

Deplover

Deployver

Clustering/Session Replication HOW-TO

Tomcal Setup Realms & Ak Examples
First Web Application JDBC DataSources

Managing Tomcat Documentation

For security, access to the manager webapp is Tomeat 7.0 Documentation

Tomeat 7.0 Conﬂguration
Tomecat Wiki

Find additional important configuration
information in

SCATALINA_HOME/RUNNING.tXT

Developers may be interested in
Tomcat 7.0 Bug Database
Tomest 7.0 JavaDocs
Tomeat 7.0 SVN Begostory

Get Invalved

Owerview
SVN Reposkories
Maiing Lets

Wik

Find Help

T Apache Software Foundation

http://www.apache.org/

Server Status
Manager App

Host Manager

Serviet Specifications
Tomcai Versions

Getting Help
FAQ and Mailing Lists

The following mailing lists are available

important announcements, releases, security
wulmerability notifications. (Low volume).

lomeat-Users

User support and descussion

fagibs-yser

User support and discussion for Apsche Tagks

v
Development maling kSt, including commil MESSages

Miscellaneous Apache Software Foundation
Contact Viho Ve Are

Lecal Heritage

Sponsorship Apache Home

Thanks Resources

2. Click Manager App. The Connect to dialog box is displayed.

3. Enter the User Id and Password that has admin rights and click OK. (For user creation in
tomcat, see Tomcat User Administration. The Tomcat Web Application Manager window
is displayed with the list of all the applications deployed.
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Figure C-21 Tomcat Web Application Manager

| stan (Stop] [Reload | [ Undepiey |
[ Ewiresessions Jwinige=30  minutes

Tomcat Documentation true Q

None specified

Star
wihige=30  minutes

Sendet and JSP Examples true [}

stant [Stop) [ Reload | [_Undeploy
| [ Exiresessions | iate » 30 minutes

Tomcat Host Manager Application tue ]

[manager

None specified

Start Stop Reload Undeploy
Tomecat Manager Application true 1 = —
wihide=30  minutes

Deploy directory or WAR file located on server

Context Path (required): fofsaai
XML Configuration file URL:
WAR or Directory URL: 5aaweb/MOCKBOHOMEMcwebiolsaal war.

;mmhm

Select WAR file to upload

stop, d

Check to see ifa
Findleaks

This giagnostic check will tigger a full garbage collection. Use it with extrame caution on production systems.

| TomcatVersion | JVVersion JVM Vendor 05 Hame 05 Version Lo Hostname 1P Addre]

1.6.0_45-006 Sun Microsystems Inc. ‘ Linw: | 2.6,39-400.211.1.el6uekxB_64 | amas4 | 0f2£220354.in,oracle.com | 10.184.13

Apache Tomcal? 0.57

Copynght © 1999-2014, Apache Software Foundation

In the Deploy section, enter the Context Path provided during the installation as
"/<context-name>".

Enter the path where the <context-name>.war file resides (by default "$FIC WEB
HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.

On successful application deployment, a confirmation message is displayed.

Start the Tomcat server. Refer Starting Infrastructure Services for more details.
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Starting/ Stopping Infrastructure Services

This section details about how to start and stop Infrastructure services. This appendix covers
the following topics:

> Starting Infrastructure Services

> Stopping Infrastructure Services

Starting Infrastructure Services

Once the installation of Infrastructure has been completed successfully and the post-installation
steps are completed, the servers must be started. Log on to each machine and run the .profile
file. All servers mentioned must be started from the same shell encoding. The following servers
mentioned are dependent on each other. It is mandatory to maintain the order in which the
servers are started. Allow each of the servers to initialize completely before starting the next
server.

1. On the machine in which Infrastructure Application components have been installed,
navigate to SFIC_APP HOME/common/FICServer/bin and execute the following
command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the
command "nohup ./ startofsaai.sh &". Starting the process using "nohup" and
"&" will return the command prompt without having to wait till the process
completes. However, this command cannot be used when you are starting the
server for the first time or starting after changing user password in the
configuration database schema.You can also start the Infrastructure Server by
executing the command "nohup ./ startofsaai.sh &". Starting the process using
"nohup" and "&" will return the command prompt without having to wait till
the process completes. However, this command cannot be used when you are
starting the server for the first time or starting after changing user password
in the configuration database schema.

2. Start ICC server:

> On the machine in which Infrastructure default Application components have been
installed, navigate to $FIC_HOME/ficapp/icc/bin

2 Execute the command:

./iccserver.sh
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Note: Only Infrastructure Default Application Server would hold ICC

component.

3. Start Back-end Services:

> On the machine on which Infrastructure Database components have been installed,
navigate to $FIC_DB HOME/bin and execute the command to start "Agent server":

./agentstartup.sh

Or

> Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: NOTE: This agent internally starts the Router, Message Server,
OLAP data server and AM services.

Starting Web Application Servers

Start the Web Application Server depending on the type from the following table.

Table D-1 Webserver start up options

Start up Option

Description

Starting WebSphere profile

On the machine in which Web sphere is installed, navigate to
[Webshpere Install Directory]
/BAppServer/<profiles>/<profile name>/bin and execute the
command: ./startServer.sh serverl

Starting WebLogic Domain

On the machine in which WebLogic is installed, navigate to
<WebLogic Installation directorys/user_
projects/domains/<domain name>/bin and execute the command:
startWebLogic.sh -dé64

Note: If WebLogic is already running, access the WebLogic Admin
Console. Stop and start the application <context name>.ear

Starting Tomcat Application

On the machine in which Tomcat is installed, navigate to <Tomcat
Install_ Directory>/bin and execute the command:
./catalina.sh run

Stopping Infrastructure Services

To stop Infrastructure services, follow these steps:

1.  On the machine in which Infrastructure Application components have been installed,
navigate to $FIC_APP HOME/common/FICServer/bin and execute the command:.

./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application
components have been installed, navigate to SFIC_HOME/ficapp/icc/bin and execute

the command:

./iccservershutdown. sh
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Note: Only Infrastructure Default Application Server would hold ICC
component.

3. To stop Back-end server, on the machine in which Infrastructure database components
have been installed, navigate to SFIC_DB HOME/bin and execute the command:

./agentshutdown.sh
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Accessing OFSAA Application

This section gives details about the steps to be performed to access OFSAA Application.

Access the OFSAA Application

1. From your desktop, open the browser and enter the URL in the following format:

<scheme>://<IP address/
hostname>:<port>/<context-name>/login.jsp

For example, https://190.0.2.2/ofsaa/login.jsp
The OFSAA login window is displayed.

Figure E-1 OFSAA Login Window

Language US-English w
User ID |
Password

[Liogn ORACLE'

2. With installation of every OFSAA Application Pack, there are two seeded user profiles
configured in the system:

"SYSADMN - System Administrator
"SYSAUTH - System Authorizer
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3. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the
SYSADMN login USER ID). Enter the password that was provided during installation. On
the first login, you will be prompted to change the password.
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Post Deployment Configurations

This section provides detailed information about the Post Deployment Configurations.

Post Deployment Configurations

This section lists the various configurations to be completed before you use the OFSAA

Applications.

> Create Application Users

> Map Application User(s) to User Group
> Change ICC Batch Ownership

Create Application Users

Create the application users in the OFSAA setup prior to use.

Note: This step may not be required if you have already setup users in the

OFSAA setup.

For more information refer user creation section from the Oracle
Financial Services Analytical Applications Infrastructure

User Guide.

Map Application User(s) to User Group

Starting the OFSAA 8.0 release, with installation of every OFSAA Application Pack,
pre-configured application user groups are seeded. These user groups are unique to every
OFSAA Application Pack and have application roles pre-configured.

User Groups seeded with the OFS AAAI Application Pack are listed in the table.

Table F-1 Seeded User Groups

Name

Description

Modeler Group

User mapped to this group will have access to all the menu items for
Enterprise modeling but will not have authorization rights for sandbox
population, model deployment and modeling technique authorization.

Modeling Administrator
Group

User mapped to this group will have access to all the menu items for
Enterprise modeling and will be have authorization rights for sandbox
population, model deployment and modeling technique authorization.

Inline Processing Admin
Group

User mapped to this group will have access to all the menu items and
actions for Inline Processing module.
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Post Deployment Configurations

Table F-1 Seeded User Groups

Name Description

Business Administrator User mapped to this group will have access to all the menu items and
actions for advanced operations of metadata objects.

Business Authorizer User mapped to this group will have access to all the menu items and
actions for authorization of changes to metadata objects.

Business Owner User mapped to this group will have access to all the menu items and
actions for read and write of metadata objects

Business User User mapped to this group will have access to all the menu items and
actions for access and read of metadata objects.

Identity Administrator User mapped to this group will have access to all the menu items for
managing User entitlements, User Group Entitlements and Access
Management configurations.

Identity Authorizer User mapped to this group will have access to all the menu items for
authorizing User entitlements, User Group Entitlements and Access
Management configurations.

System Administrator User mapped to this group will have access to all menu items for
managing the setup configurations.

Object Administrator User mapped to this group will have access to all menu items for
managing object migration and metadata traceability using metadata
browser.

Guest Group User mapped to this group will have access to certain menu items with

only access privileges.

Map the application user(s) to the respective Application User Group(s) and subsequently
authorize the entitlements by logging in as SYSAUTH (System Authorizer) user.

For more information refer Mapping/Unmapping Users section from the Oracle Financial
Services Analytical Applications Infrastructure User Guide.

Change ICC Batch Ownership
This section is not applicable for OFS AAAI Application Pack.
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Cloning OFSAA Instance

There is a consistent need for a faster and effective approach of replicating an existing OFSAA
instance for further project developments, that is, setting up OFSAA instances that are exact
copies of the current OFSAA instance. For more information on cloning, refer OFSAA Cloning
Reference Guide.
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OFSAA Landing Page

This section includes the following topics:
> OFSAA Landing Page

> Enabling a Product within an Application Pack

OFSAA Landing Page

On successful authentication, the OFSAA Landing Page is displayed. This is a common landing
page for all users until a preferred application landing page is set by the user in his preferences.

The landing page includes multiple tabs and each tab has specific links to OFSAA
Infrastructure and/or Application modules. The tabs and links are displayed based on the
OFSAA Application accessed and the access roles mapped to the logged in user.

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a
tree structure. The RHS Menu holds link(s) to modules in a navigational window format.

The following tabs are available in the Landing Page:
> Applications Tab

> Sandbox Tab

> Object Administration Tab

> System Configuration and Identity Management Tab

Applications Tab

This tab lists the various OFSAA Applications that are installed in the OFSAA setup. The
Select Application drop-down list displays the OFSAA Applications, based on the logged in
user and mapped OFSAA Application User Group(s). Links to related modules within
Applications and Infrastructure are grouped appropriately to maintain a unified experience.

Sandbox Tab

This tab lists the various OFSAA Sandboxes created in the OFSAA setup and the Select
Sandbox drop-down list displays the OFSAA Sandboxes based on the logged in user and
mapped OFSAA Application User Group(s). Links to modules that operate only on Sandbox
features are grouped in this tab.

Object Administration Tab

This tab lists the various OFSAA Information Domains created in the OFSAA setup. The
Select Information Domain drop-down list displays the OFSAA Information Domains based
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on the logged in user and mapped OFSAA Application User Group(s). Links to modules that
enable object traceability and migration of objects are grouped in this tab.

System Configuration and Identity Management Tab

This tab lists the OFSAA Infrastructure System Configuration and Identity Management
modules. These modules work across Applications/ Information Domains and hence there are
no Application and Information Domain drop-down lists in this tab. Links to modules that
allow the maintenance of setup installation and identity management tasks are grouped together
in this tab.

Note: The navigation path differs from Application to Application. That is,
based on the selected Application, the navigation varies.

For more details on how to operate on each tab, see OFSAAI User Guide
available in OHC Documentation Library.

Enabling a Product within an Application Pack

You can also enable a product/ application within an application pack post installation at any
point of time.

To enable a product through the application UI, follow these steps:

1. Login to the application as SYSADMN user or any user with System Administrator
privileges.

2. Navigate to System Configurations & Identity Management tab, expand Financial
Services Analytical Applications Infrastructure, and Administration and
Configuration. Select System Configuration.

3. Click Manage OFSAA Product License(s).

4. The Manage OFSAA Product License(s) window is displayed as follows.
This window includes the following sections:
2 INSTALLED APPLICATION PACKS
» PRODUCTS IN THE APPLICATION PACK
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Figure H-1 Manage OFSAA Product License(s) window

Financial Services Analytical Applications infrastructure > n and Conf tion > System Ct > Manage OFSAA Product License(s)

AA APPLICATION PACK LICENSE

» INSTALLED APPLICATION PACKS

APPLICATION PACK ID APPLICATION PACK NAME DESCRIPTION INSTALL DATE
® OFS ABAIPACK Financial Services Advanced Analytics Infrastructure Pack ;:}:::Sslmsgl:;igvanccu Analytics using Oracle R, Modeling & Siress Testing Framework and Inline 0 1o 00 440003
» ‘Apphcations for Basel Basic, IRB & Analytic, Operational Risk Economic Capital & Analytic and Retail -
OFS_CAP_ADQ_PACK Financial Services Capital Adequacy Applications Pack Porfolio Risk Models and Pooing in Banking and Financial Senvices Domain 20141202 17:59:58.0
» PRODUCTS IN THE APPLICATION PACK
ENABLE |PRODUCT ID PRODUCT NAME DESCRIPTION ENABLE DATE
OFS_AAAI Financial Services Enterprise Modeling Base Infrastructure for Advanced Analytical Applications 2014-12-02 1422330
il OFS_IPE Financial Services Inine Processing Engine: Framework for Inline Processing Engine

R [(RESET |

5. The following fields are displayed in the INSTALLED APPLICATION PACKS section:

Table H-1 Installed Application Pack - Field Description

Field Description

Application Pack ID

the application pack will be displayed in the PRODUCTS IN THE
APPLICATION PACKS section.

Displays a unique Application Pack ID related to the application pack.
Select the appropriate Pack id using the radio button. The Products in

Application Pack Name Displays the name of the Application Pack.
Description Displays the description of the Application Pack.
Install Date Displays the date when the Application Pack was installed.

6. Select an Application Pack by clicking the radio button next to the Application ID.

7. The following fields are displayed in the PRODUCTS IN THE APPLICATION PACK
section:

Table H-2 Products in the Application Pack - Field Description

Field Description

Enable Select the checkbox to enable a product within an Application Pack.

The checkbox is disabled for the products which were enabled during
installation.

Product ID

Displays a unique product id for the product.

Product Name

Displays the name of the Product.

Description

Displays the description of the product.

Enable Date

Displays the date when the product was enabled.

8. Click RESET to cancel the operation and refresh the screen.
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9. Click VIEW LICENSE AGREEMENT to view the license information. The License
Agreement section is displayed.

Figure H-2 License Agreement

% LICENSE AGREEMENT
Oracle Financial Services Enterpnise Modeling Option (OFS AAAI} product is a separalely licensable product and would not be enabled unless it has been licensed. Oracle ey
Financial Services Enterprise Modeling Option (OFS AAAI) product is only part of the Oracle Financial Services Advanced Analytics Infrastructure Pack and specific OFSAA
Application Packs that require the advanced analytical features of this product. Oracle Financial Services Enterprise Modeling Option (OFS AAAL) product gets pre-selected
automatically on selecting any of the ofsaa products within a specific Application Pack that require this product to be enabled and configured

Multiple products being grouped together under a Application Pack, mandate installation and configuration of these products by default. However, during the Application Pack
instaliation, based on the products that are being selected, it would get enabled and would be licensed for. It is important to note that products once selected (enabled) cannot be
disabled at a later stage. However, products can only be enabled at any later stage using the OF SAA Infrastructure "Manage Application Pack License” feature.

m

Enabling a product within a Application Pack automatically implies you agree with this license agreement and the respeclive terms and conditions.

@) | ACCEPT THE LICENSE AGREEMENT
1 DO NOT ACCEPT THE LICENSE AGREEMENT.

ENABLE

10. Select the option l ACCEPT THE LICENSE AGREEMENT and click ENABLE. A
pop-up message confirmation is displayed showing that the product is enabled for the pack.

Note:

> To use the newly enabled product, you need to map your application
users to the appropriate product specific User Group(s) and authorize the
actions by logging in as System Authorizer.

> For more information refer to Mapping/Unmapping Users section in the
OFSAAI User Guide available in OHC Documentation Library.

> To identify the newly enabled product specific UserGroups/ Application Pack
specific User_Groups, refer to the respective Application Pack specific
Installation and Configuration Guide/ User Manual.
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Additional Configuration

This section gives detailed information about the Additional Configuration regarding OFSAA
Installation.

Additional Configuration

This section covers the following topics:

?

?

?

FTP/SFTP Configuration for File Transfer
Configuring Infrastructure Server Memory
Internet Explorer Settings

Retrieving Patch Information

OLAP Data Server Configuration

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance
OFSAALI Setup Information Fetching Tool
Encryption Changer

Infrastructure LDAP Configuration

Configuring OFSAAI Web Services

Deploying OFSAAI Web Services

Configuring Message Details in Forms Designer
Clearing Application Cache

Configuring Passwords Changes

Configuring Java Virtual Machine

Configuring Internal Service (Document Upload/ Download)

FTP/SFTP Configuration for File Transfer

In OFSAA, certain modules require transfer of files from the web application server to the
OFSAA server over SSH.

Follow these steps to ensure the OFSAA server recognizes the web application server during
file transfers.

1.
2,

Login to the web application server.

Type sftp <user>@<OFSAA Server>
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3. Specify Yes when prompted for permission.

Are you sure you want to continue connecting (Yes/No)?
4. This will add an entry into the "known_hosts" file.
5. A confirmation message is displayed:

Permanently added <OFSAA Server> RSA) to the list of known hosts.

Configuring Infrastructure Server Memory

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic
can be edited for customizing memory settings and garbage collector settings depending on the
available hardware configuration as explained in the following section. These settings are base
minimum and has to be incremented considering the deployment metrics into account. The
increments are usually handled in multiples of 128mb for heap and 64mb for stack.

Infrastructure Application Server Memory Settings

You can configure the Infrastructure Application Memory settings as follows:
1. Locate .profile file.

2. Edit X _ARGS field in this file for customizing memory settings and garbage collector
settings depends on the hardware configuration.

This has a default value X ARGS="-Xms200m"

X ARGS=" "S$X ARGS" S$DELIM -Xmx2048m"

Note: This parameter is modified in 7.3.2 IR and you need to modify X
ARGS_APP variable in the .profile file to customize Java Memory Settings
for Model Upload based on the Data Model size.

For Run and Rule executions, the following value is recommended:

X ARGS RNEXE="-Xmslg -Xmxlg -XX:+UseAdaptiveSizePolicy
-XX:MaxPermSize=512M -XX:+UseParallelOldGC
-XX:+DisableExplicitGC"

X ARGS RLEXE="-Xmslg -Xmxlg -XX:+UseAdaptiveSizePolicy
-XX:MaxPermSize=512M -XX:+UseParallelOldGC
-XX:+DisableExplicitGC"

Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet Explorer, that
is, 100%.
Cookies should be enabled.

The following browser settings have to be specified at every client machine prior to accessing
the Infrastructure application.

1. Open Internet Explorer. Select Tools > Internet Options. The /nternet Options window
is displayed.

2. Click the Settings button. The Settings window is displayed.
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3. Select the option Every time I Visit the webpage and click OK.

Figure I-1 Internet Options

-
Internet Opticns

" Website Data Settings

General |Securit5-I I Privacy I Content I Connections | Programs | Advanced

Home page
I/? To create home page tabs, type each address on its own line.
b '3

aboutblank -

[ Use current ] [ Use default ][ Use new tab

Startup

() Start with tabs from the last session
(@) Start with home page
Tabs -
Change how webpages are displayed in tabs.

Browsing history -

Delete temporary files, history, cookies, saved passwords, and web
form information.

|| Delete browsing history on exit

Temporary Internet Files |Hishory I Caches and datat |

Internet Explorer stores copies of webpages, images, and media
for faster viewing later.

Check for newer versions of stored pages:
(@) Every time I visit the webpage
() Every time I start Internet Explorer
() Automatically
() Never
Disk space to use (3-1024MB) 250 =
(Recommended: 50-250MB)
Current location:

C:\Wsers\shwwali\AppDataLocal \Microsoft\Windows \Temporary
Internet Files\,

[ Move folder... ][ View objects ][ View files l

[ OK ] [ Cancel

[ Delete... ] [ Settings

]

Appearance

Colors ][ Languages H Fonts

] [ Accessibilty |

[ o

][ Cancel ] Apply

F.

4. In the Internet Options window, select the Security tab and select the Internet option

under Select a zone to view or change the security settings.

5. Click Default Level under Security level for this zone.
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Figure I-2 internet Options

Internet Options @El

| General | Security | Privacy | Content | Connections | Programs | Advanced

Select a zone to view or change security settings.,

@ 9 /e

Localintranet  Trusted sites  Restricked
sites

Internet

0 This zone is for Internet websites,
except those listed in trusted and
restricted zones.,

Security level For this zone
Allovwed levels for this zone: Medium ko High
Medium-high
- - Appropriate for most websites
- Prompts before downloading potentially unsafe

conkent
- Unsigned ActiveX controls will not be downloaded

[ OK ” Cancel ]

Click OK to save.

Click Internet Explorer >> Tools >> Compatibility View Settings.
Enter the OFSAA setup URL in the Add this website ficld.

Click Add.

© ® N o

10. Ensure the URL is listed under Websites you've added to Compatibility View.

11. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up
Blocker option under Pop-up Blocker settings.
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Figure I-3 Internet Options- Popup Blocker Settings

Internet Opticns >
» L p-c |E] Blirsagation Concoed | |

| General | security | Privacy | content | Connections | Programs | Advanced |

Settings

Select a setting for the Internet zone.
Medium

- Blocks third-party cookies that do not have a compact

privacy policy

- Blocks third-party cookies that save information that can
] be used to contact you without your explict consent

- Restricts first-party cookies that save information that

can be used to contact you without your implicit consent

[ sites | [ mport | [ Advanced | Default
Location
[ Never allow websites to request your [ Clearsites |

physical location "
BB Pop-up Blocker Settings &5 =]
[#] Turn on Pop-up Blocker e
InPrivate —= Pop-ups are curerttly blocked. You can allow pop-ups from specific

|_ - 2 .’| websites by adding the site to the list below.

Disable toolbars and extensions when InPrivate Browsing starts
Address of website to allow:

@ Some settings are managed by your system administrator. Allowed sites:
“.oracle.com s
oK | cancel Apply =
oraclecom.com
*.eraclevpn.com Remove all...

Maotifications and blocking level:

Play a sound when a pop-up is blocked
[#] Show Netification bar when a pop-up is blocked.

Blocking level:

[ Medium: Block most automatic pop-ups -]

Leam more sbout Pop-up Blodker

12. Click Settings. The Pop-up Blocker Settings window is displayed.

13. Enter the URL of the OFSAA Application in the Address of Website to Allow: field.
14. Click Add. The OFSAA URL is displayed in the Allowed Sites section.

15. Click Close.

16. Click OK in the Internet Options window.

Retrieving Patch Information
To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.
2. Navigate to Object Administration tab, expand Utilities and click Patch Information.

3. The window displays the list of patches installed on the OFSAA setup across Applications/
Platform.

OLAP Data Server Configuration
This section is applicable if you are using the OLAP feature of OFSAALI

The following parameters must be set to ensure that the system limitations are not exceeded at
any stage. The values for these OS parameters should be specified based on the expected load
at each implementation site.

Example:

Process Memory Limit
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Max Thread Stack Size
Max Number of Threads per Process

> Sort Buffer settings: This must be set at the Essbase application level appropriate to the
anticipated load.

> Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data
Services that is communicating with an OLAP Data Server, it is imperative to ensure that
the cleanup of the old instance is completed on the OLAP Data Server before restarting the
OFSAALI Server. Pause for a period of time based on the load the system was subjected to,
before restarting the Data Services subsystem.

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance

For information on this section, refer OFS Analytical Applications Infrastructure
Administration User Guide in OHC Documentation Library.

OFSAAI Setup Information Fetching Tool

Executing the SetupInfo.jar file available in the FIC HOME path will help you retrieve the
related information about the OFSAAI Set up such as Operating System Name and version,
Database Type and Version, OFSAALI architecture, Log file locations and so on.

To execute SetupInfo.jar in console:
1. Navigate to the path SFIC_HOME.
2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Encryption Changer

This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the
encrypted values of the OFSAAI setup according to the new key.

To execute EncryptC.jar in console:
1. Navigate to the path SFIC_HOME.
2. Enter the command:
java -jar EncryptC.jar
A confirmation message is displayed after execution.

Once executed, you need to create and deploy the EAR / WAR file depending on the configured
Web Application Server. For more information, refer Appendix C.

Infrastructure LDAP Configuration

For more information on LDAP configuration, see Oracle Financial Services
Analytical Applications Infrastructure Administration Guide.

Configuring OFSAAI Web Services

Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or
"synchronously" execute requested tasks offered by OFSAAI The following configuration
steps are to be done only if you are using the Web Services feature of OFSAAL
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Configure DynamicWSConfig.xml File

For each third party web service that needs to be accessed using the OFSAAI Web services
framework and the operations to be invoked, corresponding entries are to be made in the
DynamicWSConfig.xml template file.

The variable <WebServer> denotes any one of the application server, that is, WebSphere,
WebLogic, or Tomcat.

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation
Directory>/EXEWebService/ <WebServer>/ROOT/conf directory. This file can be placed
in any directory that is accessible by the application and this location must be specified in the
web.xml file, as WSCONFIGFILE parameter.

The DynamicWSConfig.xml template file will be in <WebServer Deployment Path>/
EXEWebService.ear/EXEWebService.war/conf directory.

This template is as follows:
<XML>
<WEBSERVICES>
<WEBSERVICE CODE="$CODE"
ENDPOINT="S$SENDPOINT" TARGETNAMESPACE="S$TARGETNAMESPACE"
XMLNS XSD="S$XMLNS XSD" ENCODINGSTYLE="SENCODINGSTYLE"
SERVICENAME="S$SERVICENAME" PORTTYPENAME="S$PORTTYPENAME"
SESSION MAINTAIN PROPERTY="$SESSION MAINTAIN PROPERTY"
USERNAME="$USERNAME"
PASSWORD="$PASSWORD" STYLE="S$WEBSERVICESTYLE"
STUBIMPLEMENTATION="$STUBIMPLEMENTATION" >
<OPERATION CODE="S$CODE"
NAME="$NAME"
SOAPACTION="$SOAPACTION"
STYLE="S$STYLE"
PACKAGENAME="S$PACKAGENAME ">
<INPUT ORDER="S$SORDER"
PARAMNAME="S$PARAMNAME"
ARGTYPE="SARGTYPE"
CLASSNAME="$CLASSNAME" />
<OUTPUT PARAMNAME="S$PARAMNAME"
RETURNTYPE="SRETURNTYPE"
CLASSNAME="$CLASSNAME" />
</OPERATION>
</WEBSERVICE>
</WEBSERVICES>

</XML>
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The DynamicWSConfig.xml has the placeholders as shown in the following table. These have
to be updated depending on the web service chosen and the mode of accessing it. For each Web

service to be accessed, the entire webservice tag in the DynamicWSConfig.xml file must be
repeated. The placeholders tabulated as follows should be set in accordance to the parameters
published in the third party wsdl files (webservices) to be accessed. The stub class specified

must implement the "com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF"

interface.

Attributes for WEBSERVICE tag

Table -1 WEBSERVICE tag

Placeholder Description

$CODE Unique number within the xml file and cannot be 999 or 0.

$ENDPOINT soap: address location in the wsdl: service name tag of the
wsdl file.

$STARGETNAMESPACE The attribute value for the targetNamespace of the wsdl:
definitions tag.

$XMLNS_XSD The attribute value for the xmlns:s of the wsdl:definitions tag

$ENCODINGSTYLE The attribute value for the xmlns: soapenc of the
wsdl:definitions tag.

$SERVICENAME Name of the service found under the wsdl:service name tag of
the wsdl file.

$PORTTYPENAME wsdl port type name as mentioned in the wsdl file.

$SESSION MAINTAIN PROPERTY

"

This could be given as "" also.

$USERNAME User name to access the web services. Enter "" if no user name is
required.

$PASSWORD Password to access the web services. Enter "" if no password is
required.

SWEBSERVICESTYLE This can take either "rpc" in case of DII mode of invoking web
services or "stub" in case of static mode. This is a mandatory
parameter.

$STUBIMPLEMENTATION Fully qualified class name (package name .classname).

Attributes for OPERATION tag

Ensure that the "operation tag attributes" are repeated for each of the operation tags.

Table -2 OPERSTION tag

Placeholder Description

$CODE Should be unique within the Webservice tag.

SNAME The name of the Function that is to be called by the wsdl file.

$SOAPACTION The URL for the Operation to access. This is associated with the
Operation tag of the wsdl file.

$STYLE This can take "rpc" if the web services invoking is in DII
mode or "stub" if it is in static mode. This is a mandatory
parameter.

$SPACKAGENAME Represents the JAXB package of input object.

I1-82 OFS AAAI Application Pack Installation and Configuration Guide




Additional Configuration

Attributes for INPUT tag
Table -3  INPUT tag

Placeholder Description

$SORDER The sequential number of the INPUT tag. Should start
from 0. This is in line with the input order of the
arguments that the API accepts which is called by this

operation.
$PARAMNAME Input parameter name to be called by the wsdl file.
$ARGTYPE Input Parameter Data Type. If the input argument type is

complex object, specify SARGTYPE as "xmlstring".

$CLASSNAME Represents class name of input object parameter.

Attributes for OUTPUT tag
Table -4 OUTPUT tag

Placeholder Description

$PARAMNAME Output parameter name to be returned by the web
service.

SRETURNTYPE Output parameter Data Type. If the web service response is a
complex object, then specify SRETURNTYPE as "object".

$CLASSNAME Represents class name of output object parameter.

web.xml Entries

1. This step is optional and required only if the web application server used is Tomcat. In
case of any other application server, skip and proceed with next step.

Navigate to $SFIC_HOME/webroot/WEB-INF/ and edit the web.xml file. Set parameter
value DOCSERVICEAPP to EXEWebServiceAXIS.

2. Navigate to <OFSAAT Installation

Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and edit the web.xml file
as follows:
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Note: In case of Java 7 when WebLogic is used as web application server
replace following line of <OFSAAT Installation
Directory>/EXEWebService/Weblogic/ROOT/WEB-INF/web.xml file
that is

<?xml version='1l.0' encoding='UTF-8'?>

<web-app 1d="WebApp ID" version="3.0"
xmlns="http://java.sun.com/xml/ns/javaee"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemaLocation="http://java.sun.com/xml/ns/javaee

http://java.sun.com/xml/ns/javaee/web-app 3 0.xsd"
metadata-complete="true">

with
<?xml version='1l.0' encoding='UTF-8'?>
<web-app xmlns="http://java.sun.com/xml/ns/j2ee"

xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

Entry for WSConfig File

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer
Deployment Path>/ EXEWebService.ear/EXEWebService.war/conf
directory. This file can be placed in any directory that is accessible by the application.

The path where the WSCONFIG file is placed must be specified in place of
SWSCONFIGFILELOCATIONS in the following block of text in web . xm1.

<context-param>

<description>WebServices Configuration File</description>
<param-name>WSCONFIGFILE</param-name>
<param-value>$WSCONFIGFILELOCATIONS$</param-value>
<!--Specify the Location of DynamicWSConFig.xml-->

</context-param>

Proxy Settings

Replace the following <param-value> given in bold in the following block of text in web . xml
file, with appropriate values.

If no values are required, leave the <param-value> blank.
<context-param>
<description>http Proxy Host</description>
<param-name>http.proxyHost</param-name>
<param-value>$PROXYHOST$</param-value>
<!-- Specify the IP address or hostname of the http proxy server-->
</context-param>

<context-param>
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<description>http Proxy Port</description>
<param-name>http.proxyPort</param-name>
<param-value>$PROXYPORTS$</param-value>
<!--Port Number for the Proxy Server-->
</context-param>
<context-param>
<description>http proxy UserName</description>
<param-name>http.proxyUserName</param-name>
<param-value>$PROXYUSERNAME$</param-value>
<!-- User ID To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http proxy Password</description>
<param-name>http.proxyPassword</param-name>
<param-value>$PROXYPASSWORDS</param-value>
<!-- User Password To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http non-ProxyHosts</description>
<param-name>http.nonProxyHosts</param-name>
<param-value>$NONPROXYHOST$</param-value>

<!--Hosts for which the proxy settings should get by-passed (Note:
Separate them by "|" symbol) -->

</context-param>

OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAALI installation and
should be accessible.

Replace SFIC_HOMES in the following block of text in web . xml with <WebServer
Deployment Path>/EXEWebService.ear/EXEWebService.war.

<context-param>
<description>0OFSAAI Web Home</description>
<param-name>FIC HOME</param-name>
<param-value>$FIC HOME$</param-value>
<!--OFSAAI Installation Folder-->
</context-param>
<context-param>
<description>0OFSAAI Web Home</description>

<param-name>FIC PHYSICAL HOME</param-name>
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<param-value>$FIC HOMES</param-value>
<!--OFSAAI Installation Folder-->

</context-param>

DynamicWSConfig.xml

For each third party web service that needs to be accessed using the OFSAAI Web services
framework, and the operation to be invoked, make corresponding entries into this file. This file
is to be placed in the location that is specified in the web.xml, as WSCONFIGFILE parameter.

Deploying OFSAAI Web Services

You can deploy OFSAAI Web Services separately if you had not configured OFSAAI Web
Services as part of the installation.

1. Complete the manual configuration of OFSAAI Web Services.

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> and
execute the command:

./ant.sh
This will trigger the EAR/WAR file creation, which is required for the deployment.
3. Deploy the generated EXEWebService.EAR/EXEWebService . .WAR file into the WebServer.

If you have already configured OFSAAI Web Services as part of the installation, deploy the
generated EXEWebService .EAR/ EXEWebService.WAR file into the OFSAAI Deployment
area in WebServer profile.

Configuration to Enable Parallel Execution of DML statements

A configuration file, OracleDB.conf has been introduced to accommodate any configurable
parameter related to operations on oracle database. If you do not want to set a parameter to a
specific value, then the respective parameter entry can be removed/commented off form the
OracleDB.conf file that resides in the path SFIC DB HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE OF
PARALLELISM. This parameter indicates the degree of parallelism to be used for a DML
operation if parallel DML is explicitly enabled in the session with the ENABLE PARALLEL
DML clause of the ALTER SESSION statement. The default mode of a session is DISABLE
PARALLEL DML. If CNF_DEGREE OF PARALLELISM is not set, then the default degree,
as decided by Oracle will be used.

Configuring Message Details in Forms Designer

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries
module by updating the details of mail server in the "NotificationConfig.cfqg" file that
resides in the path $SFIC_APP HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message details
are included in Administration > Security Management > User Administrator > User
Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:
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Table -5 NotificationConfig.cfg File

Parameter Description
SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server.
SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true',

otherwise set value to 'false’'.

SMTP_AUTHORIZATION Set to 'true’ if SMTP server requires the client to be

authenticated, otherwise set to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if

authentication is not required use a dummy value.

SMTP_PASSWORD Password required for logging into SMTP server, if

authentication is not required use a dummy value.

SMTP_MAILID If the Messages has to go from a Particular ID that ID

need to be added. Exchange server forces you set a valid
ID that is there in the exchange server. (Based on
Security settings)

Clearing Application Cache
This is applicable to all Web Servers (that is, WebSphere, WebLogic, and Tomcat).

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, clear
the cache. Navigate to the following path depending on the WebServer configured and delete
the files:

2

Tomcat: <Tomcat installation
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

WebLogic: <Wieblogic installation location>/domains/<Domain
name>/servers/<Server name>/tmp/ WL user/<Application name>/qaelce/jsp_
servlet

WebSphere: <Websphere installation
directory>/AppServer/profiles/<Profile name>/temp/<Node
name>/serverl/<Application name>/<.war file name>

Configuring Passwords Changes

This section explains about how to modify the OFSAA Infrastructure Config Schema and
Atomic Schema passwords.

OFSAA Infrastructure Config Schema password modification
To change the Config Schema password, perform the following steps:

1.
2.
3.

Change the Config schema User Password in the database.
Delete the SFIC_HOME/conf/Reveleus.SEC file.
Shutdown the OFSAAI App service:

cd $FIC_APP HOME/common/FICServer/bin
./stopofsaai.sh

Start the Infrastructure Server in foreground directly on the server or through X-Windows
software using the command:

./startofsaai.sh
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At the prompt, enter System Password. Enter the "new Config schema" password. The
service will start and initialize itself if it is able to successfully connect to the DB.

If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag
details in Server.xml file from the SCATALINA HOME/conf directory. For Tomcat, both
Config Schema (FICMASTER resource) and Atomic Schema (KINFODOM_NAME>
resource) exist.

If you are using WebSphere as Web server:
a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated
on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both
Config and Atomic data sources will need to be modified).

If you are using WebLogic as Web server:
a. Login to the WebLogic Administration Console, from the left side menu

b. Under Domain Structure list box, expand the appropriate Domain and navigate to
Services > JDBC >Data Sources. A list of data sources will be populated on the right
side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both
Config and Atomic data sources need to be modified).

Post successful startup of the service, if required, the Infrastructure server may be shut
down and restarted in the background using nohup mode.

OFSAA Infrastructure Atomic Schema password modification

To change the Atomic Schema password, perform the following steps:

1.
2.

Change the Atomic schema User Password in the database.

Login to the application from the browser using SYSADMN account or any user id, which
has System Administrator role mapped.

Navigate to System Configuration > Database Details window. Select the appropriate
connection and edit the password.

Navigate to Data Management Tools >Data Sources> Source Designer window. Update
the password of the appropriate Source.

If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag
details in Server.xml file from the SCATALINA HOME/conf directory. For Tomcat, both
Config Schema (FICMASTER resource) and Atomic Schema (KINFODOM_NAME>
resource) exist.

If you are using WebSphere as Web server:
a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated
on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both
Config and Atomic data sources will need to be modified).

If you are using WebLogic as Web server:

a. Login to the WebLogic Administration Console, from the left side menu
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b. Under Domain Structure list box, expand the appropriate Domain and navigate to
Services > JDBC >Data Sources. A list of data sources will be populated on the right
side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both
Config and Atomic data sources need to be modified).

6. Restart the OFSAALI services.

Configuring Java Virtual Machine

While running several database intensive tasks in parallel, fetching the database connection
from connection pool may face an error. To ensure no such error is encountered, add the line
securerandom.source=file:/dev/./urandom in the java.security configuration file
available in SJAVA HOME/jre/lib/security/ path.

This needs to be configured on all the machines or virtual machines where the OFSAAI
database components (ficdb layer) are installed.

Configuring Internal Service (Document Upload/ Download)

This step can be ignored if it has already been configured as part of any previous IR /ML
installation.

The Document Upload /Download feature has undergone a change and can now be configured
to use Internal service for document upload / download instead of the earlier ExeWebService.

To facilitate Internal service for document upload/ download, perform the following
configurations:

1. Create the folders download, upload, TempDocument and Temp in the local path of Web
application server and provide Read/Write permission.

> To find the exact location, execute the following query in CONFIG schema:
select localpath from web server info

> To create folders with Read/Write permission, execute the command:
mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write
permission.

> To find the exact location, execute the query in CONFIG schema:
select ftpdrive from app server info

> To create folder with Read/Write permission, execute the command:
mkdir -m 777 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to
FALSE in the Configuration table in CONFIG schema and hence the application
“ExeWebService” will not be used. It is recommended that the value to be set to FALSE and
use the Internal service for document upload/ downloads. If you intend to continue using the
External ExeWebService, set the value to TRUE.

Navigate to SFIC_HOME/EXEWebService/<WEBSERVER TYPE> directory of WEB tier
and type ./ant.sh. This triggers the creation of EAR/WAR file EXEWebService.ear/.war.
The EAR/WAR file EXEWebService.ear/.war will be created in SFIC

HOME /EXEWebService/<WEBSERVER TYPE> directory of WEB tier. Redeploy the
generated EAR/WAR file onto your configured web application server.
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Patching OFSAA Infrastructure Installation

Patching Your OFSAA Infrastructure Installation

Oracle strongly recommends installing the latest available patch set so as to be up to date with
the various releases of the OFSAA product.

Refer http://support.oracle.com for more information on latest release.
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Grants for Atomic/ Config Schema

This section mentions about the various grants required for the CONFIG, ATOMIC schemas.

This section discusses the following sections:

»  Grants for Atomic Schema

> QGrants for Config Schema

> Grants for Config Schema Entities for Atomic Users

Grants for Atomic Schema

Atomic Schema creation requires certain grants for object creation. This can be located in
SFIC HOME/privileges atomic user.sql file.

The following are the Grants for Atomic Schema:

grant create SESSION to &database username

/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant

/

create

create

create

create

create

create

PROCEDURE to &database username

SEQUENCE to &database username

TABLE to &database username

TRIGGER to &database username

VIEW to &database username

MATERIALIZED VIEW to &database username

olap user to &database username

select

on SYS.V SPARAMETER to &database username

Grants for Atomic/ Config Schema
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grant create SYNONYM to &database username

/

Note: If you intend to use Oracle OLAP feature, execute the following
grant on all ATOMIC schema(s):

grant olap user to &database username

Grants for Config Schema

Config Schema creation requires certain grants for object creation. This can be located in
SFIC HOME/privileges config user.sql file.

The following are the Grants for Config Schema:

grant create SESSION to &database username

/

grant create PROCEDURE to &database username

/

grant create SEQUENCE to &database username

/

grant create TABLE to &database username

/

grant create TRIGGER to &database username

/

grant create VIEW to &database username

/

grant create MATERIALIZED VIEW to &database username
/

grant olap user to &database username

/

grant select on SYS.V $PARAMETER to &database username
/

grant create SYNONYM to &database username

/

Grants for Config Schema Entities for Atomic Users

Atomic Schema creation requires certain grants for config schema object access. This can be
located in $FIC_HOME/config table privileges for atomic user.sql file.

The following are the Grants for Config Schema entities for Atomic Users:
grant select on CSSMS USR PROFILE to &database username
/
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grant select on CSSMS ROLE MAST to &database username

grant select on CSSMS GROUP MAST to &database username

grant select on CSSMS FUNCTION MAST to &database username

grant select on CSSMS USR GROUP MAP to &database username

grant select on CSSMS USR GROUP _DSN SEG MAP to &database username

grant select on CSSMS ROLE FUNCTION MAP to &database username

grant select on CSSMS GROUP ROLE MAP to &database username

grant select on CSSMS SEGMENT MAST to &database username

grant select on CSSMS USR DSN SEG MAP to &database username

grant select on CSSMS USR ROLE MAP to &database username

grant select on CSSMS METADATA SEGMENT MAP to &database username

grant select on BATCH RUN to &database username

grant select on PR2 FILTERS to &database username

grant select on PR2 TASK FILTER to &database username

grant select on PR2 TASK FILTER DETAIL to &database username

grant select on ST STRESS MASTER to &database username

grant select on ST SCENARIO MASTER to &database username

grant select on ST SHOCK MASTER to &database username

grant select on BATCH MASTER to &database username
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grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

grant

select

select

select

select

select

select

select

select

select

delete

insert

update

select

delete

insert

update

select

select

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

on

ICC_MESSAGELOG to &database username

PR2 MASTER to &database username

PR2_RUN_REQUEST

to &database username

MF MODEL SCRIPT MASTER to &database username

MF INPUT VALUES

to &database username

MF MODEL OUTPUT VALUES to &database username

DB MASTER to &database username

DSNMASTER to &database username

pr2_rule map to

pr2_rule map pr

pr2_rule map pr

pr2_rule map pr

pr2_rule map pr

pr2_rule map pr_

pr2_rule map pr_

pr2_rule map pr_

pr2_rule map pr_

&database username

to &database username

to &database username

to &database username

to &database username

tmp to &database username

tmp to &database username

tmp to &database username

tmp to &database username

pr2_rule map exclude to &database username
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grant delete on pr2 rule map exclude pr to &database username

grant insert on pr2 rule map exclude pr to &database username

grant update on pr2 rule map exclude pr to &database username

grant select on pr2 rule map exclude pr to &database username

grant delete on pr2 rule map exclude pr tmp to &database username

grant insert on pr2 rule map exclude pr tmp to &database username

grant update on pr2 rule map exclude pr tmp to &database username

grant select on pr2 rule map exclude pr tmp to &database username

grant select on pr2 run object to &database username

grant select on pr2 run object member to &database username

grant select on pr2 run map to &database username

grant select on pr2 run execution b to &database username

grant select on pr2 run execution filter to &database username

grant select on pr2 firerun filter to &database username

grant select on pr2 filters to &database username

grant select on configuration to &database username

grant select on batch parameter to &database username

grant select on component master to &database username

grant select on MDB OBJECT TYPE ATT LAYOUT to &database username
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/

grant select on REV_OBJECT ATTRIBUTE DTL to &database username
/

grant select on FORMS LOCALE MASTER to &database username

/

grant select on mdb object dependencies to &database username
/

grant select on mdb_execution details to &database username

/

grant select on REV_STAT DATA to &database username

/

grant select on REV_OBJECT REPOSITORY B to &database username
/

grant select on REV_OBJECT REPOSITORY TL to &database username
/

grant select on REV_OBJECT ATTRIBUTE DTL MLS to &database username
/

grant select on REV_OBJECT APPLICATION MAP to &database username
/

grant select on MDB OBJ EXPR DETAILS to &database username

/

grant select on MDB EXECUTION DETAILS to &database username

/

grant select on REV_OBJECT TYPES CD to &database username

/

grant select on REV_OBJECT TYPES MLS to &database username

/

grant select on REV_APPLICATIONS CD to &database username

/

grant select on REV_APPLICATIONS MLS to &database username

/

grant select on METADATA BROWSER LOCALE to &database username
/

grant select on MDB STAT DATA to &database username

/

grant select on MDB OBJECT TYPE LAYOUT to &database username

/
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grant select on ofsa md id ref to &database username

/

grant select on MDB ETL MAPPING to &database username
/

grant select on setupinfo to &database username

/

grant select on LOCALEREPOSITORY to &database username
/

grant select on MF MODEL MASTER to &database username
/

grant select on MF SANDBOX MASTER to &database username
/

grant select on MF VARIABLE MASTER to &database username

grant select on MF TECHNIQUE MASTER to &database username

grant select on MDB RULE SOURCE HEADER to &database username

grant select on MDB RULE TARGET HEADER to &database username

grant select on MDB RULE TARGET MEMBER HEADER to &database username

grant select on MDB RULE GRID DATA to &database username

grant select on MDB MODEL MAPPING to &database username

grant delete on AAT MAP MAPPER to &database username

grant insert on AAI MAP MAPPER to &database username

grant update on AAI MAP MAPPER to &database username

grant select on AAT MAP MAPPER to &database username

grant select on RTI UI EXCLUDE PDM LIST to &database username

grant select on RTI VIR PHY TBL NAME to &database username
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/

grant select on infodom patches to &database username

/
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Configuring Application Pack XML Files

This section explains configuration of <<App Pack>> PACK.xml and <<App Pack>>
SCHEMA IN.xml files.

This section includes the following topics:
> Configuring <<APP Pack>> PACK.xml file
> Configuring <<APP Pack>> SCHEMA IN.XML file

Configuring <<APP Pack>>_PACK.xml file

The <<APP PACK>> PACK.zxml file holds details on the various OFSAA products that are
packaged in a particular Application Pack.

The following table gives details about the various tags/ parameters available in the file and the
values that need to be updated. Prior to installing the OFSAA Application Pack in SILENT
mode, it is mandatory to update this file.

Note: If you are installing in the GUI mode, then this file need not be
updated.

Table L-1 <<APP PACK>>_PACK.XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
APP_PACK ID Unique Application Pack Y Unique Seeded Value DO NOT modity this value.
Identifier
APP PACK Unique Application Pack Y Unique Seeded Value DO NOT modify this value.
NAME Name
APP PACK Unique Application Pack Y Unique Seeded Value DO NOT modify this value.
DESCRIPTION Description
VERSION Unique release version Y Unique Seeded Value DO NOT modity this value.
APP Unique Application Entries | Y Unique Seeded Value DO NOT remove these tags.
APP_ID Unique Application Y Unique Seeded Value DO NOT modify this value.
Identifier
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Table L-1 <<APP PACK>>_PACK.XML Parameters

Tag Name/
Attribute Name

Description

Mandat

ory
(YIN)

Default Value/
Permissible Value

Comments

APP_ID/
PREREQ

Prerequisite Application/
Product

Y

Unique Seeded Value

For most applications
Infrastructure would be the
prerequisite set. For certain
other applications, an
appropriate Application ID
would be set.

DO NOT modify this value.
DO NOT modity this value.

APP_ID/ DEF_
SEL_FLAG

Default Selected Flag

Default - YES

In all Application Packs,
Infrastructure would have
this value set to "YES". DO
NOT modify this value.

APP_ID/
ENABLE

Enable Application/ Product

YES if
installing
in
SILENT
mode.

Default -

YES for Infrastructure
NO for Others
Permissible - YES or NO

Set this attribute-value to
YES against every APP_ID
which is licensed and should
be enabled for use.

Note: Application/ Product
once enabled cannot be
disabled. However,
Application/ Product not
enabled during installation
can be enabled later through
the Administration UL

APP NAME

Unique Application/ Product
Name

Unique Seeded Value

DO NOT modify this value.

APP_
DESCRIPTION

Unique Application/ Product
Name

Unique Seeded Value

DO NOT modity this value.

VERSION

Unique release version

Y

Unique Seeded Value

DO NOT moditfy this value.

Configuring <<APP Pack>>_SCHEMA_IN.XML file

Creating database schemas, objects within schemas and assigning appropriate grants are the
primary steps in the installation process of OFSAA Applications. The <<APP PACK>>
SCHEMA IN.xml file contains details on the various application schemas that should be
created prior to the Application Pack installation.

The following table gives details about the various tags/ parameters available in the file and the
values that need to be updated. Prior to executing the schema creator utility, it is mandatory to

update this file.
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Table L-2 <<APP PACK>>_SCHEMA_IN. XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<APP_PACK Seeded unique ID for the Y Seeded DO NOT modify this value.
ID> OFSAA Application Pack
<JDBC_URL> Enter the JDBC URL Y Example, Ensure to add an entry (with
Note: You can enter RAC jdbe:oracle:thin: @<HOST/I ?;?{ﬁgg;ﬁifg&? tllllle
and NON-RAC enabled P>:<PORT>:<SID> )
database connectivity URL OFSAA server. The entry
y LR or should match with the SID/
jdbc:oracle:thin:@//[HOST][ '[ShF;F.{I\];IBCCE [I}Tﬁ}i\/l E used in
:PORT]/SERVICE ’
or
jdbc:oracle:thin: @(DESCRI
PTION=(ADDRESS
LIST=(ADDRESS=(PROTO
COL=TCP)(HOST=[HOST]
)(port=[PORT]))(ADDRESS
=(PROTOCOL=TCP)(HOS
T=[HOST])(PORT=[PORT])
)(LOAD_
BALANCE=yes)(FAILOVE
R=yes))(CONNECT _
DATA=(SERVICE _
NAME=[SERVICEY))))
For example,
jdbc:oracle:thin:@//dbhost.se
rver.com:1521/servicel
or
jdbc:oracle:thin:@//dbshost.s
erver.com:1521/scan-1
or
jdbc:oracle:thin: @(DESCRI
PTION=(ADDRESS
LIST=(ADDRESS=(PROTO
COL=TCP)(HOST=dbhost!.
server.com)(port=1521))(AD
DRESS=(PROTOCOL=TCP
)(HOST=dbhost2.server.com
)(PORT=1521))(LOAD _
BALANCE=yes)(FAILOVE
R=yes))(CONNECT _
DATA=(SERVICE _
NAME-=servicel)))
<JDBC _ By default this driver name | Y Example, Only JDBC Thin Driver is
DRIVER> is seeded. oracle.jdbc.driver.OracleDriv supported.
Note: Do not edit this er DO NOT modity this value.
attribute value.
<HOST> Enter the Hostname/ IP Y Host Name/ IP Address
Address of the system on
which you are installing the
OFSAA components.
<SETUPINFO>/ | Identifies if the value N YES or NO Default value is YES.
PREFIX specified in <SETUPINFO>/
SCHEMA _ NAME attribute should be
NAME prefixed to the schema name.
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Table L-2 <<APP PACK>>_SCHEMA_IN.XML Parameters

Tag Name/
Attribute Name

Description

Mandat

ory
(YIN)

Default Value/
Permissible Value

Comments

<SETUPINFO>/
NAME

Enter the acronym for the
type of implementation. This
information will be
displayed in the OFSAA
Home Page.

Note: On executing the
schema creator utility, this
value will be prefixed with
each schema name. For
example: dev_ofsaaconf,
uat_ofsaaatm.

Y

Accepts strings with a
minimum length of two and
maximum of four.

Example,
DEY, SIT, PROD

This name would appear in
the OFSAA Landing Page as
"Connected To: xxxx"

The schemas being created
would get this prefix. For
E.g. dev_ofsaaconf, uat
ofsaaconf etc.

<PASSWORD>/
DEFAULT*

Enter the password if you
want to set a default
password for all schemas.

Note: You also need to set
APPLYSAMEFORALL
attribute as Y to apply the
default password for all the
schemas.

The maximum length
allowed is 30 characters.
Special characters are not
allowed.

<PASSWORD>/
APPLYSAMEFO
RALL

Enter as Y if you want to
apply the password specified
in DEFAULT attribute for all
the schemas.

If you enter as N, you need
to provide individual
passwords for all schemas.

Note: In case you have
entered Y in
APPLYSAMEFORALL
attribute and also have
specified individual
passwords for all the
schemas, then the specified
individual passwords will
take precedence.

Default - N

Permissible - Y or N

Note: Setting this attribute
value is mandatory, If
DEFAULT attribute is set.

<SCHEMA>/
TYPE

The different types of
schemas that are supported
in this release are ATOMIC,
CONFIG, SANDBOX, and
ADDON.

By default, the schemas
types are seeded based on
the Application Pack.

Note: Do not edit this
attribute value.

ATOMIC/CONFIG/SANDB
OX/ADDON

Note:

SANDBOX AND ADDON
schemas are not applicable
for OFS AAAI Application
Pack.

Only One CONFIG schema
can exist in the file.

This schema identifies as the
CONFIGURATION schema
that holds the OFSAA setup
details and other metadata
information.

Multiple ATOMIC/
SANDBOX/ ADDON
schemas can exist in the file.

ATOMIC schema refers to
the Information Domain
schema. SANDBOX schema
refers to the SANDBOX
schema. ADDON schema
refers to other miscellaneous
schema (not applicable for
this Application Pack).
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Table L-2 <<APP PACK>>_SCHEMA_IN. XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<SCHEMA.>/ By default, the schemas Y The permissible length is 15 | SETUPINFO/ NAME
NAME names are seeded based on characters and only attribute value would be
the Application Pack. alphanumeric characters prefixed to the schema name
You can edit the schema allowed. No special being created.
. . characters allowed except . .
names if required. o For example, if name is set
underscore ' . , . .
Note: - as 'ofs'aaatm and setup;nfo
as 'uat' then schema being
The Schema Name will have created would be 'uat_
a prefix of the SETUPINFO/ ofsaaatm'.
NAME attribute. NAME should be same
SCHEMA NAME must be where APP_GRP=1 for all
same for all the ATOMIC SCHEMA tags (Not
Schemas of applications applicable for this
within an Application Pack. Application Pack).
<SCHEMA>/ Enter the password of the N The maximum length Note: You need to
PASSWORD* schema to be created. allowed is 30 characters. mandatorily enter the
Note: Special characters are not password if you have set the
) allowed. <PASSWORD>/
If this attribute is left blank, APPLYSAMEFORALL
then the password specified attribute as N.
in the
<PASSWORD>/DEFAULT
attribute is applied as the
Schema Password.
<SCHEMA>/ By default, the Application Y Unique Seeded Value Identifies the Application/
APP 1D ID is seeded based on the Product for which the
Application Pack. schema is being created.
Note: Do not edit this DO NOT modify this value.
attribute value.
<SCHEMA>/ Enter the available default N Default - USERS Modify this value to
DEFAULTTABL | tablespace for DB User. Permissible - A St associate any valid
ESPACE . CIIMISSIDIC = ANy eXISHng tablespace with the schema.
Note: valid tablespace name.

If this attribute is left blank,
then USERS is set as the
default tablespace.
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Table L-2 <<APP PACK>>_SCHEMA_IN.XML Parameters

Mandat
Tag Name/ ory Default Value/
Attribute Name | Description (Y/N) Permissible Value Comments
<SCHEMA>/ Enter the available N Default - TEMP Modify this value to
TEMPTABLESP | temporary tablespace for the Permissible - Any existin associate any valid
ACE DB User. . Y & tablespace with the schema.
valid temporary tablespace
Note: name.
If this attribute is left blank,
then TEMP is set as the
default tablespace.
<SCHEMA>/ Enter the quotato be seton | N Example, Modify this value to grant
QUOTA DEFAULTTABLESPACE 600M/m the specified quota on the
attribute for the schema/ mentioned tablespace to the
user. By default, the quota 20G/g user.
size is set to S00M. .
Minimum: 500M or UNLIMITED/unlimited
Unlimited on default
Tablespace
<SCHEMA>/ Enter the name of the N Permissible length is 16
INFODOM Information Domain to characters and only

associate this schema.

The schema creator utility
automatically derives an
Information Domain Name
based on the Application
Pack if no value is specified
for this attribute.

alphanumeric characters
allowed. No special
characters allowed.
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This section gives details about the OFSAATI InstallConfig.xml file.

Configuring OFSAAI_InstallConfig.xml file

To configure the OFSAATI InstallConfig.xml file, follow these steps.

1. Navigate to OFS_AAAI PACK/OFS AAI/conf/.

2. Open the file OFSAAT InstallConfig.xml in text editor.

3. Configure the OFSAATI InstallConfig.xml as mentioned in the following table:

Table M-1 OFSAA Infrastructure Installation Tasks and Descriptions

You need to manually set the InteractionVariable parameter values as mentioned in the
table. If a value is not applicable, enter NA and ensure that the value is not entered as
NULL.

InteractionVariable
Name

Significance and Expected Value

Mandator
y

<Layer name="GENERAL">

WEBAPPSERVERTYPE

Identifies the web application server on which the OFSAA Infrastructure web
components would be deployed.

The following numeric value should be set depending on the type:
»  Apache Tomcat = 1

»  IBM WebSphere Application Server =2

»  Oracle WebLogic Server =3

For example, <InteractionVariable
name="WEBAPPSERVERTYPE">3</InteractionVariable>

Yes

DBSERVER_IP

Identifies the hostname or IP address of the system on which the Database
Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable name="DBSERVER
IP">14.15.16.17</InteractionVariables> or <InteractionVariable
name="DBSERVER IP">dbhost.server.com</InteractionvVariable>

Yes

ORACLE_SID/SERVICE _
NAME

Identifies the Oracle DB Instance SID or SERVICE_ NAME

Note: The Oracle SID value should be exactly the same as it is mentioned in
JDBC_URL.

For example, <InteractionVariable name="ORACLE SID/SERVICE_
NAME">ofsaser</InteractionVariable>

Yes
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Table M-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

IMPLEMENTATION

depending on whether you intend to use the OLAP feature. The following
numeric value should be set depending on the choice:

> YES-1
» NO-0

InteractionVariable Mandator
Name Significance and Expected Value y
ABS DRIVER PATH Identifies the directory where the JDBC driver (ojdbc<versions.jar) exists. Yes
This would typically be the SORACLE HOME/jdbc/1lib
For example, <InteractionVariable name="ABS DRIVER
PATH">">/oradataé/revwb7/oracle </InteractionVariable>
Note: Refer Appendix O for identifying the correct "ojdbc<version>.jar" version
to be copied.
OLAP_SERVER Identifies if the OFSAA Infrastructure OLAP component needs to be configured |No

in.profile:

ARBORPATH, HYPERION HOME and ESSBASEPATH.

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set

SFTP_ENABLE

Identifies if the SFTP (Secure File Transfer Protocol) feature is to be enabled.
The following numeric value should be set depending on the choice:

p SFTP -1
> FTP-0

Yes

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using SFTP
instead of FTP because SFTP is considered more secure. However, a client may choose to ignore this recommendation and
to use FTP by setting SFTP_ENABLE to 0. This selection may be changed later by using the OFSAAI administration

the OFSAA Infrastructure supports only US English.

For example, <InteractionVariable name="LOCALE">en
US</InteractionVariable>

interface.

FILE TRANSFER PORT (Identifies the port used for the file transfer service. The default value specified is |Yes
22 (SFTP). Specify value as 21 or any other PORT value if value for SFTP_
ENABLE is 0.
For example, <InteractionVariable name="FILE TRANSFER
PORT">21</InteractionVariable>

LOCALE Identifies the locale information to be used during the installation. This release of |Yes

Note: The following ports are used internally by the various OFSAA Infrastructure services. The default values mentioned
are set in the installation. If you intend to specify a different value, update the parameter value accordingly and ensure this
port value is in the range of 1025 to 65535 and the respective port is enabled.

JAVAPORT 9999 Yes
NATIVEPORT 6666 Yes
AGENTPORT 6510 Yes
ICCPORT 6507 Yes
ICCNATIVEPORT 6509 Yes
OLAPPORT 10101 Yes
MSGPORT 6501 Yes
ROUTERPORT 6500 Yes
AMPORT 6505 Yes

Note: If value for HTTPS ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA and the same is
configured on your web application server.
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Table M-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable
Name

Significance and Expected Value

Mandator
y

HTTPS ENABLE

Identifies if the UI should be accessed using HTTP or HTTPS scheme. The
default value set is 0. The following numeric value should be set depending on
the choice:

> YES-1
» NO-0

For example, <InteractionVariable name="HITPS
ENABLE">0</InteractionVariable>

Yes

WEB_SERVER_IP

Identifies the HTTP Server I[P/ Hostname or Web Application Server IP/
Hostname, to be used for accessing the UI. This IP would typically be the HTTP
Server IP.

If no separate HTTP Server is available, the value should be Web Application
Server IP/Hostname.

For example, <InteractionVariable name="WEB SERVER_
IP">10.11.12.13</InteractionVariable>

or

<InteractionVariable name="WEB_SERVER
IP">myweb.server.com</InteractionVariable>

WEB_SERVER_PORT

Identifies the Web Server Port. This would typically be 80 for non SSL and 443
for SSL. If no separate HTTP Server exists, the value should be the port
configured for Web Server.

Note: The port value will not be accepted as 80 if HTTPS_ENABLE is 1 and as
443, if HTTPS_ENABLE is 0.

For example, <InteractionVariable name="WEB_SERVER
PORT">80</Interaction Variable>

CONTEXT NAME

Identifies the web application context name which will be used to built the URL
to access the OFSAA applications. The context name can be identified from a
URL as follows:

<scheme>://<host>:<port>/<context-name>/login.jsp
Sample URL: https://myweb:443/ofsaadev/login. jsp

For example, <InteractionVariable name="CONTEXT
NAME">ofsaadev</InteractionVariable>

Yes

WEBAPP_CONTEXT

PATH

Identifies the absolute path of the exploded .ear file on the web application
server.

For Tomcat, specify the Tomcat directory path till /webapps, such as
/oradataé/revwb7/tomcat /webapps/.

For WebSphere, enter the WebSphere path as <WebSphere profile
directory>/installed Apps/ <NodeCellName>. For example,
/data2/test//WebSphere/AppServer/profiles/<Profile
Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host name.

For WebLogic, provide the WebLogic home directory path as /<WebLogic home
directory paths/bea/wlserver 10.3

Note: For WebLogic, value specified for this attribute is ignored and value
provided against attribute WEBLOGIC DOMAIN HOME is considered.

Yes

WEB LOCAL PATH

Identifies the absolute path to any directory on the web application server that
can hold temporary files being uploaded as part of the applications usage.

Note: In case of a clustered deployment, ensure this path and directory is same
on all the nodes.

Yes
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Table M-1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable Mandator
Name Significance and Expected Value y
WEBLOGIC DOMAIN_(Identifies the WebLogic Domain Home. Yes
HOME For example, <InteractionVariable name="WEBLOGIC_DOMAIN \ng 1?1 Celf(};ntlhye
HOME">/home/weblogic/bea/user _ projects/domains/mydomain if
. . WEBSER
</InteractionVariable> VERTYPE
issetas 3
(WebLogic
)
OFSAAI FTPSHARE Identifies the absolute path to the directory identified as file system stage area. Yes
PATH
Note:

2 The directory should exist on the same system on which the OFSAA
Infrastructure is being installed (can be on a separate mount).

> The user mentioned in APP_SFTP_USER _ID the following parameter
should have RWX permission on the directory.

For example, <InteractionVariable name="APP_FTPSHARE
PATH">">/oradata6/revwb7/ftpshare</InteractionVariable>

OFSAAI SFTP USER ID |Identifies the user who has RWX permissions on the directory identified under Yes
the preceding parameter APP_ FTPSHARE PATH.

M-110 OFS AAAI Application Pack Installation and Configuration Guide



N

Migration for Excel Upload

This section provides detailed instructions to migrate for excel upload.

Prerequisites
The following are the prerequisites for migration.
> Data model in ATOMIC schemas should be same on the source and target setups.
> OFS AAI (platform) patch level version should be same on the source and target setups.
> PL/SQL Developer to connect and query the database.

> WinSCP to connect and access server file system.

Migration for Excel Upload
To migrate, follow these steps:

1.  Open PL/SQL Developer and logon to the source setup's configuration (CONFIG) schema
by entering the appropriate username and password.

2. Inanew SQL window, query the data of table EXCEL MAPPING MASTER.

3. Open a new session in PL/SQL developer and logon to the target setup's configuration
(CONFIG) schema by entering the appropriate username and password.

4. Insert the records from the preceding Step 1 in to this table.

5. InV_INFODOM column of EXCEL MAPPING MASTER table, update the infodom name with
the target infodom name.

Note: If all the mappings can work out of the single target Infodom, update
same Infodom value across all rows. If only few mappings will work out of
the target infodom, update the infodom value for selective records. Excel
upload mappings will work only if the target infodom has same data model
entities as used in the mappings defined on source setup.

6. Update V_CREATED BY column with the name of any user present in the target setup that
has appropriate roles to perform Excel Upload tasks.

Note: It is mandatory to update values for V_INFODOM and V_CREATED
BY columns.
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7. Open WinSCP and login a new session by entering the host name, port number, user name
and password to access the source setup.

8. Navigate to the folder referred as FTPSHARE.

9. Copy the excel-entity mapping xml file(s) which are located in this folder according to
their folder structure on to your desktop. For example: /ftpshare
/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME .xml

Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL NAME
column of EXCEL MAPPING MASTER table.

10. Copy the excel templates (.xIs/ .xIsx) file(s) which are located in this folder according to
their folder structure on to your desktop. For example:
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.x1ls or *.xlsx

Note: .xls/.xlsx files should be copied to the path as per the local path given
in your webserverinfo table of config schema. Ignore this step if files are not
present at the location.

11. Login a new session in WinSCP by entering the host name, port number, user name and
password to access the target setup.

12. Copy the xml file(s) from Step3 to the following location in the target setup. For example:
/ftpshare/STAGE/ExcelUpload/$TARGET INFODOM NAME/SEXCEL FILE NAME.xml

Note: STARGET INFODOM NAME should be target setup infodom in which
you have uploaded the appropriate data model and the name should be same
as the V_INFODOM column value updated in EXCEL_MAPPING MASTER table.

13. Copy the xIs/ xIsx file(s) from Step 3 to the following location in target setup. For
example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.
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JDBC Jar Files

The ojdbc<version>.jar file should be copied based on Database and Java version. Refer to
the following table for details.

(http://www.oracle.com/technetwork/database/enterprise-edition/jdbc-faq-090281.html#01_02)

Table O-1 JDBC Jar Files Version Details

Oracle Database
Version

JDK/JRE Version
Supported

JDBC Jar files specific to the
release

12.1 or 12¢cR1

JDK 8, JDK 7 and JDK 6

0jdbc7.jar for JDK 7/JDK 8
0jdbc6.jar for JDK 6

11.2 or 11gR2

JDK 6 & JDK 5

JDK 7 & JDK JDK 8
supported in 11.2.0.3 and
11.2.04

ojdbc6.jar for JDK 8, JDK 7 and JDK 6.
ojdbc5 jar for JDK 5
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Upgrading an Existing OFSAA 8.0.x Java 7
Instance to Java 8

This section explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7
instance to Java 8. It consists of the following topics:

> Prerequisites

> Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8§

> Web Application Server Configurations

> OFSAA Generic Configurations

> OFSAA Configurations for New Web Application Server Installation

Prerequisites
The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:

> Java 8 should be installed on the OFSAA server and Web Application Server.

> Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch
18729264 from http://support.oracle.com/ for the same.

Note: IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8
To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1. Configure Web Application Server to Java 8. For more information, refer Web Application
Server Configurations.

2. Configure the OFSAA instance to Java 8. For more information, refer OFSAA Generic
Configurations. For a newly installed Web Application Server, refer OFSAA
Configurations for New Web Application Server Installation

3. Restart the OFSAA services. For more information, refer the Start/Stop Infrastructure
Services section in Appendix D

4. Generate the application EAR/WAR file and redeploy the application onto your configured
web application server. For more information on generating and deploying EAR / WAR
file, refer Appendix C.
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Web Application Server Configurations

Web Application Server Configurations

This section describes the changes to be made in the Web Application Server. Following are the
two options to perform Web Application Server Configurations which are listed as follows:

?

?

Upgrade the existing Web Application Server installation to Java 8

Install a new instance of the Web Application Server with Java 8

This section consists of the following topics:

?

?

Oracle WebLogic Server Updates
Apache Tomcat Server Updates

Oracle WebLogic Server Updates

Perform the following configurations to upgrade the existing WebLogic server instance to Java

8:
1.
2.

Navigate to <WLS_HOME>/Middleware/Oracle Home/wlserver.

Edit the product .properties file. Set JAVA HOME, WLS_ JAVA HOME,
JAVAHOME properties to the new Java path and java.vm.version to the new Java
version. For example,

JAVA HOME=/usr/java/jrel.8.0_ 45
WLS_JAVA HOME=/usr/java/jrel.8.0 45
JAVAHOME=/usr/java/jrel.8.0 45
java.vm.version=1.8.0 45

Navigate to <WLS_HOME>/Middleware/Oracle Home/user
projects/domains/<domain>/bin. Update SUN JAVA HOME, DEFAULT
JAVA HOME, JAVA HOME in the setDomainEnv. sh file to point to the new Java
path. For example,

SUN JAVA HOME="/usr/java/jrel.8.0 45"

DEFAULT SUN_JAVA HOME="/usr/java/jrel.8.0 45"

JAVA HOME="/usr/java/jrel.8.0 45"

Clear the Application cache. Navigate to the following path and delete the files:

<Weblogic installation location>/domains/<Domain name>/servers/<Server
name>/tmp/ WL user/<Application name>/qaelce/jsp servlet

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps:

1.
2.

Install Oracle WebLogic Server 12.1.3.x on Java 8.

Perform the configurations for the newly installed WebLogic server. For more information
refer Configuring Resource Reference in Weblogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be set
same as that of the existing Domain.

Note down the new Domain path to perform OFSAA Configurations.
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Apache Tomcat Server Updates

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java
7 to Java §:

1. Login to the Apache Tomcat Server as a non-root user.

2. Editthe user .profile. Update the value for JAVA HOME from JRE 1.7 to JRE 1.8. For
Example,

JAVA HOME=/usr/java/jrel.8.0 45
3. Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application
name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:
1. Install Apache Tomcat Server 8 with Java 8.

2. Perform the configurations for the newly installed Tomcat server. For more information
refer Configuring Resource Reference in Tomcat Application Server.

Note: Update the Connector Port in
/apache-tomcat-8.0.21/conf/server.xml file to that of the
existing Tomcat instance.

Note down the new deployment path to perform OFSAA Configurations.

OFSAA Generic Configurations
This section consists of the following topics:
> User .profile Settings

> Configurations for Java 8

User .profile Settings

Perform the following configurations:
1. Login to the OFSAA Server as a non-root user.

2. Editthe user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8.
For Example,

PATH=/usr/java/jrel.8.0 45/jre
JAVA BIN=/usr/java/jrel.8.0 45/jre/bin

LD LIBRARY PATH=$LD LIBRARY PATH:/usr/java/jrel.8.0
45/9jre/lib/amd64/server

Configurations for Java 8

Perform the configurations explained in the section Configurations for Java 8
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OFSAA Configurations for New Web Application Server

Installation

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or
Apache Tomcat Server 8.0. Follow these steps:

1.

Modify the following parameters in the Configuration table present in the Config Schema
with the new Domain Path in case of WebLogic or with the new deployment path in case
of Tomcat:

» DeFiHome

»  REV_IMG_PATH

»  EMBEDDED JSP_JS PATH

Login to the OFSAA Server as a non-root user.

Navigate to SFIC_HOME/ficweb/webroot/WEB INF and update the following
parameters in the web . xml file with the new Domain path in case of WebLogic or with
the new deployment path in case of Tomcat:

? FIC PHYSICAL HOME LOC
? FIC HOME

»  ICC_SERVLET LOG_FILE

Navigate to SFIC_HOME/ficweb/webroot/conf and update the Domain path in
case of WebLogic or with the new deployment path in case of Tomcat:

»  OFSAALogger.xml

»  MDBLogger.xml

»  RevLog4jConfig.xml

»  RFDLogger.xml

»  ExportLog4jConfig.xml
»  RFDLogger.xml

? PR2Logger.xml
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Removing OFSAA

This chapter includes the following sections:
> Uninstalling OFSAA Infrastructure

> Uninstalling EAR Files in WebSphere

> Uninstalling EAR Files in WebLogic

> Uninstalling WAR Files in Tomcat

Uninstalling OFSAA Infrastructure

This section will guide you through the necessary steps to uninstall the OFSAA Infrastructure
product.

Before you start the uninstallation process, ensure that no open connections exist to the OFSAA
Infrastructure Config and Atomic Schemas and Infrastructure services are brought down.

To uninstall OFSAA Infrastructure:

1. Log in to the system as non-root user.

2. Navigate to the SFIC_ HOME directory and execute the command:
./Uninstall.sh

3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the
following figure.

Figure 5-26 Uninstalling OFSAA Infrastructure

zcratch/of zaadb/UFSAAL: , ninstall, zh
Uhinstallation Started [time 3 Tue Jun 10 14:20:27 ST 2014 1

ek Driver loaded with Driver oracle, jdbc.driver,Oraclellriver

Pleaze enter Configuration schema Pazzword ¢

Connected to Config Schema

Cleaning config schema ...

config schema cleaned ...

Cleaning up Infrastructure Home Dir |

Fleaze wait ..

Uninztallation Completed | Thank You [time ¢ Tue Jun 10 14:21:53 IST 2014 1

#scratoh/of zaadb/0FSRAT I
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Note:

> Uninstallation does not remove the Infrastructure application from the
Web Application Server. This has to be done manually.

> The entries in the .orofile file will have to be removed manually.

> The files/ folders under the file system staging area (ftpshare) have to be
deleted manually.

> All the Database objects from Atomic Schemas have to be dropped
manually.

Uninstalling EAR Files in WebSphere

Following are the steps to uninstall any previously deployed application:

1.  Open the URL in the browser window: http://<ipaddress>:<Administrative
Console Port>/ibm/console (https if SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand Applications > Application Types > WebSphere enterprise applications from the
LHS. The Enterprise Applications window is displayed with all the deployed applications.

Figure 5-27 Enterprise Applications

Enterprise Applications ?

Enterprise Applications

Use this page to manage installed applications. A single application tan be deployed onte multiple servers.

[ Preferences
Stare | | Stop [nstaJl| Uningtzll Updata Rellout Update Rameve File | Exuon[ Expart DDL Expert Filz
R
2R
Select| Name o Application Status ()

You can administer the following resources:

[] | Refaultzpolication Y

O | itage |
. = = S
o [ =
: Total 4 -

4. Sclect the checkbox adjacent to the application to be uninstalled and click Stop.
5. Click Uninstall. The Uninstall Application window is displayed.

Figure 5-28 Uninstall Application

Chck OK to remave the following apphcaton(s). If you do not want 1o remove the apphcations, chck Cancel to retum
to the previous page

Name
ADIGAST

Cancel
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6.
7.

Uninstalling EAR Files in WebLogic

Click OK to confirm.

Click Save to save the master file configuration.

On the machine that hosts WebLogic, perform the following steps to uninstall any previously
deployed application:

1.

Open the URL in the browser window: http://<ipaddress>:<admin server
port>/console (https if SSL is enabled). The Login window of the WebLogic Server

Administration Console is displayed.

Login with the WebLogic user credentials having administrator privileges.

From the Domain Structure LHS menu, click Deployments. The Summary of

Deployments window is displayed.

Figure 5-29 Summary of Deployments

Summary of Deployments

Control | Monitoring

W Customize this table

Deployments

This page displays a list of Java EE applicat
(redeployed), or deleted from the domain by first selecting the application name and using o

5 arvd stand-slone apphication madul

To install 8 new appication or medule for deployment to targets in this domain, dick the Install button.

install | | Update | Delate |S:a.'1v Slop >

have been instaled to this domain, Instaled applications and modules can be started, stopped, updated
NE Contross on this page.

Showing 1to 10f 1 Previous | MNext

Hame &

When work compietes

Farce Stop Now

State

Health

Type

Deployment Order

# [ Aupg7273

Stop, but continue servidng administration nequests

Enterprise Application

100

Install | | Update | Dejate |S:ar‘.v Slop v

Showing 1to 1of 1 Previous | MNext

4.

5.

Select the checkbox adjacent to the application to be uninstalled and click Stop> Force

Stop Now.

Click Yes in the confirmation dialog to stop the selected deployment.
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Figure 5-30 Summary of Deployments- Messages

Messages

o Salected Deplayments have besn requasted to stop
Summary of Deployments

Control | Manitarng

This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain. Installed applications and modules can be started, stopped, updated
{redepioyed), or deleted from the domain by first selec e applcation name and using the controls on this page.

To install 3 new applcation or module for deployment to targets in this domain, dick the Install button,

W Customize this table

Deployments

| dnstad | Showing 1to 1of 1 Pravious | MNaxt
1 | name & State Health Type Deployment Order
0 | @ Pugrzr Brepared Y ox Enterprise Appicaton 100

Showing 1 %0 1of 1 Previous | Next

6. Select the checkbox adjacent to the application and click Delete to delete the selected
deployment.

7. Click Yes in the confirmation dialog to remove the selected deployment from the domain
configuration.

Uninstalling WAR Files in Tomcat

On the machine that hosts Tomcat, perform the following steps to uninstall any previously
deployed application:

1. Comment out Context path section from server.xml file in SCATALINA HOME/conf
directory to avoid conflict during undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:
<l--

<Context path ="/pr2test"
docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" debug="0"
reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/PR2ATM"

type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="pr2atm"

password="pr2atm"
url="jdbc:oracle:thin:@10.184.74.99:1521 :PERFTEST"
maxTotal="100"

maxIdle="30"

maxWaitMillis="10000"/>

</Context>
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-=>

Restart the Tomcat service by doing the following:

d. Login to the "Unix server" through a terminal emulator.

e. Navigate to $catalina home/bin directory.

f.  Stop the tomcat services using the command . /shutdown.sh

g. Start the tomcat services using the command . /startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server port>.
(https if SSL is enabled). The Tomcat home window is displayed.

3. Click the Manager App. The Connect to window is displayed.

4. Login with the user credentials having admin rights. The Tomcat Web Application Manager
window is displayed with the list of all applications deployed in Tomcat.

Figure 5-31 Tomcat Web Application Manager

8 e "*Apache

Software Foundation
http://www.apache.org/

Tomcat Web Application Manager

Path Display Name

Vieicome to Temcat

Hask Tomcal Dacumentation
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Pl Tal 1158 Tomeat Manager Appication
| totsnait Reveleus web Appbcation

Running
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Sessions

Commands
San Stoo Reioad Undeplowv

Expire sessions with e 230

Start Sigo Bsigad Lodeploy

im0

Start Stoo Beload Undepioy

Stant S0 Balesd Undegkey

[Eoore sormoms ] war a1

Stan Siop Rweiond Undeploy

Expire sessions wean e 230
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minutes

minutes
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minutes

5. Click the Undeploy link against the deployed Infrastructure application. A confirmation
message is displayed on the application /Infrastructure being uninstalled.
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FAQs and Error Dictionary

This section of the document consists of resolution to the frequently asked questions and error
codes noticed during OFSAALI installation.

> Frequently Asked Questions
> Error Dictionary

OFSAALI installer performs all the pre-requisite validation check during installation. Any errors
encountered in the process is displayed with an appropriate Error Code. You can refer to the
Error Dictionary to find the exact cause and resolution to rectify the error.

Frequently Asked Questions

You can refer to the Frequently Asked Questions which has been developed with the interest to
help you resolve some of the OFSAALI Installation and configuration issues. This intends to
share the knowledge of problem resolution to a few of the known issues. This is not an official
support document and just attempts to share the knowledge of problem resolution to a few of
the known issues.

This section includes the following topics:
» OFSAAIFAQs
> Application Pack 8.0.0.0.0 FAQs

> Forms Framework FAQs
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Frequently Asked Questions

OFSAAI FAQs

What are the different components that get installed during OFSAAI?

The different components of OFSAALI are illustrated in Figure 1-2, "Components of OFSAAI".
What are the different modes of OFSAAI installation?

OFSAAI can be installed in two modes, Silent Mode, and GUI mode.
Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier.
By default, they will be installed on single-tier. However, OFSAA Infrastructure can be
deployed within the n-Tier architecture where the Database, Web Server and Web Application
Server is installed on separate tiers.

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be uninstalled after
OFSAA installation?

JDK is not required during installation of OFSAA and only a run time is needed. For details,
see Hardware and Software Requirements, Java Runtime Environment section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA and cannot be
uninstalled as the JRE is used by the OFSAA system to work.

How do I know what are the Operating system, webservers and other software versions that
OFSAA supports?

Refer to OFSAA Technology Stack Matrices.
What are the different files required to install OFSAAI?

The following files are required:

> setup.sh.

> envCheck.sh

> preinstallcheck.sh

> Verlnfo.txt

> OFSAAlnfrastructure.bin

> validatedXMLinputs.jar

> MyResources_en_US.properties

> logdj.xml

> OFSAAI PostlnstallConfig.xml

> OFSAAI InstallConfig.xml

> privileges_config user.sql

> privileges atomic user.sql

What should I do if I get the following error message during installation: "Execute
Permission denied"?

Check whether all the files provided for OFSAALI installation has execute permissions.
To give execute permissions,
» Navigate to the path OFSAAT 80000 and execute the command
chmod 755
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"Graphical installers are not.."

If error resembles "Graphical installers are not supported by the VM. The console mode
will be used instead..." then check whether any of the X-windows software has been
installed.

Example: Hummingbird Exceed is started and configured to Graphical mode
installation.

Note: Type 'xclock' from prompt and this should display clock in
graphical mode.

""No Java virtual machine could be..."

If the error message reads "No Java virtual machine could be found from your PATH
environment variable. You must install a VM prior to running this program", then

> Check whether "java path" is set in PATH variable. See the Table 3—1, " Prerequisite
Information"section in this document.

> Check whether sufficient temporary space is available.

> Ensure that the movement of OFSAALI Installer text files to the target system is done
in the Text mode so that setup. sh file does not contain control line feed characters
("M).

What should I do if I get the following error message during installation, ""OracleDriver Files Not
Found, Please Choose the Right Path To Continue''?

Check whether the provided path for Oracle Driver files is correct and whether the user has
permissions to access the files.

What should I do if I get the following error message during installation, ""User must have
CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE
SEQUENCE, CREATE PROCEDURE'" even though the oracle schema user created has the
mentioned privileges?

OFSAALI installer validates the database details provided during installation, so ensure:

> Whether the oracle schema user has the required set of privileges for successful
installation.

> Whether the oracle schema user has been created with quota privileges on tablespace
to create database objects.

See the Table 3—1, " Prerequisite Information"section in this document.
Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAALI installation, one has to perform the Post Installation
steps. See Chapter 5, "Post Installation Configuration".

What is to be done when OFSAAI Installation is unsuccessful?

OFSAAI installer generates log file OFSAAInfrastructure Install.log inthe
Infrastructure Installation Directory. There is also another log file created in the path configured
in Log47j.xml. If the logs of any of these reported Warnings/Non Fatal Errors/Fatal
Errors/Exceptions, they should be brought to the notice of the Oracle Support Services. It is
recommended not to proceed, until the reported problems are adequately addressed.

How do I completely uninstall OFSAAI?
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OFSAALI can be completely uninstalled by performing the steps provided in Uninstalling
OFSAA Infrastructure section in this guide.

Can OFSAAI config and atomic schemas be on different databases?
OFSAALI requires both config and atomic schemas to be present on the same database instance.
How do I grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database
permissions) to the new Atomic schema.

> Log into the database as sys and connect as sysdba user.

»  Execute the file privileges config user.sql available under SFIC_HOME
directory

> Enter the database schema for which you want to grant privileges.
When should I run the MLS utility?

See the Multiple Language Support (MLS) Utility section in OFS AAI Administration
Guide available on OHC Documentation Library.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAALI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and
above.

What should I do if I get the following error message on the UNIX System terminal while
executing ./setup.sh, "Insert New Media. Please insert Diskl or type its location''?

1. Login as root user on the Unix machine where OFSAALI is getting installed.

2. Navigate to the path /etc/security/.

3. Edit the file 1imits.conf to add/edit a row for the unix user installing OFSAA:
<Unix User> soft nofile 9216

4. After saving the changes, log in as unix user with which OFSAALI is getting installed
and execute the command:

ulimit -n
The command should return the value 9216.
How do I verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the installation,
a Pre-Install Check utility is available within the Install Kit archive file. This utility can
also be obtained separately by contacting Oracle Support.

See Verifying System Environment section for additional information.
How do I know if the installation is completed successfully?

The OFSAA Infrastructure installation performs a post install health check automatically
on successful installation of the product. To rerun the post install verification at a later
time, perform the following steps:

1. Navigate to the path SFIC_HOME (Product Installation Directory).
2. Execute the command:
./piverify.sh

What should I do if the installation in GUI mode is not invoked?
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There are set of configuration steps required to be performed during the installation in
GUI mode. Verify whether the steps mentioned under Configuration for GUI Mode
Installation section are done correctly.

What should I do if there are any exceptions or errors in installation and how to proceed?
1. Please backup the installation logs.
2. Share the backup logs with Oracle support.

What should I do if I get the following error message during OFSAAI installation on Solaris 11
system?:

"Error: OFSAAI-1108

ORA-00604: error occurred at recursive SQL level 1
ORA-01882: timezone region not found"

Or

"Time zone cannot be set as null or 'localtime’ "'

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set the
environment variable TZ to a valid time zone region in the .profile file. For example,

TZ=Asia/Calcutta
export TZ
What should I do if the installation process is abruptly terminated or aborted?

If the installation process is abruptly terminated, then the installation will be incomplete. To
recover from this, follow these steps:

1. Drop the DB objects in the config schema created by OFSAALI installation.

2, Open the .profile and remove the entries made by the OFSAALI installation which are
made between the comment statements, #Beginning of entries by OFSAA Infrastructure
installation and #End of entries by OFSAA Infrastructure installation.

3. Delete the OFSAA install directory created by the OFSAAI installer.
4. Perform the OFSAALI installation again.

Does OFSAA support any other web server types, other than the ones stated in Tech Matrix and
Installation Guide?

No, all the supported softwares and versions are stated in the OFSAA Technology Stack Matrices.

What should I do if the database connection from connection pool displays the following error
message, "java.sql.SQLRecoverableException: 10 Error: Connection reset'?

This happens while running several database intensive tasks in parallel. To correct this error, add
the line securerandom. source=file:/dev/./urandomin the java.security configuration
file available in SJAVA HOME/jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where the
OFSAAI components are installed.

If the issue is not resolved even with the preceding settings, check the MTU(Maximum
Transmission Unit) settings on the linux box. For details on MTU settings and updating them,
contact your system Administrator.
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What should I do when I get syntax errors/file not found error messages while invoking setup.sh file
from my install archive?

This could mostly happen:
> When installer was not unzipped rightly or corrupted during unzip.

> setup.sh file which resides within the install archive was not transferred in ASCII or
text mode, which could have corrupted the file.

To correct this, follow the steps:

1. Copy the installer (in BINARY mode) to the system on which the OFSAA
Infrastructure components will be installed.

2. Unzip the installer using the command:
unzip <OFSAAI Installer>.zip

3. The corrupted setup. sh file would have introduced certain “M characters into the
file. You can remove "M characters from setup.sh file by following these steps:

a. Login to the server where the installer is copied.
b. Navigate to the directory OFSAAI 80000.
c. Open the setup.sh file in the vi editor using the command: vi setup.sh.

d. Inside vi editor in Esc mode, type: %s/*M//g

Note: To enter “M, hold the CTRL key then press V and M in succession.

e. Save the setup. sh file by typing: wq!
Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a standard
or enterprise edition. So, OFSAAI will work with standard edition as well.

We do not recommend standard edition because it will not scale and does not support
partition pack, database security vault, or advanced analytics.

What should I do if I get the following error message while executing ./startofsaai.sh file on
the UNIX System terminal "./startofsaai.sh: /java: Execute permission denied'?

> Ensure JAVA BIN environment variable path is set on the "unix user" terminal from
where the startofsaai.sh file is invoked.

> Ensure the .profile where the environment/ path settings are made has been
executed successfully.

What should I do if the OFSAAI Application Server does not proceed even after providing
the system password?

Ensure that the System Password provided when prompted, should match with the "Oracle
Configuration Password" provided during installation. Also check whether the connection
to the "configuration schema" can be established through sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers are
started, and the application URL is accessed, it gives an error message ''the page cannot be
found or displayed' or "Could not retrieve list of languages from Server. Please contact the
system administrator''. What should one do?
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Ensure OFSAALI servers have been started and are running successfully. For details on start
up parameters options, see Starting Infrastructure Services section.

For more details on the issue, refer to the Revappserver log in SFIC_APP
HOME/common/FICServer/logs directory or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before
installation? If yes, can it be revoked after completing the installation?

The "Oracle schema" user requires the necessary grants specified before, during, and after
the installation process. Grants provided should never be revoked as the application makes
use of these grants all the time.

Can we have distributed OFSAAI Application Server for load balancing?

OFSAALI Application server can be scaled out/distributed across different JVM's
(machines) based on the various services and Information Domains, in other words, Load
balancing could be achieved with distribution of services.

Why do we need FTPSHARE on all the layers? Can we have ftpshare on another machine
other than the machines where OFSAAI is installed?

FTPSHARE is a Metadata Repository directory. All the metadata related files used in
Infrastructure are stored in the FTPSHARE directory. The ftpshare contains folders for
each Information Domain, with each Information Domain folders holding Erwin, log, and
scripts folder. The transfer of data among the Web, Application, and Database servers in
Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers by
providing App server's FTP/SFTP credentials to the Web server and DB server users.

Yes, you can have FTPSHARE on another machine other than the machines where
OFSAALI is installed.

Is it mandatory to provide the FTP/SFTP password?

Yes, OFSAAI needs credentials of the user who has complete permissions on FTPSHARE
directory, and the user should be able to independently login to the unix server.

What are the permissions required for FTPSHARE and when should I give them?

It is recommended to provide permissions on FTPSHARE in case of installations done
across different machines or VMs (multitier installation).

In case of single tier installation, 770 permissions can be provided if the Unix users of
OFSAALI and web server belong to the same Unix group.

Additionally, any new file that is created in the FTPSHARE folder of any installation layer
should be granted specific/explicit permission.

Port Change utility can be used to have the Port number modified, which are currently
being used by the Infrastructure application. For more information, refer Changing IP/
Hostname, Ports, Deployed Paths of the OFSAA Instance section in OFS Analytical
Applications Infrastructure Administration User Guide in OHC Documentation Library.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup
OFSAAL

> SYSADMN
> SYSAUTH
> GUEST
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Does OFSAAI Application support both FTP and SFTP?
OFSAALI supports both FTP and SFTP configuration.
Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards using the
OFSAAL

OFSAAI Configuration: Unable to save the server details?
> Ensure the input User ID, Password, and Share Name are correct.
> Ensure FTP/SFTP services are enabled.
> Have a test FTP/SFTP connection made and confirm if they are successful.

What should I do if I get the following message while creating Information Domain, "'Please
create a database and then create the information domain''?

Information Domain is mapped to only one Database; and thus before the creation of
Information Domain, at least one database details should exist.

What should I do if I get the following message during the startup of backend engine
message server, ""ConnectToDatabase: FatalError, could not connect to the DB server''?

> Verify whether connection to the Configuration Schema can be established through
SQL*PLUS.

> Verify Configuration Schema password is modified post installation.

2 Ensure Oracle Database Alias Name created for Oracle Instance and Oracle Service
Name are same.

2 On a multi tier installation mode, ensure TNSNAME and SID are same in both the
Application and Database Layers.

What should I do if I get the following message during the startup of backend engine
message server, ""Fatal Error, failed to get user ID from LibSmsConnect"'?

Ensure Reveleus.sec file exist under the SFIC_HOME/conf directory where the Database
components are installed.

Does OFSAAI Application support LDAP authentication?
OFSAALI supports LDAP configuration and authentication.
Does OFSAAI support multiple languages?
Yes, OFSAALI supports multiple languages.
Does OFSAAI provide any data back-up features?

OFSAALI does not have built-in back up facility. External Storage Infrastructure is
recommended for back-up.

What kind of security features does the OFSAAI provide?
OFSAALI provides security at:
> Segment Level - Users can access only the segment they are mapped to.

> Application Level - Users can perform an operation only if mapped to appropriate role
and functions.

Does OFSAAI have the ability to enforce periodic password change?
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OFSAALI provides configurable parameters to define number of days after which the user
password would expire and then the user is forced to change the password after expiration
period.

What is the password policy followed in OFSAAI?

OFSAALI enforces a minimum password length with a combination of Upper and Lower
case characters and alpha-numeric strings.

Which version of Erwin Data Modeller does OFSAAI support?

OFSAAI now supports ERwin version 9.2 and 9.5 generated xmls in addition to ERwin
4.1, ERwin 7.1, ERwin 7.3 and ERwin 9.0 formats.

Does OFSAAI provide the mechanism to upload Business Data model?
OFSAALI provides two mechanisms for business data model upload:

> Easy to use GUI based Model upload mechanism to upload the Business Data Model
through Data Model Management -->Data Model Maintenance --> Import Model.

> OFSAAI also provides a model upload utility "upload. sh" for uploading the business
data model through the command line parameter by executing this shell script file
under the path <FIC_HOME>/ficapp/common/FICServer/bin.

For mor details, see Configuration for Model Upload Utility section of the OFS Analytical
Applications Infrastructure User Guide available on OHC Documentation Library.

How do I apply incremental change to the existing model when the Business Data model
undergoes a change?

Modified data model can be uploaded into the system and OFSAALI has the ability to
compare the changes within the data model with respect to the one already present in the
system and enables propagation of incremental changes in a consistent manner.

What are the different types of uploading a business data Model?

OFSAALI supports uploading of business data model from client desktop and also by
picking up the data model from the server location.

Can the OFSAAI Configuration Schema password be modified post installation?

The OFSAAI Configuration Schema password can be modified post installation. OFSAAI
application stores the password in the database and few configuration files, thus any
changes to the Configuration Schema password will require updating in those files.
Contact Oracle Support Services for more details.

Can the OFSAAI Atomic Schema password be modified?

The OFSAAI Atomic Schema password can be modified. OFSAALI application stores the
atomic schema password in the database and few configuration files, thus any change to
the atomic schema password will require updating those files.

To change the Atomic Schema password, follow the steps:
1. Login to OFSAA.

2. Navigate to System Configuration > Database Details window. Select the appropriate
connection, provide the modified password and save.

3. Navigate to Data Management Tools> Data Sources. Update the appropriate Source
details.

4. Based on the Web Server installed, follow the steps:

a. Ifyou are using Apache as Web server:
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*  Update the <Context> -> Resource tag details in server.xml file from the
SCATALINA HOME/conf folder. (In case of Tomcat only Atomic <Resource> will
exist).

b. If you are using WebSphere as Web server:
*  Login to the WebSphere Administration Console from the left side menu.

*  Navigate to Resources >JDBC >Data Sources. A list of data sources will be
populated on the right side.

*  Select the appropriate Data Source and edit the connection details. (In this case,
both Config and Atomic data sources need to be modified).

c. Ifyou are using WebLogic as Web server:
*  Login to the WebLogic Administration Console from the left side menu.

Under Domain Structure list box, expand the appropriate Domain and navigate to
Services > JDBC >Data Sources. A list of data sources will be populated on the
right side.

*  Select the appropriate Data Source and edit the connection details. (In this case,
both Config and Atomic data sources need to be modified).

5. Restart the OFSAALI services

Note: If the modified passwords are not updated, OFSAAI logs displays
the message ORA-28000: the account is locked.

Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory settings on the
client and server machines. Java memory setting varies with the data model size and the
available RAM. Contact Oracle Support Services for more details.

Why do the Business Metadata Management screens (Business Processors screen) in the
User Interface, take more time to load than other screens?

The Log file in DynamicServices.xml which resides in $SFIC_HOME/conf is
continuously being updated/refreshed to cache metadata. This can be observed when you
are starting startofsaai.sh and if any of the log file (For example, SMSService.log) in
DynamicServices.xml is being continuously refreshed for longer time.

By default, the Metadata Log file cache size is set to 1000. If in case the log is being
updated beyond this limit, retrospectively the preceding entries are overwritten. For
example, the 1001th entry is overwritten by deleting the first entry. This results in the
application window taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC HOME>/conf,
depending on the currently logged count for the specific metadata.

1. Generate the Log report by executing the following query in config schema.
select count(l), t.metadata name, m.dsn id
from metadata master m, metadata type master t
where m.metadata type = t.metadata type
group by t.metadata name, m.dsn_id

2. The preceding query returns a list of codes with their respective metadata count. You
can refer to "metadata_type master" table to identify the metadata name.
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3. View the log report to identify the metadata which is being updated/refreshed beyond
the specified cache size limit. Accordingly increase the cache size limit in
Dynamicservices.xml depending on the currently logged count for the specific
metadata.

For example, if the "MEASURE CACHE_SIZE" is set to 1000 and total measure
reported in log is 1022, increase the limit to 2000 (approximately).

4. Restart Reveleus/OFSAALI servers (Web and APP) and check the issue.

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere
application server?

The Java memory needs to be increased in ejbdeploy. sh file which is present under
<WebSphere Install directory>/AppServer/deploytool/itp. For example,

$JAVA CMD \
-Xbootclasspath/a:Sejbd bootpath \
Xms256m -Xmx1024m \
What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB from OFSAAI Data Model
Management -->Data Model Maintenance--> Import Model, you need to configure the
required model size in struts.xml file available in the path SFIC WEB

HOME /webroot /WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can
approximately set the max size to 3GB (3221225472 bytes) as follows, in order to avoid
size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and redeploy
the application onto your configured web application server. For more information on
generating and deploying EAR / WAR file, refer Appendix C.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes to the
underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying
Hierarchy has been changed. This can occur in hierarchy maintenance, where you have
moved a member to another hierarchy branch, and that member was explicitly selected in
the Filter and is now a child of a node which is already selected in the Filter. Refer Support
Note for the workaround.

Can I install an Application Pack on an existing Atomic schema/ Information Domain
created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information
Domain created manually. Application Packs can be installed only on Atomic
Schemas/Information Domain created using schema creator utility and/ or the Application
Pack installer.

What should I do if I get the following exception while trying to view the model outputs in
Model Outputs screen, ""Exception ->Local Path/STAGE/Output file name (No such file or
directory)''?
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Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the
web server details window. This folder needs to be created under the local path on every
node,in case of web application server clustering.

What should I do if I get the following exception during OFSAA services startup, "Exception
in thread "main" java.lang.UnsatisfiedLinkError: net (Not a directory)'?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to
point to a physical JRE installed.

What is the optimized memory settings required for "New'' model upload?
The following table lists the optimized memory settings required for "New" model
upload.

Table R-1 Optimized Memory Settings for New Model Upload

X_ARGS_APP ENV
Size of Data Model Variable in OFSAAI
Model Upload Options XML File APP Layer

Pick from Server 106 MB "-Xms1024m
-Xmx1024m

36 MB "-Xms2048m
-Xmx2048m

815 MB "-Xms4096m
-Xmx4096m

1243 MB "-Xms6144m
-Xmx6144m

Model Upload Utility 106 MB "-Xms1024m
-Xmx1024m"-Xms2048m
-Xmx2048m

336 MB "-Xms4096m
-Xmx4096m

815 MB "-Xms4096m
-Xmx4096m

1243 MB "-Xms6144m
-Xmx6144m

Save New Erwin File In 106 MB "-Xms1024m
Server -Xmx1024m

336 MB "-Xms2048m
-Xmx2048m

"-Xms4096m
-Xmx4096m

"-Xms6144m
-Xmx6144m

What should I do if I get the following error message, "ORA 01792 maximum number of
columns in a table or view is 1000 during T2T execution"'?

You should apply the following patch set from Oracle. Applicable only for 12c.
https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1

1 did not enable OFS Inline Processing Engine Application license during the installation.
However, I have enabled it post installation, using the Manage OFSAA Product License(s) in
the Admin Ul Are there any other additional configurations that I need to do?
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Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration
Guide available on OHC Documentation Library.

1 get an error when I try to build an Oracle OLAP cube. What should I do?

Execute the following grant on the appropriate ATOMIC schema
grant olap user to &database username

How do you turn off unused Information Domains (Infodoms) from caching?
Follow these steps to turn off unused infodoms from caching:

Navigate to $SFIC_HOME/conf in the APP layer of your OFSAALI installation.

-

In the DynamicServices.xml file, identify the section for <Service code="20">.

Modify the value of parameter CACHE _ON_STARTUP to 0 (default is 1).

P w N

Repeat the same in the WEB layer too. Generate the application EAR/WAR file and
redeploy the application onto your configured web application server. For more
information on generating and deploying EAR / WAR file, refer Appendix C.

5. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Start
OFSAA Infrastructure Services section.

Note: This setting will cache the Infodom metadata only for the infodoms
that get accessed upon user login. Infodoms which do not get accessed, will
not be cached.

Sample code is as follows:

<SERVICE CODE="20"
CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"
SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS>

<PARAMETER NAME="CACHE ON_ STARTUP" VALUE="0" />

<PARAMETER NAME="BACKUP XML" VALUE="1" />

<PARAMETER NAME="MAX BACKUP XML" VALUE="2" />

<PARAMETER NAME="PC NONBI BI SWITCH" VALUE="2048" />

<PARAMETER NAME="HIERARCHY NODE LIMIT" VALUE="2000" />

<PARAMETER NAME="ALIAS CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="DATASET CACHE SIZE" VALUE="2000" />

<PARAMETER NAME="MEASURE CACHE SIZE" VALUE="2000" />

<PARAMETER NAME="HIERARCHY CACHE SIZE" VALUE="2000" />

<PARAMETER NAME="DIMENSION CACHE SIZE" VALUE="2000" />

<PARAMETER NAME="HIERARCHYATTRIBUTE CACHE SIZE" VALUE="1000" />
<PARAMETER NAME="CUBE CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="RDM CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="BUSINESSPROCESSOR CACHE SIZE" VALUE="2000" />

<PARAMETER NAME="DERIVEDENTITY CACHE SIZE" VALUE="1000" />
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<PARAMETER NAME="LOG_GET METADATA" VALUE="false" />
<PARAMETER NAME="METADATA PARALLEL CACHING" VALUE="0" />
</PARAMETERS>

</SERVICE>

While creating an Excel Mapping, after specifying the excel worksheet, the target table, and
mapping each column in the worksheet to a target table, I click Save and nothing happens.
But when I click Cancel, a message pops up informing me that all changes will be
discarded", what is to be done.

Check if the version of Internet Explorer and JRE Plugin are as mentioned in the
Desktop Requirements section of this manual. If not, use the qualified versions as
mentioned.

Can multiple OFSAA Infrastructure instances share the same Config Schema?
No, only one OFSAA environment can be installed using one Config Schema.
Can Atomic Schema be shared?
Yes, it can be shared between two OFSAA instances.

While setting a firewall, which ports should be opened for communication between the Web
Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the Web
Application Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate properly?

The OFSAA Servlet port which is same as Web server port should be open. Also the web
application port should be open.

Can I modify the NLS LENGTH_SEMANTICS to BYTE from CHAR for the Database
where older versions of OFSAA is Installed?

Yes, NLS LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not
intending to use multi language support.

Can I install already installed application in a different infodom?
No, it is not possible to install the same application in two different infodoms.
How can I configure the OFSAA application for High Availability?

OFSAA can have active-passive high availability. For more details, refer Configuration for
High Availability- Best Practices Guide.

During OFSAA installation should I provide web application server's IP /Hostname and port
or web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle HTTP Server/
IBM HTTP Server are configured?

In case the web server is configured, you should enter the Web Server IP
Address/Hostname and Port details during OFSAA installation. Here the Servlet port
should be same as the Web Server port. If Web Server is not configured, the Web
Application Server's IP Address/ Hostname and Port is required during the installation
process. Here the Servlet port should be same as the Web application Server port.

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.0.0.0 and higher versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is
a change in the way agentservers are managed through AGENTSTARTUP. SH and
AGENTSHUTDOWN. SH.

What should I do when the message server process does not open and I get the following error
message, ""CI18NProvider::CI18NProvider, Error, unable to connect to the config database''?

This error is displayed due to the following reasons:
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> The Config Schema password is already expired.

> If the Config Schema password is going to expire soon and the message
like "ORA-28002: the password will expire within 6 days" displays while connecting to
Config Schema through SQLPlus.

> The Config Schema password is modified.

To resolve the error, re-set the Config Schema password to the old password. Else, if the Config
Schema password is modified to something else then follow these steps:

1. Delete the SFIC_HOME/conf/Reveleus.SEC file.

2. Shutdown the OFSAAI App service: cd S$SFIC_APP
HOME/common/FICServer/bin ./stopofsaai.sh

3. Shutdown the OFSAAI App service: cd SFIC_ APP
HOME/common/FICServer/bin ./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through XWindows
software using the command: . /startofsaai.sh

5. Enter System Password.

6. Enter the new Config schema password. The service starts and initializes if it is able to
successfully connect to the DB and generates the Reveleus. SEC file.

7. Post successful startup of the service, if required, the Infrastructure server may be shut
down and restarted in the background using nohup mode.

What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under SFIC_APP HOME/common/FICServer/logs &
<OFSAAI DEPLOYED AREA>/<CONTEXT.war>/logs is configurable in
RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to 5000kb and number of maximum
backup log files (MaxBackupIndex) retained is set to 5, both of which are configurable.
Increasing these parameters to a higher value should depend on the server hardware
configurations and may reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:
1. Navigate to SFIC_HOME/conf where OFSAA is installed.
2. Edit the following parameters in the file RevLog4jConfig.xml
> param name="file" : Enter the path where the Logs are to be generated.
> param name="MaxFileSize" : Provide the required file size.

> param name="MaxBackupIndex" : Provide the required number of backup files to be
created.

Example:

<appender name="REVSERVERAPPENDER"
class="org.apache.log4j.RollingFileAppender">

<param name="file" value="$FIC_
HOME/ficapp/common/FICServer/logs/RevAppserver.log"/>

<param name="Append" value="true" />
<param name="MaxFileSize" value="5000kb" />
<param name="MaxBackupIndex" value="5" />

<layout class="org.apache.log4j.PatternLayout">
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<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>

</layout>

</appender>

To configure the Deployed area logs file, follow these steps:

1.
2,

Navigate to <EAR/WAR Deploy area>/conf folder.

Repeat step 2 from the preceding section.

Can we modify the Log file path?

Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml file.
The default log file path (file) is set by the installer. This can be configured to another path.

Can I point the environment with HTTP enabled to HTTPS after installation and vice versa?

Follow these steps:

1.
2.

Create SSL related certificates and import to respective servers.

Enable SSL on a desired Port (example 9443) on your existing and already
deployed web application servers.

Replace the protocol as https and new ssl port (FIC_SERVLET PORT) configured
and in all the URLSs specified on the following files:

SFIC_HOME/ficapp/common/FICServer/conf/FICWeb.cfg and SFIC
HOME/ficweb/webroot/conf/FICWeb.cfg

SFIC HOME/ficapp/icc/conf/WSMREService.properties

SFIC HOME/ficweb/webroot/conf/ModelExecution.properties
SFIC HOME/ficdb/conf/MDBPublishExecution.properties

SFIC HOME/ficdb/conf/ObjAppMap.properties

SFIC HOME/utility/Migration/conf/WSMigration.properties
$FIC HOME/utility/WSExecution/conf/WSExecution.properties

SFIC
HOME /EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebServiceIm
pl.wsdl

S$FIC
HOME /EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.
wsdl

S$FIC
HOME /EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServiceImp
l.wsdl

4. Replace XML attribute/Node values as specified on the following files:

?

SFIC HOME/ficweb/webroot/WEB-INF/web.xml
FIC_WEBSERVER_PORT=9443
FIC_WEBPROTOCOL:httpS

SFIC HOME/conf/LookUpServices.xml and $FIC
HOME/ficweb/webroot/conf/LookUpServices.xml

PORT="9443" PROTOCOL="https:"

5. Login to Config Schema and execute the following SQL command to replace protocol and
SSL port.
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SQL> update configuration cn set cn.paramvalue='9443' where
cn.paramname='SERVLET ENGINE PORT';

SQL> update configuration cn set
cn.paramvalue=replace (cn.paramvalue, "http:', 'https:') where
cn.paramname="'FormsManagerCacheReload';

SQL> update web server info ws set
ws.servletport='9443',ws.servletprotocol="https"';

6. Create EAR/WAR file and Re-Deploy.
What should I do if the sliced data model upload takes a long time to complete?

If the metadata cache size is set to a lower value than the actual count of each metadata type
(hierarchy, dataset, dimension etc), then it gets into performance degrade issues. We have to
increase the cache size for each metadata type according to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on the
metadata count in your environment.

<PARAMETER NAME="HIERARCHY NODE LIMIT" VALUE="2000"/>
<PARAMETER NAME="ALIAS CACHE SIZE" VALUE="1000"/>
<PARAMETER NAME="DATASET CACHE SIZE" VALUE="2000"/>
<PARAMETER NAME="MEASURE CACHE SIZE" VALUE="3000"/>
<PARAMETER NAME="HIERARCHY_ CACHE SIZE" VALUE="2000"/>
<PARAMETER NAME="DIMENSION CACHE SIZE" VALUE="2000"/>
<PARAMETER NAME="CUBE CACHE_ SIZE" VALUE="1000"/>
<PARAMETER NAME="BUSINESSPROCESSOR CACHE SIZE" VALUE="2000"/>
<PARAMETER NAME="DERIVEDENTITY_ CACHE_ SIZE" VALUE="1000"/>
Metadata count can be derived based on the following queries:

select count(1) from metadata master where metadata_version=0 --- for all metadata

select count(1) from metadata master where metadata version=0 and metadata type=1 --- for
measure

select count(1) from metadata master where metadata_version=0 and metadata_type=2 --- for
Dimension

select count(1) from metadata master where metadata_version=0 and metadata_type=3 --- for
HCY

select count(1) from metadata master where metadata_version=0 and metadata_type=4 --- for
DATASET

select count(1) from metadata master where metadata_version=0 and metadata_type=59 ---
for BP's

select count(1) from metadata _master where metadata_version=0 and metadata_type=54 ---
for Alias

select count(1) from metadata master where metadata_version=0 and metadata_type=5 ---
for CUBES

select count(1) from metadata _master where metadata_version=0 and metadata_type=856 ---
for Derived Entity

For LDAP authentication, which server connects with the LDAP server, the Application server
(where ofsaai is installed), or Web Application server (where EAR is deployed)?
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For LDAP authentication, the Application server (ficapp) connects with the LDAP server.

The LDAP server in the setup listens on secure protocol ldaps (port 636). I have the root
certificate of the LDAP server for SSL, and would like to know where to offload this certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer.
How to relocate FTPSHARE folder?

You can run the PortC.jar utility. For more details, refer Changing IP/ Hostname, Ports,
Deployed Paths of the OFSAA Instance section in the OFSAAI Admin Guide available on OHC
Documentation Library.

How do we identify the list of ports that are used by/configured in an OFSAA environment?
1. Navigate to $FIC_HOME folder on Target.
2. Run the PortC jar utility using the command:
java -jarPortC.jar DMP

A file with the name DefaultPorts.properties will be created under $FIC_ HOME
directory which will contain the ports. For more information, refer Changing IP/
Hostname, Ports, Deployed Paths of the OFSAA Instance section in the OFSAAI Admin
Guide available on OHC Documentation Library.

What should I do if I get the following error message, ""Error while fetching open cursor value
Status : FAIL"?

This error occurs while executing envCheck. sh because the user does not have access to
V$parameter. This error does not occur due to sysdba or non sysdba privileges provided
they have access/grants to VSparameter.

Application Pack 8.0.0.0.0 FAQs

What is an Application pack?

An Application Pack is suite of products. For more information, refer About Oracle Financial
Services Analytical Applications (OFSAA) Application Packs.

Can I get a standalone installer for OFSAAI 8.0?

No. AAl is part of every application pack and installs automatically.
How does OFSAA 8.0 Application pack relate to OFSAA 7.x series?

8.0 is a new major release consolidating all products from OFSAA product suite.
Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack?

There is no upgrade path available. However, we will have migration kit / path for every
product to 8.0 application pack. Further details will be available with Oracle Support.

Does OFSAA 8.0 Application pack UPGRADE automatically to existing environments?

No. OFSAA 8.0 application pack has to be installed in an new environment and subsequently
migration path / migration kit needs to be run to migrate from 7.x to 8.0. Note that the objects
can be migrated only from the previously released version of OFSAA products.

Where can I download OFSAA 8.0 Application Pack?

You can download the OFSAAI 8.0 Application Pack from Oracle Software Delivery Cloud (OS-
DC).
What are the minimum system and software requirements for OFSAA 8.0 Application Pack?

Refer installation guide section Hardware and Software Requirements.
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Is my environment compatible with OFSAA 8.0 Application Pack?
Environment Check utility performs the task. It is part of install and can also be run separately.
Does the OFSAA 8.0 Application Pack support all Operating systems?

OFSAA 8.0 Application pack supports the following Operating Systems: LINUX, AIX,
SOLARIS 10, 11. Refer to Technology Matrix for the technology matrix that OFSAA suite
products are/ will be qualified on.

How can I install OFSAA 8.0 Application Pack?

Refer to Oracle Financial Services Advanced Analytical Infrastructure Installation And
Configuration Guide published in OHC Documentation Library for the application pack
installers.

Does this installation require any Third party Softwares?

Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration
Guide published in OHC Documentation Library lists the third party software that needs to
be installed.

What languages are supported during OFSAA 8.0 Application Pack installation?
US English is the language supported.

What mode of installations OFSAA Application Pack supports? [i.e., Silent, GUIJ
OFSAA Application Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0 Application Pack support Multi tier Installations?

OFSAA 8.0 supports only single tier installation. For more information refer to OFSAAI FAQs
section.

Does this Application Pack validate all Pre-requisites required for this installation i.e., Memory,
Disk Space etc.?

Yes. The pre-requisite checks are done by the respective application pack installer.

What happens if it aborts during installation of any application with in Application pack?
You must restore the system and retrigger the installation

Does this Application pack 'Roll Back' if any application installation fails due to errors?
Rollback of installation is not supported.

Does the Application pack install all applications bundled?

All application pack system files are installed but there is an option to enable the licensed
products.

Can I re-install any of the Application Packs?
You can retrigger in case of failure.

Does this Application pack allow enabling / disabling any of the applications installed?
Yes. You cannot disable once the product is enabled in an environment.

I have installed one application in an Application pack, can I install any of new application within
the Application pack later?

No, installation of additional applications is not required. If you wish to add an application
later, you can enable the application at that time.

How many OFSAA Infrastructures can be installed in a single server?
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There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP
installations and separate associated database instances and separate Web Server installations
on the same server as long as adequate memory is allocated for each instance and as long as
each OFSAALI installation is installed using a separate UNIX user and profile. Care should be
taken if running multiple OFSAAI installations on a single server. Adequate memory will be
required for each installation as several OFSAAI processes (model upload, DEFQ services, etc)
take significant amounts of memory. So it depends on your server memory.

Is it possible to Install OFSAA 8.0 Application pack on an existing 'Infodom' where another
OFSAA 8.0 application is installed?

Yes. However, the Behavioral Detection Application Pack, Compliance Regulatory Reporting
Application pack are the exceptions. They need to be installed in a different INFODOM.

Can I select an Infodom in Application pack during installation?
Yes. You can select or change the required infodom.
Can I install all Application Packs in a 'Single Infodom'?

Yes. But Behavioral Detection Application Pack, Compliance Regulatory Reporting
Application Pack are the exceptions. They need to be installed in a different INFODOM.

Is it possible to install applications on different Infodom within the Application pack? (For
example, I want to install LRM & MR in two infodoms)

Applications within application pack have to be installed in the same information domain in the
same environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0?

You can install only one infodom during installation. But after installation, you can create
multiple infodoms.

Is the 'Data Model' bundled specific to an Application pack or to an individual application?
A merged data model for all applications within the application pack is bundled and uploaded.
Is it possible to install OFS Enterprise Modeling later?

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any
application pack that bundles Enterprise Modeling.

Does the Application pack create sandbox automatically for the required applications?
Yes, Sandbox creation is part of application install process.
Are upgrade Kits available for individual applications or the complete Application Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all
applications.

Can I upgrade AAI only?
Yes, you can upgrade AAI alone.

Can I upgrade one application within the Application Pack? (For example, I want to upgrade
LRM in the Treasury Application pack, but not MR.)

No, an upgrade is applied to all applications in the application pack.
Is it possible to uninstall any Application from the Application pack?

No, it is not possible to uninstall any Application from the Application Pack.
Can I uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.
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Is it possible to uninstall only application and retain AAI in the installed environment?

No, you cannot uninstall only the application and retain AAI in the installed environment.
Does Application Pack contain all Language Packs supported?

Language Packs need to be installed on 8.0 application packs.

Can I install an Application Pack over another Application Pack (that is same infodom or different
infodom)?

Yes, you can install an Application Pack over another Application Pack in the same information
domain or different information domain. But Behavioral Detection Application Pack and
Compliance Regulatory Reporting Application Pack, Asset Liability Management Application
Pack and Profitability Application Pack are the exceptions. They need to be installed in a
different INFODOM.

Can I use an existing manually created schema as information domain for application pack
installation?

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.
Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12¢?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12¢c. WebLogic 10.3.6 supports
oracle 12¢ with some additional configurations. Refer the link
http://docs.oracle.com/cd/E28280 01/web.1111/e13737/ds_12cdriver.htm#JDBCAG655 for
additional configurations.

What should I do if I get the following error message while running the schema creator utility,
"HostName in input xml is not matching with the local hostname''?

One possible reason could be the machine is configured for zonal partitioning. Ensure all the
known IP Addresses of the machine are present in the /etc/hosts file.

OFS AAAI Application Pack supports Java 1.7.x and 1.8.x.
Is OFS AAAI Application Pack version 8.0.0.0.0 supported on Java 8?

Yes. To install this release of the OFS AAAI Application Pack version 8.0.0.0.0 on Java 8. For
more information, refer to specific notes mentioned in the sections Installer and Installation
Prerequisites, Configurations supported for Java 8, Configuring the Schema Creator Utility,
GUI Mode Installation, SILENT Mode Installation.

This is a generic error message that appears during application installation failure. You should
check the installation log files for more information about what failed the installation.

This is a generic error message that appears during application installation failure. You should
check the installation log files for more information about what failed the installation.

However, if the message is displayed and the log files are not generated, it could be that it is a
temp directory issue. The resolution is that your UNIX administrator has to disable the
NOEXEC option. The installers extract the installation files into the /#mp directory, and if
NOEXEC is enabled, execution of binaries will not happen in the directory and the installation
fails. Re-run the installer after the configuration is changed. For detailed information, see the
support note at
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.

Forms Framework FAQs
What should I do when I have large volume of data to be exported?
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It is recommended to use BIP reports or OBIEE reports if you have to export large volume of
data.

How do I export the columns added to the grid using Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field Chooser
option.

'Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What should 1
do?

Expand All/ Collapse All button is disabled if the number of hierarchy nodes is more than 50
and if it is a non-custom hierarchy. Hierarchy with more than 50 nodes is considered as large
hierarchy and the data will be fetched dynamically when you expand the parent node.

What is the difference between the two Searches available in the Hierarchy Browser window?

In the new Hierarchy Browser window introduced from 7.3.5.1.0 version, there are 2 search
options available as highlighted in the following figure:

= Hierarchy Browser - Windows Internet Explorer prDU...EIiIéJ

Code Name |bbva \ Search+PReset I

'¥] Society Details

[T =
----- BANCO DEPOSITARIO BEVA, S.A

~
----- BEVA SERVICIOS, 5.A.

----- BEWVA SUEA, S.A. (BBWVA SWITZERLAND)
----- BEWVA & PARTNERS ALTERNATWE INV AW, 5.4,
----- BBEWVA ASESORIAS FINANCIERAS S.A.

----- BBVA ASSET MANAGEMENT (IRELAMD) LIMITED
BBVA ASSET MANAGEMENT ADMON.G.FONDOS, SA

BEVA ASSET MANAGEMENT CONTINENTAL S.A S

----- BEVA ASSET MANAGEMENT, S.A. 5GIC
----- BEVA AUTORENTING SPA

----- BEVA BANCO DE FINANCIACION 5.A.

----- BEVA BANCO FRANCES, 5.A.

----- BEVA BANCOMER GESTION, S.A. DE CW.

----- BBEWVA BANCOMER OPERADORA, S5.A

----- BBVA BANCOMER SERV ADMINISTRATIVOS, S.A.
f v
i BEVA BANCOMER USA, INC.

MNode H Find |
OK Cancel

DB Search (Top search container): It will search the required node in database and
displays the result as shown below. This search is performed on full hierarchy nodes.

» Ul search (Below the hierarchy): This search will find the required node in the UI and
will show in tree structure.

Note: In case hierarchy nodes are more than 50 and if it is a non-custom
hierarchy, then the UI search will not show the required node in tree
structure, until all the nodes are expanded and loaded manually in the UL

What is a Custom Hierarchy?
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Custom hierarchies will be having the parameter configuration customQuery as shown below
and the customized query will be taken from the HIERARCHY FILTER MASTER table.

Configuration in xml:
<CONTROL ID="1003" TYPE="41">
<CONTROLPROPS>
<EXTRAPARAMETERS>

<PARAMETER NAME="customQuery" VALUE="Yes"/>
</EXTRAPARAMETERS>
</CONTROLPROPS>

</CONTROL>
For custom hierarchy, all the hierarchy nodes are loaded in UI without any limit.

So, even if the hierarchy nodes are more than 50, the Ul search will show the required node in
tree structure and ExpandAll and ExpandBranch images will be enabled.

Error Dictionary

This contents of this section has been created with the interest to help you resolve the
installation issues if any. There is a compilation of all the possible errors that might arise during
the installation process with the possible cause and the resolution to quickly fix the issue and
proceed further with the installation.

This section includes the following topics:
> Accessing Error Dictionary

> Error Code Dictionary

Accessing Error Dictionary

Instead of scrolling through the document to find the error code, you can use the pdf search
functionality. In the "Find" dialog available in any of the Adobe Acrobat version that you are
using to view the pdf document, follow these instructions to quickly find the error resolution.

1. With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on screen during Infrastructure installation.
4

Press Enter. The search results are displayed and highlighted as follows:

Figure R-1 Error Code

Error code - OFSAAI-1003

Cause JA VA_!WE’TN—’I‘ nolt found in PATH vanable

Resolution | Import <IAVA HOME>/bin into PATH vanable

Example: PATH = SJAVA_HOMEbn SPATH export PATH.
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View the details of the issues, its cause, and resolution specific to the error code. Repeat the
step to find an answer to any other errors that you notice during installation. If you are not able
to resolve the issue even after following the steps provided in resolution, you can contact
support.oracle.com along with log files and appropriate screen shots.

Error Code Dictionary

Error code - OFSAAI-1001

Table R-2 Error code - OFSAAI-1001

Cause Unix shell is not "korn" shell.

Resolution Change the shell type to "korn". Use chsh unix command to change SHELL
type.
Shell type can also be changed by specifying shell path for the Unix user in
/etc/passwd file.

Note: chsh command is not available in Solaris OS.

Error code - OFSAAI-1002

Table R-3 Error code - OFSAAI-1002

Cause No proper arguments are available.
Resolution Provide proper arguments. Invoke Setup.sh using either SILENT or GUI
mode.

Example: . /Setup.sh SILENT or ./Setup.sh GUI

Error code - OFSAAI-1004

Table R-4 Error code - OFSAAI-1004

Cause File .profile is not present in $HOME.

Resolution Create .profile in $HOME, i.e. in the home directory of user.

Error code - OFSAAI-1005

Table R-5 Error code - OFSAAI-1005

Cause File OFSAAInfrastructure.bin is not present in current folder.

Resolution Copy OFSAAInfrastructure.bin into installation kit directory.

Error code - OFSAAI-1006

Table R-6 Error code - OFSAAI-1006

Cause File CustReg.DAT is not present in current folder.

Resolution Copy CustReg.DAT into installation kit directory.

Error code - OFSAAI-1007

Table R-7 Error code - OFSAAI-1007

Cause File OFSAAI InstallConfig.xml is not present in current folder.
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Table R-7 Error code - OFSAAI-1007

Resolution Copy OFSAAI InstallConfig.xml into installation kit directory.

Error code - OFSAAI-1008

Table R-8 Error code - OFSAAI-1008

Cause File validateXMLInputs.jar is not present in current folder.

Resolution Copy validateXMLInputs.jar into installation kit directory.

Error code - OFSAAI-1009

Table R-9 Error code - OFSAAI-1009

Cause File 1og4j.xml is not present in current folder.

Resolution Copy log4j.xml into installation kit directory.

Error code - OFSAAI-1010

Table R-10 Error code - OFSAAI-1010

Cause Unknown error occurred.
Resolution Make sure to provide proper argument (SILENT or GUI) to the Setup. sh
file.

Error code - OFSAAI-1011

Table R-11 Error code - OFSAAI-1011
Cause XML validation failed.

Resolution Check InfrastructurePreValidations.Log for more details.

Error code - OFSAAI-1012

Table R-12 Error code - OFSAAI-1012

Cause Property file with locale name does not exist.

Resolution Copy MyResources_en_US.properties to the setup kit directory and keep
en_US in LOCALE tag of OFSAAI InstallConfig.xml.

Error code - OFSAAI-1013

Table R-13 Error code - OFSAAI-1013

Cause File OFSAAI InstallConfig.xml/OFSAAI PostInstallConfig.xml not
found.
Resolution Copy OFSAAI InstallConfig.xml/OFSAAI PostInstallConfig.xml to

the setup kit directory.
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Error code - OFSAAI-1014

Table R-14 Error code - OFSAAI-1014

Cause XML node value is blank.

Resolution Make sure all node values except SMTPSERVER, PROXYHOST,
PROXYPORT, PROXYUSERNAME, PROXYPASSWORD,
NONPROXYHOST, or RAC_URL are not blank.

Error code - OFSAAI-1015

Table R-15 Error code - OFSAAI-1015

Cause XML is not well formed.

Resolution Execute the command dos2unix OFSAAI InstallConfig.xml to convert
plain text file from DOS/MAC format to UNIX format.
OR

Make sure that OFSAAI InstallConfig.xml is valid. Try to open the file
through Internet Explorer for a quick way to check validity. If it is not
getting opened, create new OFSAAI InstallConfig.xml using the XML
Utility.jar.

Error code - OFSAAI-1016

Table R-16 Error code - OFSAAI-1016

Cause User installation directory contain blank spaces.

Resolution Provide an installation path that does not contain spaces. Check the tag
USER_INSTALL DIR in OFSAAI InstallConfig.xml file. This path
should not contain any spaces.

Error code - OFSAAI-1017

Table R-17 Error code - OFSAAI-1017

Cause User installation directory is invalid.

Resolution Provide a valid installation path. Check if you are able to create the
directory mentioned in USER_INSTALL DIR tag value of OFSAAI
InstallConfig.xml file.
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